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Introduction

IBM Aspera Console is a web-based application which allows users to centrally manage, monitor and control Aspera
servers (nodes) and transfers. Console offers the following features:

Feature Description

Transfer monitoring and View transfers, pause / resume / cancel, change transfer rates.

control

Transfer Initiation Initiate and schedule transfer jobs remotely.

Node Configuration An administrator can configure all nodes directly from Console such for options such

as bandwidth, priority, and encryption.

Email Notification Notify users of transfer events with customizable messages.

Reporting Create detail and summary reports of transfer activity.

Role-based access control | Manage what transfers are visible and controllable to Console users with security

groups.

Console Nodes
Aspera servers can be added to Console as managed nodes or unmanaged nodes.

Managed nodes can be configured and their transfer activity managed from the Console UI through an SSH
connection. The transfer activity of managed nodes is logged to the Console database. For nodes that run an Aspera
server application version 3.4.6 or newer ("regular" nodes), Console makes REST calls to the Node API to pull
transfer details into console as well as to start and control transfers. For nodes than run older versions of Aspera
server applications ("legacy" nodes), Console processes data that gets pushed to the database by the node. Console
also communicates with legacy nodes via SOAP calls to start and control transfers and to check for cases where nodes
failed to log the end of a transfer.

Unmanged nodes are not under control of Console. These can be used as transfer destinations, but only transfer
activity with managed nodes is reported to Console.

The following figure shows the relationship between Console, two managed nodes (Node 1 and Node 2) and an
unmanaged node. All transfer activity on the managed nodes, such as Transfer 1, can be monitored and controlled. In
contrast, Console is only aware of transfers that are between the unmanaged node and a managed node (for example,
Transfer 2 between Node 1 and the unmanaged node).

poe 1 MNoda 2

|_ = Transter 1 J
= Tranclor 2
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Console Endpoints

An endpoint is an individual user account on a node (managed or unmanaged) that can perform Aspera transfers
without requiring the user to enter credentials in the Console UI. You can have one or multiple endpoints on a node
depending on your business needs. The following figure shows a simple endpoint arrangement. Node 1 has two
endpoints, Endpoint A (aspl@nodel) and Endpoint B (asp2@nodel), and Node 2 and Node 3 have one endpoint
each (Endpoint C and Endpoint D, respectively). A Console user can run transfers between endpoints from the
Consoel Ul. For example, Transfer 1 between Endpoint A and Endpoint D, and Transfer 2 between Endpoint B
and Endpoint C. Both transfers originate from Node 1, but from different Endpoints and have different destination
Endpoints.

i
(111}

9
Mode3

"Endpoint D
john®@node3

Transfer 2 j ‘
Transfer 1

What's New?

NEW FEATURES
A patched Console installation displays the current patch version in the page footer, defined by a patch-version file
included in a patch. Upgrading Console removes the patch-version file.

DOCUMENTATION UPDATES
Updated the Shares version requirement of adding Shares to Console to 1.9.3.
Re-branded documentation to reflect Console's new name: IBM Aspera Console.

Documented process for migrating Console database to a server with a different operating system. For more
information, see Migrating Console Database from a Linux Server on page 101.

Installing Console

System and Firewall Requirements

Operating System «  Windows 2008r2 Server 32-bit and 64-bit (English)
*  Windows 2012 Server 64-bit (English)

Note: Aspera recommends installing Console on 64-bit Windows, which is essential for
maximizing MySQL performance.

Minimum Hardware 4 GHz dual-core CPU (or better)
Requirement + 8GBof RAM
* 10 GB of disk space
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In terms of planning for the size growth of the database, the per file records generate

Requirement 1-2KB per file transfer, and the session records generate 8-12KB per session. For some
size estimates, here are a few examples:

* 100 sessions per day of 1000 files each, all external transfers between managed and
unmanaged nodes = approx 201 MB per day db growth, 6.03 GB per month, 73.4 GB
per year.

* 1000 sessions per day of 1 file each, all internal between managed nodes = approx 28
MB per day, 840 MB per month, 10 GB per year.

» 1000 sessions per day, 10,000 files each, 50% internal between managed nodes, 50%
external with unmanaged node = approx 30 GB per day, 900 GB per month, 11 TB
per year.

Applications *  MySQL Database

» Apache HTTP Server

Note: If there is an existing installation, shut down the MySQL database and the

Apache HTTP server during installation.

Node Machine

* In order to work with Console, node machines must have an Aspera transfer product
installed (IBM Aspera High-Speed Transfer Server, IBM Aspera High-Speed
Transfer Server, or IBM Aspera High-Speed Transfer Endpoint).

* To use the new Console architecture implemented in Console version 3.0 and on,
the Aspera transfer products on existing node machines must be upgraded to at least
version 3.4.6 and ideally to the latest version. These legacy nodes must be converted
to use Node API using the built-in convert option in the Console 3.0 Node edit
screens. If a node is not converted to use Node API, the legacy node will continue
to report to Console using the existing mechanism. For more information on node
conversion, see Converting Legacy Nodes on page 36.

Firewall (on the Console
Machine)

Open the following ports on the Console machine:

* For the Web Ul, allow inbound connections for HTTP or HTTPS Web access (for
example, TCP/80, TCP/443).

» Allow outbound connections for SSH (to be used for node administration) on a non-
default, configurable TCP port (for example, TCP/33001).

* Allow an outbound connection for TCP/9092 to allow Console to connect with nodes
through the Node API

* Allow an outbound connection for TCP/40001 and an inbound connection for
TCP/4406 to allow Console to connect with legacy nodes.

Firewall (on the Node
Machines)

» To ensure that your server is secure, Aspera strongly recommends allowing inbound
connections for SSH on TCP/33001 (or on another non-default, configurable
TCP port), and disallowing inbound connections on TCP/22. If you have a legacy
customer base using TCP/22, you can allow inbound connections on both ports.
For details on securing your individual Aspera transfer server product, review the
corresponding user manuals.

* Allow inbound connections for FASP transfers, which use UDP/33001 by default,
although the server may also choose to run FASP transfers on another port.

* For current nodes and legacy nodes that have been converted to current nodes, allow
an inbound connection on TCP 9092.

* For legacy nodes (unconverted), allow an inbound connection for Aspera Central (for
example, TCP/40001).

» For legacy nodes (unconverted), allow an outbound connection for logging to
Console on TCP/4406.
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Note: No servers are listening on UDP ports.

When an Aspera client initiates a transfer, the client opens an SSH session to the SSH
server on the designated TCP port and negotiates the UDP port over which the data
transfer will occur.

For Aspera servers that have multiple concurrent clients, the Windows operating
system does not allow Aspera's FASP protocol to reuse the same UDP port for multiple
connections. Thus, if you have multiple concurrent clients and your Aspera server

runs on Windows, then you must allow inbound connections on a range of UDP ports,
where the range of ports is equal to the maximum number of concurrent FASP transfers
expected. These UDP ports should be opened incrementally from the base port, which
is UDP/33001, by default. For example, to allow 10 concurrent FASP transfers, allow
inbound traffic from UDP/33001 to UDP/33010.

Installing Console

Warning: Due to incompatible common components, do not install IBM Aspera Console and IBM Aspera
/= 3 Faspex on the same machine. Aspera does not support this combination.

This topic describes how to perform a fresh installation of Console. To start the installation process, log into your
computer as an Administrator (or Domain Administrator if in an Active Directory environment) and follow the steps
below. If you are upgrading Console rather than starting a fresh installation, refer instead to Upgrading Console to the
Current Version on page 12.

1. Upgrade to Windows Installer 4+.

The Console installer requires Windows Installer 4+ for a successful configuration. You may download the latest
version of Windows Installer from the Microsoft website: www.microsoft.com/en-us/download/details.aspx?
1d=8483

2. Download Console installation components.

Use the credentials provided by Aspera to download the Console installer from the Aspera website: http://
downloads.asperasoft.com/en/downloads/3

3. Run the downloaded installation components.
Double-click the Console installer to start the installation.

Note: If you are running Windows Server with User Account Control (UAC) enabled, run the installation as an
administrator. Right-click the installer and click Run as administrator.
4. Choose setup type

Proceeding the Console's End-User License Agreement screen, you should see Choose Setup Type with the
following two options:

Option Description

Typical Install all components required by Console, including the Console application, Ruby,
MySQL common files, and Console's MySQL database.

Custom Select the components to install. You can use your existing installation of Ruby, MySQL
or Console's MySQL database for the new installation.

If you select custom install, you can choose components to install in the following screen.


http://www.microsoft.com/en-us/download/details.aspx?id=8483
http://www.microsoft.com/en-us/download/details.aspx?id=8483
http://downloads.asperasoft.com/en/downloads/3
http://downloads.asperasoft.com/en/downloads/3
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iﬁ_% Aspera Management Console Setup ;IEIEI

Custom Setup

Select the way vou want features to be installed,

Click the icons in the tree below to change the way features will be installed,

Aspera Management Console
<= = | Aspera Common Files
= = | MyS0L &4-bit Database

Installs Aspera Console and service.

This feature reguires 41ME an your
hard drive. Ithas 1of 1
subfeatures selected, The
subfeatures require 10ME on your
hard drive.

Browse, ., |
Reset Disk Usage < Back I Mext = I Cancel |

5. Enter the user name and password of the system account used as the Aspera service account.

This account can be either a local account or an Active Directory account. If the Aspera service account is an
existing user, enter the user's password. Otherwise, create a new user name and password. By default, the user
name is sveAspera. If the existing user's password you have entered is incorrect, or you want to change the
Aspera service user, see Managing the Aspera Service Account on page 118.

i:_% Aspera Management Console Setup El

Aspera Service Account

There was a problem setting up the user account that runs the
Aspera services.

User sycAspera already exists but the password is
incorrect (Windows error code 1326)

Go back and either specify a local user account to be created, or an
existing local or domain account.

| < Back I Cancel
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6. Runthe asctl setup command.

Once installation is complete, click Finish. By default, the installer automatically runs the asctlsetup command. If
you do not want to run the setup command automatically, clear Launch asctl to continue the Console setup and
click Finish.

Note: If Console doesn't automatically run the setup command or an error halts the process, then you can run the
command manually, as shown below.

> asctl console:setup

7. Optional: Update the Aspera license from the command line.

Console administrators can update the license in the Console web Ul, see Logging Into Console for the First Time
on page 12. However, if you are automating Console installation, you can use a rake command to set the
license without logging into the web UI.

a. Set the license text as an environment variable.

> set LICENSE TEXT='<ASPERA LICENSE> <DETAILS expiration date=... </KEY>
</ASPERA_LICENSE>'

In this example, only part of the license text is shown. You must paste the entire license text for the license to
be valid.

b. Update the Aspera license:
> asctl console:rake aspera:update license
To access the Console interface, go to the following address with a browser: http://

server ip or name:port/aspera/console. For instructions on logging in for the first time, see Logging
Into Console for the First Time on page 12.

Logging Into Console for the First Time

Note: IBM Aspera Console requires Adobe Flash Player. If you do not have Adobe Flash Player installed, download
and install Flash Player here: http://get.adobe.com/flashplayer.

1. Access the Console interface by entering its hostname or IP address followed by /aspera/console in your web
browser. For example, enter https://IP address/aspera/console.

Console requires a valid license key before a user can access and interact with the Console interface. An
administrator must log in to paste a valid license or upload a valid license file before other users can log into
Console. No other user interaction is permitted until a valid license is installed.

2. Enter the username and password and click Login. At this point, Console prompts you to change your password.
Verify the old password. Then, enter and confirm a new password. Click Change Password to save your new
password and login.

Note: Passwords must be at least six characters long, with at least one letter, one number, and one symbol.

3. Console directs you to the Console configuration page to update your Console license with the license Aspera
provided to you. Click Upload a license file to upload a license file or paste the license text into the text window.

Upgrading Console to the Current Version

Note: As of Console 3.0.3+, Console stores license information in the database, rather than in a file located at C :
\Program File (x86)\Aspera\Management Console\config.Ifalicense is added to the directory
before the upgrade script is run, the script migrates the license information from the file into the database and deletes
the file. To modify your license, see Updating your Console License on page 107.


http://get.adobe.com/flashplayer
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. Upgrade to Windows Installer 4-+.

The Console installer requires Windows Installer 4+ for a successful configuration. You may download the latest
version of Windows Installer from the Microsoft website: www.microsoft.com/en-us/download/details.aspx?
1d=8483

. Back up the Console database using an asctl command. Open a Command Prompt (Start > All Programs >
Accessories >Command Prompt) and execute the following command:

> asctl console:backup database

. Stop Console and all related services.

Run the following asct1 command:

> asctl all:stop

. Backup my.cnf if you have customized it.
Upgrading the Aspera Common Components overwrites the existing my . cnf with default values.

Create a backup of the existing file, which can be found in the following location:
C:\Program Files (x86)\Common Files\Aspera\Common\mysql\my.conf

Save the backup outside the aspera directory.

. Download Console installation components.

Use the credentials provided by Aspera to download the Console installer from the Aspera website: http://
downloads.asperasoft.com/en/downloads/3

. Install components.

Important: If you have set a custom database backup path with the SQL_EXPORT _DIR environment variable,
execute the installer in the same command prompt (set SQL._EXPORT DIR=db-export-path), so that the
installer can use the variable.

Double-click the Console installer to start the installation.

. Enter the user name and password of the system account used as the Aspera service account.

This account can be either a local account or an Active Directory account. If the Aspera service account is an
existing user, enter the user's password. Otherwise, create a new user name and password. By default, the user
name is sveAspera. If the existing user's password you have entered is incorrect, or you want to change the
Aspera service user, see Managing the Aspera Service Account on page 118.


http://www.microsoft.com/en-us/download/details.aspx?id=8483
http://www.microsoft.com/en-us/download/details.aspx?id=8483
http://downloads.asperasoft.com/en/downloads/3
http://downloads.asperasoft.com/en/downloads/3
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i’-g‘ Aspera Management Console Setup El

Aspera Service Account

There was a problem setting up the user account that runs the
Aspera services.

User sycAspera already exists but the password is
incorrect (Windows error code 1326)

Go back and either spedify a local user account to be created, or an
existing local or domain account.

| < Back I Cancel

8. Click Install.

9. Upon completion, the installer will prompt you to execute the asct1 upgrade command. If you did not select the
option, run the asctl upgrade command in a Command Prompt:

> asctl console:upgrade

10. Restore any my . cnf customizations.

Copy the custom configurations from your backup to:

C:\Program Files[ (x86)]\Common Files\Aspera\Common\mysql\my.conf
11. Optional: Upgrade legacy nodes.

Upgrade your legacy nodes (running an Aspera transfer product prior to version 3.4.6) to take advantage of
Console features. For more information on converting your legacy nodes, see Converting Legacy Nodes on page
36.

Uninstalling Console

1. Prior to removal, stop the Console application and its services in a Command Prompt window using the asct1
command.

> asctl all:stop

2. Go to Control Panel > Programs and Features. Right-click Aspera Management Console and click Uninstall.
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Configuring Email Notifications

Email Server Configuration

IBM Aspera Console needs to connect to a Simple Mail Transfer Protocol (SMTP) server to send email notifications.

Email Server

» Configure Email Server

Server smtp.example com
E) o 25
Domain example.com

E Use TLS if available

E Authentication type ® Open authentication Login required
"Erom" address aspera_admin@example.com
"Erom" name Aspera Console Admin

Save settings

Go to Notifications > Email Server.

Enter the SMTP server information [A, B, C].

Optional: Enable Transport Layer Security (TLS) [D] if available.
Choose the authentication type [E] of your email server.

Pl ol

If your SMTP server requires login credentials, select Login required under Authentication type and enter your
login credentials. Otherwise, select Open authentication.

5. Inthe 'From' address [F] and 'From' name [G] fields, enter the default sender email address and sender name
that appear in email notifications when they receive an email notification.

6. Enter your email address and select Save settings and send test email.

Check your email inbox for the confirmation email titled Email settings test. If you do not receive the email,
review your settings or check your spam folder.

Configuring Notification Time Zones and Cutoff Times

1. Go to Noetifications > Email Notification Options.
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Email Motification Options

= Configure Email Notification Options

Default time zone (GMT+00:00) UTC v
Skip non-error emails older than 1 heur(s)
Skip error emails older than 24 hour(s)

Save Options

2. Select a default time zone for email timestamps.

3. Enter a cut-off time for delivering older emails.

Configuring Advanced Rulesets for Email Notifications

Configure advanced rulesets for automated generation of additional email notifications beyond the simple
announcement of transfer events. IBM Aspera Console checks configured rulesets whenever a transfer starts,
completes successfully, or errors out for the final time (the transfer runs out of retries or Console detects a transfer that
was supposed to retry but never did). If the transfer matches the ruleset, Console sends an email notification to the
designated recipients.

1. Go to Notifications > Advanced Rulesets and click Create New Ruleset.

2. Enter a description of the ruleset.
3. Optional: Disable the ruleset to control when the ruleset comes into effect.
4. Select a filter.
Filter Description
Address Filter by the IP address of a node machine.
Cookie Filter by information in a transfer cookie. For more information on

transfer cookies, see Creating a Cookie Parsing Rule on page 67.

Contact Filter by the contact assigned by Console. A contact can be a Console user
name, a Faspex user name, a SSH account, or a customized value obtained
from a transfer cookie. For example, a contact can be "admin console",
"aspera ssh", or "aspera faspex" and so on.

Failover Group Name Filter by the failover group name of the node. For more information about
failover groups, see Configure Failover Groups on page 66.

Faspex Metadata Filter by metadata found in a Faspex file package.

File Path Filter by the file path of the transfer.

SSH User Filter by the username of the SSH user that started the transfer.
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Filter Description

Note: This works only for Console-triggered transfers with endpoints
matching the SSH User.

Tags Filter by the JSON hash used to tag the transfer. For more information on
transfer tags, see Working with Tags on page 115.

5. Select the side to apply the filter.

Side Description

Either Apply the filter to both sides.

Source Apply the filter to the source node.

Destination Apply the filter to the destination node.

Client Apply the filter to the node initiating the transfer
request.

Server Apply the filter to the node receiving the transfer
request.

6. Select the comparator and enter the value.
Note: Select NOT to exclude entries matching the value.

For example, set the following parameters to send an email notification every time a node with the defined IP
address participates in a transfer.

MATCH SIDE NOT COMPARISON VALUE

Address Either = 10.0.0.1

7. Designate email recipients.
Enter an email address and click Add. Select an email template for each transfer event.
8. Click Create.

The newly created template appears on the Advanced Rulesets page where you can disable or enable, edit, copy, and
delete rules.

View Email Notification Statistics

You can monitor notification activity in the Session Notifications report for each transfer. To view the report,

go to a transfer's Sessions Details page. Click The Statistics column contains either a link describing the type of
notifications configured for that session or None if no notifications were configured. Click the link to display the
Session Notifications page.
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Statistics
Started: 2015-10-13 13:05:21
Stopped: 2015-10-13 13:05:21
Elapsed: Os
Bytes written: 0 Bytes
Bytes transferred: 0 Bytes
Average rate: 0 bps
Network delay: 0 ms
Motifications: start. success & erre

The Session Notifications page provides the following information about the transfer:

» Session Details: This section gives basic information about the transfer, such as its name, status, and start and stop
times

» Configured Notifications: This section shows which types of notification were configured for this transfer (start,
success, or error) and the name of the template configured for each.

* Email Messages Sent (or Attempted) This section shows which types of notification were actually sent or
attempted for this transfer (start, success, or error) and the name of the template used for each. You can see more
detail about a message by clicking on it to launch the Email Message Details page, which provides more detail
about a message, including its content. You can also resend messages listed in this section by clicking resend.
This may be useful in cases where recipients are not receiving messages due to email server or configuration
issues.

Configuring Personal Email Notifications

Individual users can manage personal email notifications from their Preferences menu.

1. Open the Preferences page and select Email Notifications.

2. Select email templates for notifications that are triggered by the following events: transfer start, transfer success,
or transfer error.
You can create new templates or modify existing templates by going to Notifications > Email Templates. For
more information on how to create and modify email templates, see Editing Email Templates on page 20.

3. Select or clear global email notifications. By default, Console notifies you for transfers that you start when those
transfers start, succeed, or fail.

4. For each specific transfer path listed, select or clear notifications for transfer path. These notifications are disabled
by default.

5. Click Update.
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Configuring Email Notification Templates

Creating a New Email Notification Template

IBM Aspera Console allows you to create and modify email notification templates based on three transfer events:
transfer start, transfer success, and transfer error. You can customize emails based on recipient needs by creating a
new template. For example, an error notification email to an internal admin typically contains as much information as
possible, while a notice to an outside party might contain a bare minimum of information. You can edit the included
default templates, create and edit new templates, and change which templates are used as defaults.

1. Go to Notifications > Email Templates.

2. Click on the appropriate "Create new..." link.

= Email Notifications for Transfer Start

@Iﬁlreaie new transfer start email template

NAME DEFAULT ACTIONS

Default Start o

o

= Email Notifications for Transfer Success

@i:reate new transfer success email template

NAME DEFAULT ACTIONS

Default Success o

l4e]

= Email Notifications for Transfer Error

eilreaie new transfer error email template

NAME DEFAULT ACTIONS

Default Error o

i

@new_errnr_template_’ edit default delete

To create a new template, click Create new transfer start email template (A), Create new transfer success

email template (B), or Create new transfer error email template (C) depending on the situation for which you
want to send an email notification.

The new template (D) appears listed under the default template.
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3. Rename the template.

Click Edit Plain Template to open the plain text editor. Enter a descriptive name of this template in the Template
name field. At this point, you can edit the template. For more information on editing templates, see Editing Email
Templates on page 20. Otherwise, click Save to rename the template and return to the template preview page.

Note: To ensure that information displays correctly in the email, edit both the plain text and HTML code versions
of the template.
4. Optional: Make this template the default template.

Return to the Email Templates page by clicking the Email Templates tab. Find your renamed email template and
click default.

= Email Notifications for Transfer Error

NAME DEFAULT ACTIONS
Default Errar o edit
Customer Transfer Errar edit Jdefault | delete

Editing Email Templates

IBM Aspera Console allows you to create and modify email notification templates based on three transfer events:
transfer start, transfer success, and transfer error. You can customize emails based on recipient needs by creating a
new template. For example, an error notification email to an internal admin typically contains as much information as
possible, while a notice to an outside party might contain a bare minimum of information. You can edit the included
default templates, create and edit new templates, and change which templates are used as defaults.

1. Go to Notifications > Email Templates.

2. Click edit for the email template you want to configure.

Note: To ensure that information displays correctly in the email, edit both the plain text and HTML code versions of
the template.

3. Click Edit Plain Template.

Field Description

Template name

Modify the name of the template displayed in Console.

From Name

Enter the name displayed as the email sender.

Reply-to Address

Enter the email address receiving replies from the email recipient.

Subject

Modify the email subject line.

Body

Modify, add, or remove the default text. The yellow box at the top of the
page lists special text strings you can use in the message body. Console
replaces the strings with the appropriate value in the actual email. The
available text strings differ depending on the type of template (transfer
start, transfer success, or transfer error)

For an example of how to edit the plain text version of the template, see Email Template Example: Creating a
Simple Notification for a Successful Transfer on page 139.




4. Click Save.
5. Click Edit HTML Template.
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Field

Description

Template name

Modify the name of the template displayed in Console.

From Name

Enter the name displayed as the email sender.

Reply-to Address

Enter the email address receiving replies from the email recipient.

Subject

Modify the email subject line.

Body

Modify, add, or remove the default text. The yellow box at the top of the
page lists special text strings you can use in the message body. Console
replaces the strings with the appropriate value in the actual email. The
available text strings differ depending on the type of template (transfer

start, transfer success, or transfer error)

For an example of how to edit the HTML code of the template, see Email Template Example: Adding Company

Branding to Your Template on page 140.
6. Click Save.
7. Optional: Test the email template. Enter an email address in the field and click

8. Optional: Make this template the default template.

Send Test Email.

Return to the Email Templates page by clicking the Email Templates tab. Find your renamed email template and

click default.

= Email Notifications for Transfer Error

NAME DEFAULT

Default Errar o edit

ACTIONS

Customer Transfer Errar edit

You can take the following actions for the new template:

+ Set this template as your personal default from your Personal Preferences page.

* Select this template when creating a transfer.
» Select this template for an Advanced Ruleset.

Displaying Email Notification Templates for an Email Address

See a list of email notifications enabled for a given email address. The results show the email recipient's node
endpoints, smart transfers, and user preferences. The results also list the email templates selected as the default for

each transfer event (start, success, failure).

1. Go to Notifications > Email Templates
2. In the Search field, enter the email address (full or partial) and click Search.

In the example below, the results display all pre-configured email notification templates related to the email address

"jdean".
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Email Template Search

Configured Email Motifications Matching 'aspera_user'

= Node Endpoints
EMAIL NCODE MAME HNODE TYPE ENDPCOINT ADDRESS START SUCCESS ERR

aspera_usen@asperaexample.com  10.0.201.212 Managed rosot 10.0.201.213 Default Start  Default Success Defs

EMAIL SMART TRANSFER NAME DESTINATION START SUCCESS ERA
aspera_usenf@asperaexample.com  Distribute Content to Customer A root@10.0.201.213  Default Start  Default Success  Def
aspera_usenf@asperaexample.com  Distribute Content to Customer B root@10.0.201.184  Default Start  Default Success  Def

® User Preferences - "Send notifications for transfers | start”
EMAIL USER LOGIN - START SUWCCESS ERRCR

aspera_usen@asperasxample.com aspera_user Default Start  Default Success Customer Transfer Error

= User Preferences - Transfer paths chosen

EMAIL USER LOGIN - SOURCE DESTIMATION START SUCCESS

aspera_usen@asperasxample.com 35DEra_USer 10.0.201.184 {10.0.201. 184) Ay Default Start  Default Succe
Fspera_usen@asperasxample.com aspera_user  Any 10.0.201. 184 Default Start  Default Suece
Fspera_usen@asperasxample.com A5 DEr3_USEr 10.0.201.213 {10.0.201.213) Any Default Start  Default Suece
Fspera_usen@asperasxample.com aspera_user  Any 10.0.201.213 Default Start  Default Suece

Adding Nodes to Console

Adding Nodes to Console

In Console, a node is a computer that has an Aspera transfer product installed and is enabled to make transfers. A
node can be a managed node or an unmanaged node.

* Managed Node: Console can initiate transfers with this node, monitor this node's activity, and configure settings
for this node.

» Unmanaged Node: Console cannot initiate transfers with this node or configure its settings. Console can only
monitor transfers between this node and managed nodes.

You can also add an Aspera Transfer Cluster to Console. A transfer cluster is a provisioned cluster of Aspera servers
in the cloud that autoscales with traffic and use. Console can monitor transfers running on managed clusters using
access key authentication for each node. You can also run reports on managed clusters. For more information, see
Adding Managed Clusters to Console on page 34.

Adding Managed Nodes

To add a managed node to Console, prepare the node as described in Configuring Transfer Servers for Use with
Console on page 23.
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Once the node is configured for use with Console, add it as a managed node and configure it. This processes includes
the following steps:

1. Create a new managed node in Console; see Creating a Managed Node in Console on page 30.
2. Authorize access to the node; see Managing Nodes on page 35.
3. Set up permissions for the node; see Accounts and Permissions on page 39.

Adding Unmanaged Nodes
To add an unmanaged node to Console, you do not need to have access to the node or configure it. As described in
Adding Unmanaged Nodes on page 31, the process is a simpler version of adding a managed node:

1. Create a new unmanaged node in Console; see Adding Unmanaged Nodes on page 31.
2. Set up permissions for the node; see Accounts and Permissions on page 39.

Configuring Transfer Servers for Use with Console

What is a Node?

A node is a local, remote, or cloud workstation running an Aspera transfer server product (IBM Aspera Enterprise
Server, IBM Aspera Connect Server). In order to make transfers, Console communicates with a node through the
Node API. The Node API is a daemon on the transfer server that offers REST-inspired file operations and a transfer
management API. Aspera web applications authenticate to remote node services using a Node API username and
password. Different nodes may use different Node API username and password pairs.

Configuring a Node for Use with Console

Nodes do not have to run on the same platform as the Console server. To set up your machine to run as a node, follow
the instructions pertinent to the platform of the workstation.

*  Windows: Setting Up a Windows Node on page 25
* Linux: Setting Up a Linux Node on page 23
* OS X: Setting Up an OS X Node on page 27

Setting Up a Linux Node

A node is a local, remote, or cloud workstation running an Aspera transfer server product (IBM Aspera Enterprise
Server, IBM Aspera Connect Server). In order to make transfers, Console communicates with a node through the
Node API. The Node API is a daemon on the transfer server that offers REST-inspired file operations and a transfer
management API. Aspera web applications authenticate to remote node services using a Node API username and
password. Different nodes may use different Node API username and password pairs.

Note: The following instructions require you to have administrative privileges.

1. Verify you have installed IBM Aspera Enterprise Server with a valid Connect Server license on your transfer
server.

Run the following command:
# ascp -A

In the resulting output, look for the following phrase:
Connect Server License max rate

If you need to update your transfer server license, follow the instructions in /BM Aspera Enterprise Server Admin
Guide: Updating Product License.
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Create a system user account on the node.

Run the following command:
# useradd username

The examples in this topic use xfer user as an example username.

The following steps use the asconfigurator utility to modify the aspera.conf configuration file, located at /
opt/aspera/etc/aspera.conf.

3.

Add the user to aspera.conf and set the docroot.
The directory you choose for the docroot is the absolute path for the transfer user. When this node is added to
Console, users cannot access files or folders outside of the docroot.

~, CAUTION: Aspera recommends that you not use spaces in your docroot. If your docroot contains
/= ' spaces, you may not receive all email notifications relating to transfer activity.
Run the following asconfigurator command with the transfer username and the docroot path:

# asconfigurator -x "set user data;user name, username;absolute,/
docroot/path"

For example:

# asconfigurator -x "set user data;user name,xfer user;absolute,/projectl"

Set up token authorization for the user in aspera.conf.

Run the following asconfigurator commands to set the encryption key for the user:

> asconfigurator -x

"set user data;user name, username;authorization transfer in value,allow"
> asconfigurator -x

"set user data;user name, username;authorization transfer out value,allow"
> asconfigurator -x

"set user dataj;user name, username;token encryption key,encryption key"

The encryption key can be any string of numbers. Aspera recommends a string that is at least 20 characters long.
For example:

> asconfigurator -x
"set user data;user name,xfer user;authorization transfer in value,allow"
> asconfigurator -x
"set user data;user name,xfer user;authorization transfer out value,allow"
> asconfigurator -x
"set user data;user name,xfer user;token encryption key,gj50930t78m34ejme9dx"

Set the IP address or hostname for the node in the aspera.conf file with the following asconfigurator
command:

# asconfigurator -x "set server data;server name,ip or hostname"

For example:

# asconfigurator -x "set server data;server name,aspera.example.com"

Set up a transfer user account with a Node API username and password.

Console authenticates to the node machine using a Node API username and password. The following command
creates a Node API user and password and associates it with the system user you created.

Note: Aspera recommends that you use different names for the system user account and transfer user account in
order to minimize confusion when tracing transactions and events.
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a) Run the following commands to set up the Node API user:

# /opt/aspera/bin/asnodeadmin -a -u node api username -
p node api passwd -X system username --acl-set impersonation

# /opt/aspera/bin/asnodeadmin -a -u node user -p XF324cd28 -
X svcAspera --acl-set impersonation

b) Run the following command to check the system user was successfully added to asnodeadmin:
# /opt/aspera/bin/asnodeadmin -1

Given a node user named node_user and a system user named xfer_user, the result should be similar to the
following example:

node user xfer user

Adding, modifying, or deleting a node-user triggers automatic reloading of the user database and the node's
configuration and license files.

Note: If the transfer server on your node is running a transfer server before version 3.5.5, the node is not recent

enough to support setting the "impersonation" ACL. You must upgrade the node to 3.5.5+ or obtain a patch from
Aspera Support.

The transfer node is now ready for connection to Console.

Setting Up a Windows Node

A node is a local, remote, or cloud workstation running an Aspera transfer server product (IBM Aspera Enterprise
Server, IBM Aspera Connect Server). In order to make transfers, Console communicates with a node through the
Node API. The Node API is a daemon on the transfer server that offers REST-inspired file operations and a transfer
management API. Aspera web applications authenticate to remote node services using a Node API username and
password. Different nodes may use different Node API username and password pairs.

Note: The following instructions require you to have administrative privileges.

1.

Verify you have installed IBM Aspera Enterprise Server with a valid Connect Server license on your transfer
server.

Run the following command:
> ascp -A

In the resulting output, look for the following phrase:
Connect Server License max rate

If you need to update your transfer server license, follow the instructions in /BM Aspera Enterprise Server Admin
Guide: Updating Product License.

When you install an Aspera transfer product, the installer automatically creates the Aspera service account
(sveAspera, by default). Aspera recommends using this user as the transfer user. Otherwise, follow the instructions in
the following step to create a new system account on the node.

The examples in this topic use sveAspera as an example username.

2. Create a new system account on the node.



| Adding Nodes to Console | 26

Click Control Panel > User Accounts and add a new account. This system user account is associated with the
Node API account in the steps below.

After creating a Windows user account, log in as that user at least once for Windows to set up the user's home
folder.
The following steps use the asconfigurator utility to modify the aspera.conf configuration file, located at:

C:\Program Files (x86)\Aspera\Enterprise Server\etc\aspera.conf

3. Add the user to aspera.conf and set the docroot.
The directory you choose for the docroot is the absolute path for the transfer user. When this node is added to
Console, users cannot access files or folders outside of the docroot.

<~ CAUTION: Aspera recommends that you not use spaces in your docroot. If your docroot contains
/ = ‘4 spaces, you may not receive all email notifications relating to transfer activity.
Run the following asconfigurator command with the transfer username and the docroot path:

> asconfigurator -x "set user data;user name, username;absolute, /
docroot/path"

For example:

> asconfigurator -x "set user dataj;user name,xfer user;absolute,/projectl"

4. Set up token authorization for the user in aspera.conf.
Run the following asconfigurator commands to set the encryption key for the user:

> asconfigurator -x

"set user dataj;user name, username;authorization transfer in value,allow"
> asconfigurator -x

"set user data;user name, username;authorization transfer out value,allow"
> asconfigurator -x

"set user data;user name, username; token encryption key,encryption key"

The encryption key can be any string of numbers. Aspera recommends a string that is at least 20 characters long.
For example:

> asconfigurator -x

"set user data;user name, svcAspera;authorization transfer in value,allow
> asconfigurator -x

"set user data;user name, svcAspera;authorization transfer out value,allow
> asconfigurator -x

"set user data;user name, svcAspera;token encryption key, encryption key

5. Set the IP address or hostname for the node in the aspera.conf file with the following asconfigurator
command:
> asconfigurator -x "set server data;server name, ip or hostname"
For example:

> asconfigurator -x "set server data;server name,aspera.example.com"

6. Set up a transfer user account with a Node API username and password.
Console authenticates to the node machine using a Node API username and password. The following command
creates a Node API user and password and associates it with the system user you created.

Note: Aspera recommends that you use different names for the system user account and transfer user account in
order to minimize confusion when tracing transactions and events.
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a) Run the following commands to set up the Node API user:

> asnodeadmin -a -u node api username -p node api passwd -
x system username --acl-set impersonation

> asnodeadmin -a -u node user -p XF324cd28 -x svcAspera --acl-set
impersonation

b) Run the following command to check the system user was successfully added to asnodeadmin:
> asnodeadmin -1

Given a node user named node_user and a system user named svcAspera, the result should be similar to the
following example:

node user svcAspera [impersonation]

Adding, modifying, or deleting a node-user triggers automatic reloading of the user database and the node's
configuration and license files.

Note: If the transfer server on your node is running a transfer server before version 3.5.5, the node is not recent
enough to support setting the "impersonation" ACL. You must upgrade the node to 3.5.5+ or obtain a patch from
Aspera Support.

7. Set up the transfer user account as a user in Enterprise Server, if it is not already configured.

For more information on adding users, see the IBM Aspera Enterprise Server Admin Guide: Setting Up Users.

The transfer node is now ready for connection to Console.

Setting Up an OS X Node

A node is a local, remote, or cloud workstation running an Aspera transfer server product (IBM Aspera Enterprise
Server, IBM Aspera Connect Server). In order to make transfers, Console communicates with a node through the
Node API. The Node API is a daemon on the transfer server that offers REST-inspired file operations and a transfer
management API. Aspera web applications authenticate to remote node services using a Node API username and
password. Different nodes may use different Node API username and password pairs.

Note: The following instructions require you to have administrative privileges.

1. Verify you have installed IBM Aspera Enterprise Server with a valid Connect Server license on your transfer
server.

Run the following command:
# ascp -A

In the resulting output, look for the following phrase:
Connect Server License max rate

If you need to update your transfer server license, follow the instructions in IBM Aspera Enterprise Server Admin
Guide: Updating Product License.

2. Create a system admin account on the node.

a) Go to System Preferences # Users & Groups.
b) Click the lock button and enter your admin credentials to make changes.
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¢) Click the add button

d) Select Administrator from the New Account drop-down menu.

e) Name the account.

f) Enter and verify a password for the account.

g) Click Create User.

h) Click Login Options in the users panel.

i) Click the Join button next to Network Account Server.

j) Click Open Directory Utility.

k) In the Directory Utility window, click the lock button and enter an administrator account and password to
make changes.

1) From the menu bar, select Edit # Enable Root User.

m) Enter and verify the password.

n) Click OK.

The following examples use xfer user as an example username.

The following steps use the asconfigurator utility to modify the aspera.conf configuration file, located at:

3.

/Library/Aspera/etc/aspera.conf

Add the user to aspera.conf and set the docroot.

The directory you choose for the docroot is the absolute path for the transfer user. When this node is added to
Console, users cannot access files or folders outside of the docroot.

~, CAUTION: Aspera recommends that you not use spaces in your docroot. If your docroot contains
/ = * spaces, you may not receive all email notifications relating to transfer activity.
Run the following asconfigurator command with the transfer username and the docroot path:

# asconfigurator -x "set user data;user name, username;absolute,/
docroot/path"

For example:

# asconfigurator -x "set user data;user name, svcAspera;absolute,/projectl”

Set up token authorization for the user in aspera.conf.

Run the following asconfigurator commands to set the encryption key for the user:

# asconfigurator -x

"set user data;user name,username;authorization transfer in value,allow"
# asconfigurator -x

"set user data;user name, username;authorization transfer out value,allow"
# asconfigurator -x

"set user data;user name, username; token encryption key,encryption key"

The encryption key can be any string of numbers. Aspera recommends a string that is at least 20 characters long.
For example:

# asconfigurator -x
"set user dataj;user name,xfer user;authorization transfer in value,allow"
# asconfigurator -x
"set user data;user name,xfer user;authorization transfer out value,allow"
# asconfigurator -x
"set user data;user name,xfer user;token encryption key,gj50930t78m34ejmeddx"

5. Set the IP address or hostname for the node in the aspera.conf file with the following asconfigurator

command:
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# asconfigurator -x "set server data;server name, ip or hostname"
For example:

# asconfigurator -x "set server data;server name, aspera.example.com"

Set up a transfer user account with a Node API username and password.

Console authenticates to the node machine using a Node API username and password. The following command
creates a Node API user and password and associates it with the system user you created.

Note: Aspera recommends that you use different names for the system user account and transfer user account in
order to minimize confusion when tracing transactions and events.

a) Run the following commands to set up the Node API user:

# /Library/Aspera/bin/asnodeadmin -a -u node api username -
P node api passwd -X system username --acl-set impersonation

# /Library/Aspera/bin/asnodeadmin -a -u node user -p XF324cd28 -
X svcAspera —--acl-set impersonation

b) Run the following command to check the system user was successfully added to asnodeadmin:
# /Library/Aspera/bin/asnodeadmin -1

Given a node user named node_user and a system user named xfer_user, the result should be similar to the
following example:

node user xfer user

Adding, modifying, or deleting a node-user triggers automatic reloading of the user database and the node's
configuration and license files.

Note: If the transfer server on your node is running a transfer server before version 3.5.5, the node is not recent
enough to support setting the "impersonation" ACL. You must upgrade the node to 3.5.5+ or obtain a patch from
Aspera Support.

Set up the transfer user account as a user in Enterprise Server, if it is not already configured.
For more information on adding users, see the IBM Aspera Enterprise Server Admin Guide: Setting Up Users.

The transfer node is now ready for connection to Console.

Preparing a Non-Local User to Run the Aspera Central Service

IBM Aspera Console communicates with nodes through the Aspera Central service. When you are setting up a
Windows node and using an Active Directory (or non-local) user to run the Aspera Central service, the user must have
special permissions configured to allow Console to manage the node.

1.
2.
3.

Create or obtain an Active Directory account to use for running the Aspera services.
Add that Domain user account to the local Administrators group.

Go to Control Panel > Administrative Tools > Local Security Policy and give the user special permissions to
allow Console to manage the node machine.

Within the Local Security Policy window, select Local Policies > User Rights Assignment in the left panel, and
add the desired user to the following policies (by double-clicking each policy):

* Act as part of the operating system
* Adjust memory quotas
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* Create a token object

* Logon as a service

* Replace a process level token

Go to Control Panel > Administrative Tools > Services and set the following services to run as the user:
» Aspera Central

* Aspera Sync
*  OpenSSH

To set the service to run as the user, right-click the service and select Properties. Click the Log On tab and select
your user.

Creating a Managed Node in Console

It is best practice to keep all your nodes up to date with the latest version of IBM Aspera High-Speed Transfer Server,
IBM Aspera High-Speed Transfer Server, or IBM Aspera High-Speed Transfer Endpoint.

To verify your node machine's product version, run the following command on your node machine:

> ascp -A

If you have an older version, you can download the latest from http://asperasoft.com/downloads.

6.

. Go to Nodes and click New Managed Node.

Enter your managed node's IP Address and Name.

Important: When adding the Console server itself as a managed node, don't enter 127.0.0.1 as the IP address
unless it is the only node you are planning to add to Console. Even then it is not recommended. Do this only if
your network or firewall configuration interferes with Console communicating with its own external address.
Configure the communication settings.

Update SSH Port, SSH Encryption, and Node API Port if you do not want to use the default values. Select a
default endpoint type from the drop-down menu. You can still change the endpoint type when you add an endpoint
to this node.

Add the node to a failover group.

Select Enable failover and load balancing for Console-initiated transfers on this node. Add the node to an
existing group or select enter new name from the Failover Group Name drop-down menu to create a new group.

If you select enter new name, enter a new failover group name in the prompt. For more information on failover
groups, see Configure Failover Groups on page 66.

Optional: Create the three default Console groups. Select Create default Console groups.

The default transfer Console groups have the following permissions:

* Transfer Admin: Users in this group can manage transfers on this node. This includes initiating, canceling,
and deleting transfers.

* Transfer Initiator: Users in this group can only initiate transfers.

» Transfer Monitor: Users in this group can only monitor transfers.

For more information on Console groups, see Creating Console Groups on page 41

Click Create.

Console redirects you to the Credentials page. For more information on configuring admin credentials, see Updating a
Node's Admin Credentials on page 31.
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Updating a Node's Admin Credentials

If you have not already configured an administrative account on your node machine for use with IBM Aspera
Console, see the following instructions:

*  Windows node: Setting Up a Windows Node on page 25.
* OS X node: Setting Up an OS X Node on page 27.
* Linux node: Setting Up a Linux Node on page 23.

IBM Aspera Console connects to a managed node through SSH for file browsing and node configuration. You must
update Console with the node's SSH credentials before Console can access the node.

If Console automatically redirected you to the Admin Credentials page as part of the process of adding a new
managed node, skip the first step.
1. Go to Nodes. Click the edit link for the managed node, and click the Credentials tab.
2. Select Edit Credentials.
3. Ifyou want to configure the node from Console, enter the node machine's SSH login credentials.
Enter the administrative account username and password to allow Console to connect to the node machine. You

can authenticate the account in one of two ways:

* Password authentication: Enter the account password.

* Public key authentication: Sclect Use SSH Key and select your uploaded key. To use public key
authentication, you must have your SSH private key configured in Console. For instructions, on how to
configure SSH keys in Console, see SSH Keys on page 90.

4. Enter the node machine's Node API credentials.

5. Click Update.

6. Click Test Credentials to make sure Console has a working connection to the node.
If successful, the message "Successfully connected to node via SSH and Node API" appears in green at the top of
the page.

A connection is established between Console and your managed node. To edit or remove a node, go to Nodes for a list
of managed nodes and click edit or delete for the designated node.

Adding Unmanaged Nodes

It is best practice to keep all your nodes up to date with the latest version of IBM Aspera High-Speed Transfer Server,
IBM Aspera High-Speed Transfer Server, or IBM Aspera High-Speed Transfer Endpoint . Verify the machine's
product version with the administrator of the node.
1. Go to Nodes. Click List Unmanaged Nodes.
2. Click New Unmanaged Node.
3. Enter the node's Address (IP or domain name) and Name.

Note: Console does not send notifications when an unmanaged node is using a fully qualified domain name

(FQDN) instead of an IP address if the transfer is started by IBM Aspera Enterprise Server or IBM Aspera Point-
to-Point Client. Console still sends notifications for transfers started by Console.

4. Select the default endpoint type from the drop-down menu.

You can still change the endpoint type when you add an endpoint to this node.
5. Configure SSH.

Enter the SSH Port number and select the SSH Encryption method from the drop-down menu.
6. Click Create when finished.

7. To verify that your new node has been created, select List Unmanaged Nodes and look for your unmanaged node
in the table.
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A connection should be established between Console and your unmanaged node. To edit or remove a node, go to
Nodes and click List Managed Nodes for a list of managed nodes. Click edit or delete for the designated node.

Connecting IBM Aspera Shares to Console

Note: Console requires Shares version 1.9.3 and later.
To initiate a Console transfer with an Aspera Shares application as an endpoint, follow the steps below:

1. Add Shares as an unmanaged node to Console with default endpoint type as Shares and Node API port as 44 3.

Adding the Shares application as an unmanaged node makes it easier to save Shares credentials for use in
transfers. Aspera does not recommend adding Shares applications as managed nodes because they lack the
capabilities necessary for monitoring.

For more instructions on adding an unmanaged node, see Adding Unmanaged Nodes on page 31.
2. Create a Shares endpoint for the unmanaged node.
For instructions on adding an endpoint to the node, see Adding Endpoints on page 33.
3. Add nodes used by the Shares application as managed nodes in Console for transfer monitoring.
For instructions on adding a managed node, see Creating a Managed Node in Console on page 30.
4. Create a simple or smart transfer with the Shares endpoint.
For instructions on creating simple or smart transfers, see Starting a Simple Transfer on page 55 and Creating
a Smart Transfer on page 57, respectively.

Important: You cannot initiate transfers between Shares endpoints and SSH endpoints, or between two Shares
endpoints. For more information about restrictions on endpoint combinations, see Console Transfer Special
Conditions on page 54.

Understanding Endpoints

An endpoint serves as a transfer source or destination for transfers initiated in the Console Ul between nodes
(managed or unmanaged) and between nodes and clusters. It is defined by a login credential and address. These
appear in the Transfer drop-down menus for Source and Destination as /ogin@address, such as xasp1@10.0.0.2 for
a node or ats-aws-us-east-1.aspera.io for a managed cluster.

Whenever a node or cluster is added to Console, Console automatically creates a "wildcard" endpoint with the format
*@address (for example, *@198.51.100.22. A wildcard endpoint

created with the form The wildcard endpoint is listed as just the IP address or domain name. When a user selects the
wildcard endpoint as a source or destination, they must enter credentials to authorize the transfer. Wildcard endpoints
enable you to monitor all transfers on a node per user account or access key.

Console admins can add more endpoints to nodes and clusters, and configure them with credentials. The credentials
required to set up and use an endpoint depend on the endpoint type:

* SSH: An Aspera transfer user's username and either a password or SSH key.
* Node API: An Aspera node username and password. (Only supported for managed nodes)
* Access Key: An Aspera access key and secret. (Only supported for clusters)

When you create a new endpoint, you can enter the credentials or leave the password/secret field blank (you must
provide a login - a username or access key). Sharing a credentialled endpoint with a user who does not have login
credentials allows that user to send or receive files without compromising the security of your nodes. When the
password for the endpoint is not set, the user must enter it when initiating a transfer. These credentials are then stored
in the user's Saved Endpoints under the Preferences tab.
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Adding Endpoints

An endpoint serves as a transfer source or destination for transfers initiated in the Console UI between nodes
(managed or unmanaged) and between nodes and clusters. It is defined by a login credential and address. These
appear in the Transfer drop-down menus for Source and Destination as login@address, such as xasp1@10.0.0.2 for
a node or ats-aws-us-east-1.aspera.io for a managed cluster.

For more information about endpoints, see Understanding Endpoints on page 32.

Tip: To use domain names as transfer endpoints, create an unmanaged node using a domain name, then add an
endpoint to this unmanaged node.

1. Open the Endpoint dialog for a node or cluster.

* To add an endpoint to a managed node or cluster, go to Nodes and click edit for the node or cluster to which
you want to add an endpoint.

* To add an endpoint to an unmanaged node, go to Nodes > List Unmanaged Nodes and click edit for the node
or cluster to which you want to add an endpoint. Click the Endpoints tab.
2. Add a new endpoint.

Click Add Endpoint and enter the following information:

* Endpoint type: Select the endpoint type from the drop-down menu.

* Login: The username or access key.

* Password: The password, SSH public key, or secret. If left blank, users must enter the password, SSH public
key, or secret to authorize a transfer with the endpoint. The credentials required to set up and use an endpoint
depend on the endpoint type:

* SSH: An Aspera transfer user's username and either a password or SSH key.
* Node API: An Aspera node username and password. (Only supported for managed nodes)

+ Access Key: An Aspera access key and secret. (Only supported for clusters) To use SSH keys, the user
must have their private key configured in Console. For instructions, see SSH Keys on page 90.

Important: When using SSH key authentication, make sure that the key file on the node is not a shared
key. On the node computer, the key file should be a "private" key in the specified user account.
» Label: Optional descriptive name for the endpoint. Default is login@node address
* Email address: The email address to receive notifications of transfer activity on this endpoint. You can enter
multiple email addresses by clicking Add after each one, then select which notifications to send to which email
addresses from the drop-down menus.

Click Create.
3. Verify that your endpoint is configured correctly and that the connection works.

The new endpoint appears in the list of endpoints. To test the connection, click test and, on the following page,
Test Connecting to Host. If successful, a confirmation message appears in green at the top of the page. If
unsuccessful, a description of the error appears in red at the top of the page and the SSH Client Log appears at the
bottom of the page.

The endpoint is now configured. If Password Saved is selected in the Endpoints table, the endpoint contains a
password, an SSH key, or a secret, depending on the endpoint type, and permitted users are not required to enter
credentials to use this endpoint. To edit or remove an endpoint, click edit or delete.

Set a Global Docroot for the Node

A document root, or docroot, is the area of a machine that a system user has permission to access. Setting docroots are
important for maintaining security by keeping unqualified users from accessing confidential information.

1. Go to Nodes and click edit for the node.

2. Go to Accounts and click edit for the user or group you want to configure.
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3. Expand the Docroot configuration section and click Browse. Choose the file directory you want to set as the
docroot.

The docroot is a security feature that allows you to restrict the area asperawatchfolderd can access. If you
need to acces the entire file system, you can set the docroot path as C: \ or leave it empty. The directory you
choose is configured in the aspera. conf configuration file on the transfer node.

4. Click Save changes.

Adding Managed Clusters to Console

Adding a Managed Cluster to Console

A transfer cluster is a provisioned cluster of Aspera servers in the cloud that autoscales with traffic and use. Console
can monitor transfers running on managed clusters using access key authentication for each node. You can also

run reports on managed clusters. For information on configuring the Aspera Transfer Cluster, see the IBM Aspera
Transfer Cluster Manager Admin Guide.

To add a cluster to Console, follow the instructions below.

1. Go to Nodes and click the New Managed Cluster button.
Enter the cluster's domain name address in the Domain Name field.
Name the cluster in Console.

Configure the cluster API port. Port 443 is the default port for communicating with Aspera clusters.

Nk w

If you want to use HTTPS to connect to node, select Use HTTPS to connect to node. Aspera recommends using
this feature for security reasons.

6. If you want Console to verify the SSL certificate of cluster nodes, select Require signed SSL certifcate.
7. Click Create.

Console redirects you to the Credentials page to add access keys for authentication. For more information about
adding access keys, see Adding Access Keys to a Managed Cluster on page 34.

Adding Access Keys to a Managed Cluster

Aspera Transfer Clusters use access keys to authenticate to other Aspera products. Each transfer cluster can have
multiple access keys. For more information about access keys and access key management, see the entries in the /BM
Aspera Transfer Cluster Manager Admin Guide: Managing a Cluster section.

Follow the instructions below to add access keys to a managed cluster.

1. Go to Nodes. Click the edit link for the managed cluster and click the Credentials tab.
Click the Add Access Key button.

Give the access key a name to differentiate it from other keys.

Enter the ID and Secret associated with the key.

Click Update.
Console redirects you to the list of Access Keys for this cluster. Verify that your new access key is in the list.

AN ol o

6. Test your new access key by selecting test.
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Managing Nodes

Editing the User or Group on a Node

IBM Aspera Console can configure user and group account settings for managed nodes that have valid admin
credentials saved in Console. For more information on updating admin credentials, see Updating a Node's Admin
Credentials on page 31.

1.
2.

6.

Go to Nodes and click edit for the node you want to edit. Click Accounts.

Make sure that the group or user you want to configure has already been created and is available on the node
machine. Console automatically detects new groups and users and lists them under the node's Accounts tab, but if
the group or user is not listed, click Add Group or Add User.

Depending on whether you want to configure a node user or a node group, select Users or Groups.

Select the edit link for the user or group account you want to edit.

Configure the user or group account's transfer options. For more detailed information on these options, see Node
Account-Level Configuration Options on page 151.

Open all Open overridden Close all

¢ Docroot

p  Authorization
¢ Bandwidth
¢ Advanced File Handling

» Advanced Network Options

When you are finished, click Save changes.

Set a Docroot for a Node User or Group

A document root, or docroot, is the area of a machine that a system user has permission to access. Setting docroots
are important for maintaining security by keeping unqualified users from accessing confidential information. To set a
docroot for a node user or group, you must have already added them into Console. For more information about adding
node users or groups to Console, see Editing the User or Group on a Node on page 35.

1.
2.
3.

Go to Nodes and click edit for the node.
Go to Accounts and click edit for the user or group you want to configure.

Expand the Docroot configuration section and click Browse. Choose the file directory you want to set as the
docroot.



4.
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The docroot is a security feature that allows you to restrict the area asperawatchfolderd can access. If you
need to acces the entire file system, you can set the docroot path as C: \ or leave it empty. The directory you
choose is configured in the aspera . conf configuration file on the transfer node.

Click Save changes.

Converting Legacy Nodes

A node running an Aspera transfer product with a version prior to 3.4.6 is considered a legacy node and continues to
report to Console using the legacy mechanism. To take full advantage of Console's architecture, upgrade the Aspera

transfer products on legacy nodes to the latest version and convert legacy nodes to use the Node API in the Console

3.0+ Node Maintenance page.

Important: Once you convert from a legacy node to a regular node, you cannot revert back to a legacy node.

1.

On the node machine, upgrade your Aspera transfer product to its latest version. To check the version of the
running transfer product, run the following command:

> ascp -A

Configure an administrative account and API user on your node machine.

*  Windows node: Setting Up a Windows Node on page 25.

* OS X node: Setting Up an OS X Node on page 27.

* Linux node: Setting Up a Linux Node on page 23.

From the Console menu, select Nodes. Select the edit link for a node that Console shows is a "Legacy Node".
Click Node API and enter your Node API credentials for the node machine.

For more information on updating a node's admin credentials, see Updating a Node's Admin Credentials on page
31.

Click Convert and then click Convert to use Node API. When prompted by the browser to confirm conversion,
click OK.

Note: If you do not see Convert to use Node API, make sure you have correctly configured your Node API
credentials on the machine and entered them into Console. Edit the node in Console, click Credentials, and click
Test Credentials.

Select Open all to expand all available configuration options. Clear any overridden values in the Database and
Transfer Server sections.

7. Select Save changes.

8. Restart the Aspera Central service on the node.

*  Windows:
Use the Computer Management window. Go to Manage > Services and Applications >Services.
* Linux:
# service asperacentral restart

« OSX:

S sudo launchctl stop com.aspera.asperacentral
$ sudo launchctl start com.aspera.asperacentral

Console now displays your legacy node as a regular node in the node list.
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Configuring Virtual Links

Configure Virtual Links (Vlink) on a node to create a "virtual" bandwidth cap for the node. Transfer sessions assigned
to the same Vlink take up equal shares of the capped bandiwdth.
1. Go to Nodes, find the desired node, and click edit. Click Vlinks > New Vlink.

2. Enter a number for the Vlink ID and name the Vlink. Sessions assigned with the same ID share the same
bandwidth cap.

3. Select True to activate the Vlink.

4. Enter a value for the capacity. When applying this Vlink to a transfer, the transfer's bandwidth will be restricted by
this value.

5. Click Create.

After creating a new Vlink, you have the option of configuring the Vlink to run on a schedule by clicking Edit Time
Varying Schedule and then New Schedule. For more information on scheduling Vlinks, see Scheduling Virtual Links
on page 37.

Scheduling Virtual Links

After creating a new virtual link, you have the option of configuring the Vlink to run on a schedule.

1. Go to Nodes, find the desired node, and click edit. Click Vlinks, find the desired Vlink, and click edit.
2. Click Edit Time Varying Schedule and click New Schedule.

Configure the following options.

Options Description

On the following Select the days or set of days for which the bandwidth rate cap is enforced.

days

From the following | Enter a time to start the bandwidth rate cap.

time

To the following Enter a time to stop the bandwidth rate cap.

time

Set the rate to Enter a value for the scheduled virtual bandwidth cap. When applying this Vlink to a
transfer, the transfer's bandwidth will be restricted by this value based on the configured
schedule.

Note: Overlapping time schedules are not supported. If there are overlapping schedules, they are not accurately
reflected in the Vlinks chart, and precedence is indeterminate.

3. Click Update.

Setting Up Cloud Storage from the Console

Enabling S3 Storage Using Console

IBM Aspera Console can use S3 storage for a node transfer user by specifying the storage in the user docroot. Use
this user to transfer files to and from your S3 storage. The steps below assume the following:

* You have purchased and booted up your Aspera On Demand product.
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* You have created an S3 bucket.
*  You have permissions to create [AM roles or change the policies of your [AM.
*  You know how to SSH as root to your Aspera On Demand instance.

1. In Console, select a node and edit its transfer user from the Accounts tab.

2. Expand Docroot, click Override, and paste the S3 docroot for that user using the following syntax:

S3://access _id:secret key@s3.amazonaws.com/my bucket/my path

+ Docroot Override

Ove Default Help

EFFECTIVE VALUE

Q@ Browse
Absolute Path S3./access_idisecret_key(@s3.amazona
Read Allowed * true L false
Write Allowed * true '\ false
Browse Allowed * true ' false

Use URL encoding for special characters in your S3 Access ID and secret key. For example, encode a slash
character (/) by replacing it with $2F and encode a plus character ( + ) by replacing it with $2B.

Click on the Save Changes button.

For more information about setting a user's docroot, see Editing the User or Group on a Node on page 35.
3. Restart the Aspera NodeD service on the node.

SSH into the node and run the following command:

# ssh -i identity file -p 33001 ec2-user@ec2 host ip
# service asperanoded restart

Configure advanced S3 storage settings and test your configuration.
4. Optional: Enable advanced S3 storage settings.

» Enable Reduced Redundancy Storage (RRS): Append the following to the docroot:
?storage-class=REDUCED REDUNDANCY

For example, enter:

S3://access id:secret key@s3.amazonaws.com/my bucket/my path?storage-
class=REDUCED_ REDUNDANCY

» Enable S3 Server Side Encryption (SSE). Append the following to the docroot:
?server-side-encryption=AES256

For example, enter:

S3://access id:secret key@s3.amazonaws.com/my bucket/my path?server-
side-encryption=AES256

5. Test your configuration. Perform a test transfer using an Aspera client to the account configured with the S3
docroot. For information on starting a transfer, see Starting a Simple Transfer on page 55.
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Enabling SoftLayer Storage Using Console

IBM Aspera Console can use SoftLayer storage for a node transfer user. Use this user to transfer files to and from
your SoftLayer storage.

CAUTION: When transferring files larger than 64 MB to SoftLayer storage, an . aspera-segment

- 5__1 directory is created at the destination. Do not move this directory or modify any files in it. Doing so may
cause corruption or loss of data.

1. Go to Nodes and click the edit button for the node.

2. Go to Accounts and click edit for the account to configure with SoftLayer access.

Note: You can also create a new account by clicking on the Add User button. For information on how to add a
new account, see Editing the User or Group on a Node on page 35.

. Enter the SoftLayer docroot.

Expand Docroot, click Override, and paste the SoftLayer docroot for that user using the following syntax:

swift://username:api key@Object Storage URI/bucket name?
aspera.swift.endpoint.auth-path=%2Fauth%2Fv1.0

v Docroot e

EFFECTIVE VALUE

Absolute Path R Browse
swift://IBMO5303446-2% 3Ahhemant:3c 1
Read Allowed ® true " false
Write Allowed * true ' false
Browse Allowed ® true ' false

Use URL encoding for special characters. For example, encode the colon ( : ) by replacing it with $3A.

4. Click on the Save Changes button.

. Restart asperanoded on the node.

SSH into the node and run the following command:

# service asperanoded restart

. Test your configuration. Perform a test transfer using an Aspera client to the account configured with the

SoftLayer object storage docroot. For information on starting a transfer, see Starting a Simple Transfer on page
55.

Managing User Accounts

Accounts and Permissions

Definition of Terms

User: A user is a Console login account with customizable access permissions.
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*  Group: A group defines the transfer permissions of all its users.

» Transfer Path: A transfer path consists of two endpoints, the transfer direction (one-way or two-way), and a set of
permissions that authorize starting transfers, monitoring transfers, and enabling email notifications.

Overview

Console uses a combination of groups, transfer paths, and user accounts to manage to user permissions. A user that
belongs to a group inherits permissions defined within the groups it belongs to. A group's permissions are defined by
its transfer paths. If you have a non-admin user and you want them to be able to see certain transfers, you need to add
them to a group. This group must have one or more transfer paths that specify the kinds of transfers that members of
the group are allowed to see or control.

Each group can contain one or more transfer paths. In the figure below, Group 1 contains two transfer paths, #1 and
#2. A Console user inherits transfer permissions from all of the groups he or she belongs to. For example, Console
User 2 belongs to both Group 1 and Group 2, and has the permissions to use Transfer Paths #1, #2, and #3.

& &

Group? Group2
Transfer Path #1 Transfer Path #3

Transfer Path #2

Console User 1 Console Usar 2 Consola User 3

Permissions: Permissions:

Transfer Path #1 Transfer Path #1 Transfer Path #3
Transter Path #2 Transfer Path #2

Transfer Path #3

Tip: Console administrators are able to view and control all transfers. They automatically inherit permissions of any
existing Console groups. They can add, edit, and delete any nodes, Console users, and Console groups.

Default Console Groups
When adding a new node, you have the option of creating three default groups associated with that node.

Group name Description

Transfer Administrators The users in this group can monitor, control, and set up email notifications of
all transfers on the node. They can start simple and smart transfers between
this node and any node, and share smart transfer templates with other users.

Transfer Initiators The users in this group can start simple and smart transfers between this
node and any node.

Transfer Monitors The users in this group can monitor and set up email notifications of all
transfers on this node.

Creating Console Groups and Users
For instructions on creating a new Console group, see Creating Console Groups on page 41.

For instructions on creating a new Console user, see Creating Console Users on page 42.
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Creating Console Groups

Console uses a combination of groups, transfer paths, and user accounts to manage to user permissions. A user that
belongs to a group inherits permissions defined within the groups it belongs to. A group's permissions are defined by
its transfer paths. If you have a non-admin user and you want them to be able to see certain transfers, you need to add
them to a group. This group must have one or more transfer paths that specify the kinds of transfers that members of
the group are allowed to see or control.

Tip: Console administrators are able to view and control all transfers. They automatically inherit permissions of any
existing Console groups. They can add, edit, and delete any nodes, Console users, and Console groups.

Important: You must first manually add a group to the node OS before you can add it in Console.

1. Go to Accounts > Groups and click New Group.

2. Enter the group name and a brief description. When finished, click Create.
You are redirected to a page that allows you to configure the group.

3. Click Add Transfer Path.
A transfer path determines a user's permissions to create, initiate, and monitor transfers from one endpoint to
another. A transfer path consists of two endpoints, the transfer direction (one-way or two-way), and a set of
permissions that authorize starting transfers, monitoring transfers, and enabling email notifications.

4. Select the endpoints for the transfer path.

For a unidirectional transfer path, set Endpoint 1 as your source endpoint and Endpoint 2 as your destination
endpoint. Order does not matter for a bidirectional transfer path. If you specify a node user in an endpoint, users
in the group are limited to monitoring only transfers on the node machine that involve the specified node user. An
example of such a transfer is a transfer initiated using the specified node user's credentials. Selecting "Any" grants
users transfer path permissions to all nodes.

Important: When you select Any as an endpoint and permit users to start simple or smart transfers, users can
enter arbitrary addresses for file transfers.
5. Choose the direction of the transfer path.
A transfer path can be unidirectional or bidirectional.
* Unidirectional (to): Console users can create, initiate, and monitor transfers initiated from Endpoint 1 to
Endpoint 2 (depending on the transfer path permissions) but not the other way around.

» Bidirectional (to/from): Console users can create, initiate, and monitor all transfers (depending on the transfer
path permissions) between Endpoint 1 or Endpoint 2.

6. Choose the permissions you want to give users in the group.

Item Description

Start Simple Transfers Users can start a simple transfer.

Start Smart Transfers Users can start smart transfers.

Create Smart Transfers Users can to create a smart transfer template.

Share Smart Transfers Users can to share smart transfer templates with other users.

Control Transfers started | Users can control other users' transfers. For example, they can stop, pause, and set
by others the rate of a transfer, and so on.

View Transfers started by | Users can view other users' transfers on the same transfer paths.
others

Opt-in to email Users can enable email notifications for this transfer path.
notifications

7. Optional: Enter a description for this transfer path.
8. When finished, click Create.
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The Editing Group Details screen displays the new transfer path in the Transfer Paths list. To modify or remove
the transfer path, click edit or delete, respectively.

9. Add users to the group.
Select a Console user from the members drop-down and click Add.
Tip: Alternatively, you can assign group members through user management. See Creating Console Users on
page 42.

10. Click Update.

Creating Console Users

Console user is a Console login account with customizable access permissions. Except for administrator accounts,
Console user permissions are managed through group assignment. A Console user inherits permissions from its
groups.

Note: Console users are not directly related to the login account to a node.

1. Go to Accounts > Users and click New User.

2. Enter a login username, the user's first and last name and an email address. Set the user's time zone.

Important: All activity on the Console is dated according to the user's time zone.

3. Optional: Select Set password to create a password for the user account. If you do not set a password, Console
generates a temporary password for the account and emails the password to the user.

Tip: You can change password requirements in the Console Password Options section. Go to Configuration >
Defaults For more information on password requirements, see Configuring Console Defaults on page 110.

4. Optional: Disable user login by clearing Active (allow user to login).
If you wish to finish setting permissions for the user account before allowing the user to log in, disable the account
by clearing Active (allow user to login). To re-enable the account, return to these settings and select Active
(allow user to login). User login is enabled by default.

5. Optional: Disable reporting features for the user by clearing Reports Allowed.

6. When finished, click Create.
The system sends an account creation notification email to the designated email with the account's username and

password. If you do not set a password, Console generates a temporary password for the account and include that
in the email.

The following step is only applicable when creating non-admin users. All admin users have full permissions to all
groups and transfer paths. After creating a non-admin user, Console redirects you to the user permissions page.
7. Assign the user to Console groups.

Assign the user to groups with the desired transfer-path permissions. To assign the user to a group, select a group

from the drop-down menu and click Add. You can review the Console user's transfer permissions in a table listing
all transfer paths accessible by this user

Once the Console user account is created, users can log in to Console with the proper account credentials. To
deactivate this account or make other changes to it, go to Accounts > Users. Locate the account you want to change
in the list of all Console users.

» To deactivate or reactivate the account, change it to a Console administrator, or modify any of the basic account
information, click edit.

» To modify transfer permissions and group membership, click permissions.
* To remove a Console user from the system, click delete.
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Monitoring Console

The Console Dashboard

The Dashboard provides a quick overview of all transfer activities and the statuses of nodes for which you have
monitoring permissions. It gives continuous updates and helps identify transfer and node problems.

Go to Dashboard. The Dashboard contains the following six panels:

Current Transfers

Current Transfers lists up to ten ongoing transfers on all monitored nodes. To view all active transfers, click the
Current Transfers header.

» Current Transfers

NAME CONTACT ETA STATUS
SLES to Fedora admin (console)  10:31am
100MB root (ssh) 10:31am
NAB Demo Transfers user01 (console)  10:38am [ 8% ]
Test Transfer admin (console) Queued

Scheduled Transfers

Scheduled Transfers lists up to ten scheduled transfers on all monitored nodes. To view all scheduled transfers, click
the Scheduled Transfers header.

» Scheduled Transfers
NAME CONTACT SCHEDULED START
From Mew York to London admin (console) 10:00am 7-Jul (r)

Weekly Transfer admin (console) 10:29am 12-Jun (r)

Recent Transfers

Recent Transfers lists up to ten recent transfers on all managed nodes. To view all recent transfers, click the Recent
Transfers header.



» Recent Transfers
NAME

Test Transfer
MAB Diemo Transfers
SLES to Fedora

100MB

Problem Transfers

CONTACT

admin (console)
userd1 (console)
admin (console)

root (ssh)

ENDED
10:35am

10:34am
10:32am

10:30am

TRANSFERRED
329 mB

28 MB
10.7 MB

100 MB
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Problem Transfers lists up to ten transfers with errors on all managed nodes. To view all transfers with errors, click

the Problem Transfers header.

= Problem Transfers

TRANSFER
SLES to Fedora #3

testtransfer 3

Fraom Mew York to London

Map

CONTACT

admin (consaole)

admin (console)

admin (consaole)

TIME
10:42am

10:42am

10:38am

STATUS

ser aborted
session

Cancelled while
waiting in queue

ser aborted
ses5ion

The map shows the status of all your monitored nodes and shows the transfers between them. If a node fails, the icon
becomes red in the map, and the node and the problem are listed in the table below the map.

Nodes are not automatically added to maps. They must be configured. For more information, see Configuring the

Map on page 49.



= Map

NODE PROBLEMS

fedora

ADDRESS
10.0.202.250

NODE STATUS

SOAP Connection Prablem
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Note: You can choose to hide or display the map and bandwidth chart by clicking the blue arrow ( bl') next to the

map.

Bandwidth

The Bandwidth chart shows bandwidth usage of your monitored nodes. If you select one or more nodes on the map,
the chart shows the cumulative bandwidth of the selected nodes.

= Bandwidth

0.
ao.
70,
60.
50.
40,
30.
20,

10.

Mby's
Mbys
Mby's
Mby's
Mbys
Mby's
Mbys
Mby's
Mby's

Mb/'s

INBOUND

CUTBOUND

0.0 Mb/s
20.0 Mby/s
70.0 Mby/s
50.0 Mby/s
50.0 Mby/s
40.0 Mb/s
20.0 Mbys
20.0 Mb/s
10.0 Mb/s
0.0 Mbys
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Note: You can choose to hide or display the map and bandwidth chart by clicking the blue arrow ( P ) next to the
map.

The Activity Overview

The Activity Overview page lists all transfers on all managed nodes. View the Activity Overview page by going to
Activity. You can narrow down the list with the filter and advance into a transfer's session detail page. The Activity
Overview screen displays the following information:

Item Description

NAME The transfer's name.

DETAILS The transfer initiator, source, and destination.

START This transfer's start time.

END The estimated time of arrival, or the transfer completion time.

STATUS Current status of this transfer.

AVG RATE The transfer rate of the active transfer, or the average rate of a past transfer.

ACTIONS Show all available actions. For example, pause and cancel for a running transfer or rerun
for a past transfer.

Transfers Synt Jobs

Histary: | Past hour ¥ Scheduled: | Mone v Status: | A v Search: | Transfer Mame ¥ advanced
= Current

NAME DETAILS 5TART  END STATUS RATE ACTIONS

Long Transfer aspl {console), Node 1 fo Node 2 3:03pm  3:08pm (ETA 3149 M8 8.7 Mbps pause C AN
Long Transfer admin {console), Node 1 fo Node 2 3:03pm  3:04pm (ETA, 31.9 M8 BT Mbps pause C AN
= Past

HAME DETAILS 5TART END STATUS AVG RATE ACTIONS
Small Transfer to Un  admin {console), Node 2 fo Node 3 {Unmanaged J:03pm  3:03pm Error: failed to authenticate rernsn

Small Transfer admin {console), Node 1 fo Node 2 J:0ipm  3:01pm Completed BB Mbps  rerun

The Current panel lists all currently active transfers, including running and queued transfers. The Past panel shows
previous transfers, including those that were completed, canceled, or those that generated errors.

The filter options on the top can be used to narrow down the list.

Item Description

History Select the time frame to display the started transfers.
Scheduled Select the time frame to display the scheduled transfers.
Status Select a specific transfer status to display.

Search Search for keywords in transfer sessions.
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You can also perform an advanced search by clicking on the advanced link. For more information on searching, see
Search for a Transfer on page 51.

Transfer Details

Overview
Details about a particular transfer can be accessed by clicking on a transfer shown in listings of past, current, and
scheduled transfers. These lists can be found in three locations:

» The Activity Overview page
* The Console Dashboard
» The Managed Node Detail page (the specific node from Nodes in the Console menu)

Ongoing Transfers
For an ongoing transfer, the Session Detail page provides the transfer monitor that displays current transfer status.
You can control the transfer through the options shown at the top of the graph.

Rates Targst: | 10000 pin o | Set || Fair v | | M Pauze | Cancel
2.0 Mby's
E.D Mb/=
7.0 Miys
&.0 Mby's
5.0 Mby's
4.0 Mby'=
30 Miys
2.0 Mby's
1.0 Miy's
0.0 Mby'=

Important: The failed files counter may count "directories" if the network failed at some point or the user cancelled
the transfer.

Finished or Failed Transfers
For a finished or failed transfer, the Session Detail page provides detailed information about the transfer's state,
endpoints, and statistics.
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Session State Endpoints Statistics
Session status;  Tunning Initigtor: Source Started: 2015-10-23 15:13:00
of 300 ME Source: Hode 1{10.0.203.28)  Eigpsed Im 24s
ETA: 2015-10-23 15:17:25 P — Bytes to transfer: 300 MB
- _— Source path(s): /sent_fies/100MB _ )
Flkes: g ;f-:hD;E'Cld'ﬁDEIE. 0 Failed, -.5E|-|1-_f lss/200MB Bytes written: B0.5 MB
- fasn2 Diestination: Hode 2 (10.0.202.245) Average rate: 2.0 Mbps
_,3-15::-".: asp nbound queue Network delay: 1ms
Encrypion: Nane Diest. path: received_files Motifications: start, success & error
Session D 1 1
Target Rate: 10.0 Mbps
Minimumn rate: 0 bps
Rate Polizy: Adaptive

The Session Files panel lists all files being transferred in this session. Click on a file to review its information. You
can use the search box to show only specific files or groups of files.

Note: When searching for files, "*" is not a wildcard. Any string you enter is treated as a "search within". In other
words, the string "foo" will match "123foo0", "fo0456", and "123fo0456".

HAME S5TATUS STARTED STOPPED 5I1ZE
homelaspera/node_files/sent_files/200ME 1:14pm 200 MB
home/aspera/node_files/sent_files/1D0MB completed 3:13pm 3:14pm 00 MB

Console also lets you monitor notification information that includes messages about transfer starts, successes, errors,
and what notification templates were used under the Statistics column. Next to Notifications is a link describing some
combination of start, success, and error depending on what notifications were configured for the transfer, or None

if no notifications were configured. Select the link to see the Session Notifications page. For more information, see
View Email Notification Statistics on page 17.

Multiple-Session Transfer

A multiple-session transfer is a smart transfer with more than one destination. In the Activity Overview page, clicking
on a multiple-session transfer reveals all sessions in the transfer. To drill down to the particulars of each session, click
the Session Detail button to open its Session Detail page.

Optimizing Node Reporting

By default, managed nodes report the filenames of the first 1,000,000 files of a transfer to Console. However,
reporting this many filenames, especially if multiple managed nodes are reporting transfer sessions of several
thousands of files, can slow transfers.

You can decrease the number of filenames that are reported by each endpoint by configuring all managed nodes. This
configuration affects all transfer reporting, including transfers initiated by Aspera Hotfolders and Aspera Sync. The
total number of files transferred, completed, failed, and skipped are still reported, but filenames are logged only for
the files up to the specified number.

Perform the following steps on every managed node:

1. Decrease the number of files that are reported.
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> asconfigurator -x "set central server data;files per session,1000"

With this setting, only the first 1000 filenames are reported to Console and logged.
2. Restart Aspera Central and Aspera NodeD to activate your changes.

You can restart the Aspera Central from the Computer Management window. Go to Control Panel >

Administrative Tools > Computer Management > Services and Applications > Services, click Aspera

Central, and click Restart.

Go to Control Panel > Administrative Tools > Computer Management > Services and Applications >

Services, click Aspera NodeD, and click Restart.

Monitoring Nodes

You can monitor the node status and manage the transfers on a node. Navigating to Nodes from the Console menu
will bring you to the list of managed nodes. To view a list of unmanaged nodes, click the List Unmanaged Nodes

button. To monitor a node, click on the node.

Monitor Transfers on a Node

On the Node Detail page, the transfer chart shows all inbound and outbound transfers on this node. To control a
transfer session, select a session from the graph, and use the control options above the graph to control it.

INBOU... OUTEBOUMND

Mode 2 inbound total: .73 Mo/

0 Mby

E.0 Mby's

i

0 Mby's

0.0 Mby's

The table lists all sessions on this node. Use Pause and Cancel to control an ongoing session.

Transfers

Inbound Queus Outbound Queus
= Current
NAME DETAILS START END STATUS RATE
Long Transfer admin {console), Node 1 fo Node 2 3:38pm  3:48pm (ETA} 975 MB 4.8 Mbps

ACTIONS

Configuring the Map

You can configure Console to display the locations of your nodes on the dashboard map.

1. Go to Configuration > Map.
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2. Select or upload a map image for use on the Console dashboard.
* Upload a new map image: Click Upload Map File. Upload the file and then click select. For best results,
Aspera strongly recommends using an image with a ratio of 16:9 (for example, 800 x 450).
» Select existing map image: Choose one of two default map images or any previously uploaded image as the
dashboard map by clicking the select link.
Note: To delete a map image you have uploaded, click the delete link.
3. Configure node to show on map.
Edit your node and click the Map tab. Select Show on Map. Click and drag the green icon to its proper location
on the map.

The configured nodes appear on the map on the Dashboard. Ongoing transfers between nodes are represented by a
line between the nodes.

= Map

Access Logs

Once you have created accounts for Console users, you can monitor their activity from the Accounts > Access Log
tabs. The User Access Log displays user logins and logouts, concurrent logins and session timeouts.
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Users  Groups  Directories

» User Access Log

ACTION
Login
Login
Login
Logout
Login

Login

Access Log

DESCRIPTION

User (2, admin 1) from 10.0.200.82
User (2, admin 1) from 10.0.200.82
User (2, admin 1) from 10.0. 200.82
User (2, admin 1) from 10.0.200.82
User (3, user 1) from 10.0.200.82

User (2, admin 1) from 10.0.200.82

AT

F22pm

1:53pm

1:47pm

1:47pm

1:23pm

12:54pm

Search for a Transfer

Search

You can search for a transfer from any page in IBM Aspera Console by using the search bar in the top right corner of
the page. If you want to refine your search, you can access the Advanced Search dialog by selecting the blue drop-

down arrow next to the search bar.

Console will search all transfers within the last 24 hours for transfers that match the search criteria.

For more information about the advanced search form, see Advanced Search on page 125.

Monitoring Sync Jobs

Enabling Sync Client Node Reporting

The instructions below describe how to configure the IBM Aspera Sync client reporting to Console when the client is

a managed node.

Note: If both client and server involved in a Sync job are Console managed nodes, then reporting can come from
either node, both nodes, or neither node using the async_activity logging setting in aspera.conf. For
example, to receive reporting from both the client and server, set async_activity loggingto true on both.
The server is reported as the local host. For more information on server reporting, see Enabling Async Server Node

Reporting on page 53.

Transfer Reporting

The Sync client reports transfers associated with Sync jobs if <async _management activity logging>is
setto true in aspera.conf, which is the default configuration. The transfer name is listed as the Sync session

name. In the example below, the Sync session "ny-push-london" is reported under Transfers.
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& aspera console

Activity Nodes Ac ra [ 2| MNotifications Confi

Activity Overview

Transfers  Sync Jobs

History: | Past hour ¥ Scheduled: | None v Status: | Al v Search: | Transfer Name ¥ advanced

= Current

NAME DETAILS START END STATUS RATE ACTIONS
ny-push-london aspera (ssh), San Francisco to 10.0...  1:45pm 408.8 MB 9.5 Mbps pause cance

This setting can be modified by running the following command:

> asconfigurator -x
"set client data;async _management activity logging, value"

Setting the value to false disables reporting transfers associated with Sync jobs to Console. You do not need to
restart the Aspera Node API service for the new setting to be activated.

If you are syncing empty directories then no transfers are reported; the creation of the empty directories at the
destination is not reported as a transfer.

Sync Job Reporting

The Sync client reports Sync jobs to Console if <async_kvstore activity logging>issetto true in
aspera.conf. The default value is false, such that no Sync jobs are reported. To modify this setting, run the
following command:

> asconfigurator -x "set client data;async_ kvstore activity logging, value"

Sync jobs are listed under Activity > Sync Jobs.

& aspera console

Dashboard Activity Nodes Accounts Transfer Reports Notifications Configuration

Activity Overview

Transfers Sync Jobs

= Sync Jobs
NAME LOCALNODE LOCALPATH DIRECTION REMOTE NODE REMOTE PATH STATUS TRANSFERRED S/P ACTIONS
ny-push-london  San Francisco  fvarfaspera/Project X push 10.0.111.200 [Project X running 2426 MB 3679 /4858
sf-push-ny New York fsync/Project X push 10.0.163.22 [Project X stopped 1GB 8537/0 remaove log data

You can click on a Sync job to view more details about the session, including the endpoints, the status of individual
file transfers, and the transfer rate. For more information, see Monitor Sync Jobs on page 53.
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Enabling Async Server Node Reporting

By default, Console does not report transfers with a server that are associated with IBM Aspera Sync jobs or the Sync
job information. If the server is a Console managed node and is runnning IBM Aspera Enterprise Server or IBM
Aspera Connect Server version 3.1.5 or later, then it can be configured to report transfers and Sync jobs.

1. Enable server activity logging for Sync jobs.

Run the following asconfigurator command to enable activity logging for Sync jobs:
> asconfigurator -x "set node data;async_activity logging, true"

This command adds the following text to the <default> section of the aspera. conf file, located at: C:
\Program Files\Aspera\Enterprise Server\etc\aspera.conf.

<CONF version="2">
%aéfault>
;ééync_activity_logging>true</async_activity_logging>
<}aéfault>
</ C‘ZONF>
2. Restart the Aspera Node API service to activate your changes.
Go to Control Panel > Administrative Tools > Services, right-click Aspera NodeD and select Restart.

3. Confirm Sync jobs and transfers associated with them are reported in Console.

After initiating a sync session, go to Console and go to Activity > Sync Jobs page to monitor the job.

Note: Sync job reporting (from the Sync Jobs screen) may not appear immediately.

Monitor Sync Jobs

To monitor Aspera Sync jobs, you must first configure Console to poll the Node API. For more information, see
Enabling Async Server Node Reporting on page 53 to configure server reporting, and Enabling Sync Client Node
Reporting on page 51 to configure client reporting.

Once you have initiated a Sync transfer, you can monitor it by going to Activity > Sync Jobs. This shows a list of
active and recently completed Sync jobs. You can also remove log data from the Sync Jobs page by clicking remove
log data.

Note: Sync jobs may not appear immediately.

From the Sync Jobs table, you can view a job's transfer details by clicking the corresponding row. The job's transfer
details page displays the following:

* Local and remote server details

» Session statistics including the number of paths that are synced, pending, conflicted, deleted, or in error state
» Transfer rate graph, which is only active during the transfer

* Remove log data button, which deletes the job's log data from the Console and Aspera Sync databases.

The example below shows a running Sync job.
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& aspera console

Dashboard Activity

Sync Job Detail: ny-push-london

ny_pUSh_IO ndon Current Status Il Transfer Rate (Mbps) for ny-push-london
Status: running Synchronized Paths: 4063
Direction push Pending Paths: 4474 1oo V'
Start Time: Mar 29 2017 01:45 PM Conflict Paths: 0 r
Checksum: shal-sparse Error Paths: 0 75
Local Node San Francisco
Local User: root Last Session <o
Local Host: debfd-22 Deleted Paths: 0
Local Address: 10.0.163.22 Deleted Bytes: 0 Bytes
Lecal Path: fvarlaspera/Project X Deduped é}-tes_ 0 Bytes 25
Remote User: aspera Transferred Bytes: 291.2 MB
Remote Host: 10.0.111.200 0.0
Remote Address: 10.0.111.200 Cumulative Stats
Remote Path: /Praoject X Deleted Bytes- 0 Bytes
Dedupe Mode Off Deduped Bytes: 0 Bytes
Transferred Bytes: 2912 MB

Search Files: AR Scarch |

File Status

PATH STATUS SIZE LA ST MODIFIED

12007 September 05/Picture low 29.jpg pending 586 KB March 29 2017, 01:57:04 PM
12007 September 05/Picture high 28.jpg pending 2344 KB March 29 2017, 01:57:04 PM
/2007 September 05/Picture normal 10.jpg pending 96 KB March 29 2017, 01:57:03 PM
12007 September 05/Picture low 10.jpg pending FBGKE March 29 2017, 01:57:01 PM
12007 September 05/Picture normal 22.jpg pending 96 KB March 29 2017, 01:57:05 PM
12007 September 05/Picture high 14.jpg pending 2344 KB March 29 2017, 01:57:02 PM
FINAT ©antrmbhar AR Dirhira L 47 inm memdinn FozwvD March 90 3047 M4-88-E7 DA

Transferring Files

Console Transfer Special Conditions

Console transfers have restrictions for some endpoint combinations. For more information about endpoints, see
Understanding Endpoints on page 32.

Incompatible Endpoint Combinations

Console does not support transfers with the following endpoint combinations:

» Transferring between SSH and Shares endpoints
» Transferring between two Shares endpoints

Restricted Endpoint Combinations

In order to make transfers with the following endpoint combinations, you must follow the requirements below:
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Endpoint Combination Initiating Endpoint

SSH and Node API endpoints The Node API endpoint must be the initiator and a
managed node

SSH and Access Key endpoints The SSH endpoint must be the initiator and a managed
node

Shares and Node API endpoints The Node API endpoint must be the initiator and a

managed node

Share and Access Key endpoints The Access Key endpoint must be the initiator and a
managed node

Starting a Simple Transfer

IBM Aspera Console can be used to initiate transfers between nodes when the Console user has the permission to start
transfers. Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are
one-time transfer sessions that require entering all transfer information. Smart transfers are reusable templates with
saved transfer settings.

1. Go to Transfer.
2. Click Simple Transfer.

Start a Simple Transfer

Beqgin a high-speed transfer now. Specify transfer rates,
encryption, and email notifications.

Simple Transfer

3. Enter the transfer name and optional comments. The name and comments can be helpful if you want to search for
this transfer later.

4. Optional: Add new tags or modify existing tags.
Click the button to add a new tag. Enter the tag name and the tag value. Click the E] button to delete an

existing tag. Select the é‘ button to prevent a user from changing or deleting the locked tag when starting this
transfer. For more information about tags, see Working with Tags on page 115.

Tag Name Tag Value &
Company Aspera (]

5. Inthe Source section, click the Connect drop-down menu and select the source node, cluster, or saved endpoint.

* Node: A node is listed as the node name (by default, its IP address) and IP address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

* Cluster: A cluster is listed as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

» Endpoint: A saved endpoint is listed as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.

» Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.



| Transferring Files | 56

6. Select content to transfer by clicking Browse, selecting the content, and clicking Add.

Note: When browsing the node, you can narrow your search by applying a filter. When specifying a filter, the
asterisk (*) is not a wildcard. Any string you enter as a filter is treated as a "search within". In other words, the
string "foo" matches "123fo0", "foo456", and "123fo0456".

By default, the parent folders of the selected files and folders are not transferred. If a source item is a file, then
only the file is transferred. If a source item is a folder, then the folder and its entire contents are transferred.
For example, if the source path is aspera/tmp/sent files, the only folder that will be transferred to the
destination is the sent files folder. Neither /aspera nor /tmp appear at the destination location.

To transfer only the contents of a selected folder, select Specify base for source path(s) and enter the filepath to
the folder. For example, if the source folder is aspera/tmp/sent files and you specify that same path as
the base for source paths, the contents of /sent files is transferred to the destination directory as separate
items that are not contained ina /sent files folder.

7. In the Destination section, click the Connect drop-down menu and select the source node, cluster, or saved
endpoint.

* Node: A node is listed as the node name (by default, its IP address) and IP address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

* Cluster: A cluster is listed as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

* Endpoint: A saved endpoint is listed as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.
* Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.

8. ClickBrowse, sclect the destination directory, and click Add.
9. Optional: Configure settings in the More Options section.

Click the toggle arrow next to each section to view settings.

Section Description

Connection Configure fasp settings.

Transfer Configure transfer rates and policies.

Security Encrypt the transfer.

File Handling Configure source file attributes, archive source files

after transfer, and set filters for source files.

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 15.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

Transfer Time Schedule your transfer to run Now or Later. If you

choose Later, click the E£ button and choose the date
and time you want the transfer to run.
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Section

Description

< Movember ¥ | 2015 ¥ >

8 9 13 14
15 20 21

22 27 28
29

@REGIIRA KA vow ok

For information on these options, see Simple Transfer Options on page 158.
10. Click Transfer to start the transfer (or Schedule if you set a transfer time).

Note: You can cancel scheduled simple transfers by going to Activity > Transfers. Click the Scheduled drop-
down menu and select All In the row for the transfer, click Cancel.

Transfers

= Future
NAME

Cancel Scheduled Transfer

DETAILS

. Scheduled: . .

SCHEDULED ACTIONS

admin (console), Node 1 to Node 1 4:39pm 30-Cct start

cancel

Creating a Smart Transfer

IBM Aspera Console can be used to initiate transfers between nodes when the Console user has the permission to start
transfers. Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are
one-time transfer sessions that require entering all transfer information. Smart transfers are reusable templates with

saved transfer settings.

1. To create a smart transfer template, go to Transfer > New Smart Transfer.

Create a New Smart Transfer

multiple destinations.

Create a reusable transfer template with the ability to add

MNew Smart Transfer

2. Enter a transfer name.
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3. Optional: Select Share this smart transfer to share this smart transfer with any user who has permissions for the
transfer paths.

For more information on sharing smart transfers, see Sharing a Smart Transfer on page 62.

4. Optional: Select Allow changes to transfer settings at submit time to allow the user who starts this smart
transfer to change settings before submitting the transfer request.

5. Optional: Add new tags or modify existing tags.
Click the button to add a new tag. Enter the tag name and the tag value. Click the E] button to delete an

existing tag. Select the & button to prevent a user from changing or deleting the locked tag when starting this
transfer. For more information about tags, see Working with Tags on page 115.

Tag Name Tag Value &
Company Aspera E3

The highlighted box in the Smart Transfer Diagram indicates whether you are configuring the Source or Destination
for the smart transfer. Make sure Source is selected.

» Smart Transfer Diagram

adds a new destination node

[(¢] removes a destination node

Source Destination

6. Select the source node or saved endpoint from the Connect drop-down menu.

* Node: A node is listed as the node name (by default, its IP address) and IP address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

* Cluster: A cluster is listed as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

* Endpoint: A saved endpoint is listed as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.

* Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.

7. Choose your Source directory.

Click Choose Source Directory to browse the node for the directories and files you want to transfer. Console
displays the source path you choose once you have chosen your source directory.

Note: When browsing the node, you can narrow your search by applying a filter. When specifying a filter, the
asterisk (*) is not a wildcard. Any string you enter as a filter is treated as a "search within". In other words, the
string "foo" matches "123fo0", "foo456", and "123fo0456".

8. Select Specify base for source path(s) to place the transferred files directly into the destination folder without its
hierarchy of directories. The specified base for the source path is removed from the source path when transferring
directories.

For example, if the source path is /shared files/projects/presentation, asuccessful transfer
results in the folder destination folder/shared files/projects/presentation onthe
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destination node. A successful transfer with "/shared_files/projects" specified as the base path results in the folder
destination folder/presentation on the destination node.

For more information on specifying a base path, see Specify Base for Source Path on page 165.
9. Select one of the following file-transfer rules from the Items to transfer drop-down list:

» Always transfer the entire directory: The transfer always transfers all files in the source directory.

* Allow initiator to select items when starting manually: The user starting this smart transfer can choose the
items in the directory included in the transfer.

10. Expand the settings under More Options to configure addition settings.
Click the toggle arrow next to each section to view settings.

Section Description

Connection Conlfigure fasp settings.

Transfer Configure transfer rates and policies.

Security Encrypt the transfer.

File Handling Configure source file attributes, archive source files

after transfer, and set filters for source files.

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 15.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

Transfer Time Schedule your transfer to run Now or Later. If you

choose Later, click the " button and choose the date
and time you want the transfer to run.

< Movember ¥ | 2015 ¥ >

8 9 12
15 17 18 19

22 24 25 26
29

CRETIIRA A niow 0k

For more information on these options, see Smart Transfer Options on page 161.

The highlighted box in the Smart Transfer Diagram indicates whether you are configuring the Source or Destination
for the smart transfer. Make sure a Destination is selected. You can create additional destination endpoints by clicking

the button. To remove a destination, click the E] button inside the destination box.
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= Smart Transfer Diagram

adds a new destination node

[E] removes a destination node

Source Destination

Destination

11. Select the destination node or saved endpoint from the Connect drop-down menu.

* Node: A node is listed as the node name (by default, its IP address) and IP address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

* Cluster: A cluster is listed as the domain name. Select the Endpoint type from the drop-down menu and enter

your credentials.

* Endpoint: A saved endpoint is listed as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.
* Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.

12. Select your Destination directory.

Click Choose Destination Directory to browse the node for the directories and files you want to transfer. Console
displays the source path you choose once you have chosen your source directory.

Note: When browsing the node, you can narrow your search by applying a filter. When specifying a filter, the
asterisk (*) is not a wildcard. Any string you enter as a filter is treated as a "search within". In other words, the
string "foo" matches "123foo", "foo456", and "123fo0456".

13. Optional: Allow the user starting this smart transfer to change the directory on this destination node. The Change
Destination Path button appears for a destination with this option enabled.

14. Optional: Allow the user starting this smart transfer to remove this destination node. The E] button appears for a

destination with this option enabled.

15. Optional: Configure additional settings for this individual destination node.

Note: This option is only available for a smart transfer with multiple destination nodes.

Select Set transfer options individually for this destination. The More Options appears at the bottom of the

page.
Section Description
Connection Configure fasp settings.
Transfer Configure transfer rates and policies.
Security Encrypt the transfer.
File Handling Configure source file attributes, archive source files
after transfer, and set filters for source files.
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Section Description

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 15.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

For information on these options, see Smart Transfer Options on page 161.

16. Click Save.

Once a smart transfer template has been saved, it is accessible from the Transfer page. Go to Transfer to start, edit,
copy, and delete existing smart transfers.

Starting a Smart Transfer

IBM Aspera Console can be used to initiate transfers between nodes when the Console user has the permission to start
transfers. Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are

one-time transfer sessions that require entering all transfer information. Smart transfers are reusable templates with
saved transfer settings.

1.

Go to Transfer to see all the smart transfers you have permission to access. For instructions on creating a smart
transfer, see Creating a Smart Transfer on page 57.

Find the smart transfer listed under Saved Smart Transfers and click Start.

Optional: Modify the Transfer Name and leave a comment describing the transfer.

Optional: Add new tags or modify existing tags.
Tags
Tag Mame Tag Value
Company Aspera
Division Development E]

Click the button to add a new tag. Enter the tag name and the tag value. Click the [E] button to delete an

existing tag. Locked tags are greyed out and cannot be modified. For more information, see Working with Tags on
page 115.

Optional: Configure email notification options.

Expand the Notifications section. Add or delete email addresses and configure notifications for existing email
addresses. For more information, see Configuring Email Notifications on page 15.

Optional: Schedule the transfer to run Now or Later.

If you choose Later, click the = button and choose the date and time you want the transfer to run.
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< Movember ¥ | 2015 ¥ >

7. Click Start.

Sharing a Smart Transfer

Smart transfers are reusable templates with saved settings. The primary use case for sharing smart transfers is to set
up pre-defined transfers for non-admin users to run. You can decide what transfers a user can monitor and start by
limiting the user's permissions and access to a smart transfer. By default, shared transfers require you to use endpoints
created by an admin using the Edit Nodes > Endpoints page. Once configured in Console settings, you can also
share smart transfers saved with personal login credentials and domain names.

For more information about sharing smart transfers with personal logins, see Sharing a Smart Transfer with Personal
Login Credentials on page 63

Note: These instructions assume you know how to configure a smart transfer. For more information, see Creating a
Smart Transfer on page 57.
1. Create endpoints on the nodes you want to use for this smart transfer.
For detailed instructions, see Adding Endpoints on page 33.
Tip: To use domain names as transfer endpoints, create an unmanaged node using a domain name, then add an
Endpoint to this unmanaged node.
2. Go to Transfer and click New Smart Transfer.

3. Select Share this smart transfer.

Description
Transfer name
#|  Share this smart transfer

Allow changes to transfer settings at submit time
Tags

Note: When creating a smart transfer with Any as an endpoint, you must first save the smart transfer before
selecting Share this smart transfer.

4. Select endpoints for the Source and Destination.

Tip: Create new personal saved endpoints by selecting the desired node and entering the SSH user login
credentials.
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5. Finish configuring the smart transfer. Click Save when finished.
6. Enable a user to start this smart transfer.

* Create a group with permissions to start smart transfers for this transfer path (see Creating Console Groups on
page 41).
* Add the user to this group (see Creating Console Users on page 42).

Admin users have permissions to all transfers and do not need to be added to a group to use a shared smart transfer.
By default, admins do not have the ability to edit Smart Transfers that are shared with them but owned by another
admin. To enable admins to edit each other's smart transfers, go to Configuration > Defaults and select Smart
Transfer Editing: Allow administrators to edit each other's Smart Transfers.

Note: Even with this feature enabled, admins can only edit smart transfers that do not contain personally saved login
credentials.

Tip: Editing another admin's smart transfer changes ownership of the smart transfer to the admin who made the last
change.

Sharing a Smart Transfer with Personal Login Credentials

Smart transfers are reusable templates with saved settings. The primary use case for sharing smart transfers is to set
up pre-defined transfers for non-admin users to run. You can decide what transfers a user can monitor and start by
limiting the user's permissions and access to a smart transfer. By default, shared transfers require you to use endpoints
created by an admin using the Edit Nodes > Endpoints page. Once configured in Console settings, you can also
share smart transfers saved with personal login credentials and domain names.

Personal login credentials are automatically created and saved when a user creates a transfer, chooses a node, and
enters authentication credentials for an SSH user on that node. The following describes how to share a smart transfer
with personal login credentials.

Note: These instructions assume you know how to configure a smart transfer. For more information, see Creating a
Smart Transfer on page 57.

1. Go to Configuration > Defaults and select Smart Transfer Sharing.

2. Create a new smart transfer, select Share this smart transfer.

Description
Transfer name
#|  Share this smart transfer

Allow changes to transfer settings at submit time
Tags

Note: When creating a smart transfer with Any as an endpoint, you must first save the smart transfer before
selecting Share this smart transfer.

3. Select personal saved endpoints for the Source and Destination.

If you have no personal saved endpoints, create a new one by selecting the desired node and entering the SSH user
login credentials.

4. Finish configuring the smart transfer. Click Save when finished.

5. Enable a user to start this smart transfer.
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* Create a group with permissions to start smart transfers for this transfer path (see Creating Console Groups on
page 41).
* Add the user to this group (see Creating Console Users on page 42).
Admin users have permissions to all transfers and do not need to be added to a group to use a shared smart transfer.
By default, admins do not have the ability to edit Smart Transfers that are shared with them but owned by another

admin. To enable admins to edit each other's smart transfers, go to Configuration > Defaults and select Smart
Transfer Editing: Allow administrators to edit each other's Smart Transfers.

Note: Even with this feature enabled, admins can only edit smart transfers that do not contain personally saved login
credentials.

Tip: Editing another admin's smart transfer changes ownership of the smart transfer to the admin who made the last
change.

Queue Transfers

Overview
The Console queueing feature provides two useful capabilities:

*  Admins can limit the number of Console-initiated transfers that can run concurrently for a given destination or
from a given source. This can be useful if network connections have limited bandwidth or if particular destination
nodes have difficulty handling more than a small number of transfers at a time. For example, if the concurrency
limit for a connection is "2", and two transfers are in progress, any new transfers initiated while the first two are
still in progress will be queued in the order in which they were initiated.

» All users can change the priority order of queued and in-progress transfers. This can be useful in situations where
users need to respond to emergencies or shifting priorities.

Important: Queueing only applies to transfers started from Console or via its API. Transfers started outside Console
are not subject to queueing and do not count towards concurrency limits.

Concurrency limits are always assigned on a per-node basis, and per outbound or inbound direction. However, the
overall, actual limit on a set of concurrent transfers between two nodes is governed by the node with the lowest limit.
That is, if NodeA has an outbound limit of "2" and NodeB has an inbound limit of "1", concurrent transfers from
NodeA to NodeB are limited to one transfer at a time, with subsequent transfers queued up in the order in which they
were initiated.

Adjusting the Queueing Properties of In-Progress Transfers

If queuing is enabled on a node (see Configuring Queues for Nodes on page 66), the queueing properties of in-
progress transfers can be adjusted in several ways:

» Their relative priorities can be raised or lowered.

* They can be paused and resumed.

» The concurrency limit in effect can be raised or lowered.

* Concurrency (and therefore queueing) can be disabled completely.

These adjustments can be made while monitoring the node from the Node Detail page. You can view the Node Detail
page by going to Nodes and clicking on the node.

Tip: You can also reach this page from the Queing page on the current queue contents link next to an enabled

Limit concurrency: Ld

Max. concurrent transfers: 3 current queue contents

concurrency limit.
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On the Node Detail page, below the transfer chart, you may see the Inbound Queue tab, the Outbound Queue tab,
or both. These tabs are visible if the node is configured with inbound or outbound queueing. Clicking the tab displays
the node’s inbound or outbound transfers - both those currently in progress and those in the queue.

® Transfer Chart

o
(=)
[

Transfers Inbound Queuws Outbound Queus

To view past transfers, open the Transfers tab. The Transfers tab also shows both outbound and inbound transfers,
but does not include controls to promote, demote, pause, or resume transfers.

Controlling In-Progress Transfers

STATUS RATE ACTIONS
414.5 MB - &8mbps | v Y| OX
Queued here 1) A A X
Icon Action
11 Pause Transfer
- Resume Transfer
A Promote Transfer to Highest Priority
A Promote Transfer
v Demote Transfer
Y Demote Transfer to Lowest Priority
X Cancel Transfer
s Highlight this session on the graph
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Configuring Queues for Nodes

Both managed and unmanaged nodes can be configured for queuing. For more information on queuing, see Queue
Transfers on page 64.

1. Go to Nodes. Find your node in the Managed Nodes or Unmanaged Nodes page . Click edit and then click
Queueing.

Enable queueing by selecting Limit concurrency (disabled by default) for Inbound Transfers.

Choose the maximum number of concurrent transfers allowed for this node. The default setting is "1".
Repeat the previous two steps for Outbound Transfers.

Click Update.

Nk w

In the example below, queueing is disabled for inbound transfers. For outbound transfers, queueing is enabled for at
most three transfers in progress at the same time.

Inbound Transfers

Limit concurrency:

Max. concurrent transfers: 1

Outbound Transfers

Limit concurrency: v

[¥¢]

Max. concurrent transfers: 3 current queue content

Configure Failover Groups

Overview

A failover group contains a group of different nodes that act as substitutes for the original node in the case that the
original node becomes unavailable. When a node goes offline, Console also restarts any transfers in progress on that
node, submitting them to a different node in the group.

Note: Transfer failover only activates if the status of a node is set to error. Transfers that are inactive do not failover.

Node Requirements
Nodes must have identical passwords, transfer accounts, and docroots to be grouped together. Make sure each node
has identical configurations for each item in the following list before adding them to a failover group:

* System User Accounts

» Transfer User Accounts

* Node API User Accounts
* Docroots

* Endpoints on Console

* Directory Structure
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Adding a Node to a Failover Group

When adding or editing a node, select Enable failover and load balancing for Console-initiated transfers on this
node. Add the node to an existing group or select enter new name from the Failover Group Name drop-down menu
to create a new group.

Failowver

# Enable failover and load balancing for Conscle-initiated transfers on this node
Failower Group Mame | FAILOVER GROUP 1 ¥ |

inone )

FAILOWVER GROUP 1

If you select enter new name,enter a new failover group name in the prompt.

Endpoint Synchronization
Editing an endpoint on a node of a failover group makes those changes to the same endpoint on the other nodes in the
failover group.

Note: Only saved and synchronized endpoints should be selected as a destination when starting a transfer.

Configuring Load Balancing
Go to Configuration > Console Defaults and configure the Failover / Load balancing Behavior option.

* Failover + Load Balancing: The transfer uses the least busy nodes first.
» Failover only: The transfer will uses the original endpoints that the user specified.

Creating a Cookie Parsing Rule

Note: Cookie configuration applies only to the use of custom cookies. Console does not apply parsing rules to
cookies it recognizes as standard cookies used by Aspera products.

In an ascp command-line transfer, you can specify the transfer cookie with an environment variable.
set ASPERA SCP COOKIE=custom cookie

Using a rule, Console can match the set cookie string and then substitute it for selected transfer information.

1. Go to Configuration > Cookies. Click New Rule.

2. Name the rule.

3. Configure the cookie.
Enter the regular expression Console uses to filter transfers. If this string matches a transfer, Console includes the
cookie in the transfer and the information in the other fields is used in the transfer session.
Tip: The regular expression follows Ruby regular expression format currently documented on the Ruby web site:
https://ruby-doc.org/core-2.5.3/Regexp.html.

4. Configure the cookie with the following information:

Field Description

Started via Name of the transfer initiator.
Contact description Description of this transfer initiator.
Transfer name Name for this transfer.

5. Click Create.


https://ruby-doc.org/core-2.5.3/Regexp.html
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When you have multiple cookie parsing rules, Console uses the first rule listed that matches the cookie string.
To modify the order of the parsing rules, drag-and-drop the rules in the list. If two rules have identical regular
expressions, the rule that is higher in the list is applied.

It is possible to capture parts of the cookie and reuse the value in the three parameters. For instance to enable
setting the three transfer fields directly from the initiating application, one can fill in the fields with the following

configurations:
Field Description
Rule name MyCustomCookieRule
Regexp Asetcustomfields:(+?2):(.+?):(.+2):8
Started via \1
Contact description \2
Transfer name \3

For example, the following cookie replaces Started via with "My App", Contact description with "My Contact",
and Transfer name with "My Transfer".

set ASPERA SCP COOKIE="setcustomfields:My App:My Contact:My Transfer:"

Working with Watchfolders

Configuring a Watchfolder-enabled Transfer Node

Watchfolders uses the Aspera Watchfolder service (asperawatchfolderd) and the output from the Aspera Watch
Service (asperawatchd) to automatically transfer new files added to a source folder on an Aspera node. Follow
the instructions below to start the two services.

Note: You must perform the following instructions on the transfer node.
1. Select a user account to run your services.

Watchfolder services must be run under a user with access to every area of your file system in which you intend
to create a watch folder. Watchfolders allows you to run multiple instances of these services under different users.
Most users run these services under one user. Choose a user that has access to your entire file system.

If you need to run multiple instances of these services to access every area of your file system, see Choosing User
Accounts to Run Watchfolder Services on page 71.
2. Configure a docroot for the chosen user.

The docroot is a security feature that allows you to restrict the area of the file system that a user, and services run
by that user such as the Aspera Watch Service, can access. If a user needs access to the entire file system, set the
docroot path as C: \, but you cannot leave it empty.

Set the user's docroot by running the following command:
> asconfigurator -x "set user data;user name, username;absolute, docroot"
For example:

> asconfigurator -x "set user dataj;user name,root;absolute,/"
success
user name: root
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3. Configure the asperawatchd and asperawatchfolderd services to run under your user.

The following commands add the services in the asperarund database; asperarund automatically starts and
preserves services in its database. The asperarund service must be running.

Windows Node:

> asperawatchd --user username
> asperawatchfolderd --user username

Windows requires a password when running services as other users. Enter the password when prompted.

OS X Node:

$ /Library/Aspera/sbin/asperawatchd --user username
$ /Library/Aspera/sbin/asperawatchfolderd --user username

Linux Node:

# /opt/aspera/sbin/asperawatchd --user username
# /opt/aspera/sbin/asperawatchfolderd --user username

4. Verify that asperawatchd and asperawatchfolderd is running under the given user.

Use the aswatchadmin and aswatchfolderadmin admin tools to retrieve a list of running daemons.
Daemons are named with the username you passed in when starting the service. For example, if you used the root
user to run your services, you should see the root daemon listed in the output.

Windows Node:

> aswatchadmin query-daemons
[aswatchadmin query-daemons] Found a single daemon:
svcaspera

> aswatchfolderadmin query-daemons
[aswatchfolderadmin query-daemons] Found a single daemon:
svcaspera

Windows requires a password when running services as other users. Enter the password when prompted.

Linux Node:

$ /opt/aspera/bin/aswatchadmin query-daemons
[aswatchadmin query-daemons] Found a single daemon:
root

$ /opt/aspera/bin/aswatchfolderadmin query-daemons
[aswatchfolderadmin query-daemons] Found a single daemon:
root

5. Create a Node API User and map it to a system account. The user account must have administrative privileges to
interact with Aspera WatchfolderD.

Using the REST API provided by the asperanoded service, a user can create, remove, query and modify
watchfolder instances. The asperanoded service forwards requests to the corresponding watch folder instances
over Redis.

Windows Node:

> asnodeadmin -a -u node username -p node password -x admin user --acl-set
"admin, impersonation"
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Linux Node:

# /opt/aspera/bin/asnodeadmin -a -u node username -p node password -
X admin user --acl-set "admin,impersonation"

For example:

Windows Node:

> asnodeadmin -a -u watchfolder user -p X2451skd3 -x root --acl-set
"admin, impersonation"

Linux Node:

# /opt/aspera/bin/asnodeadmin -a -u watchfolder user -p X2451skd3 -x root
—--acl-set "admin,impersonation”

Adding, modifying, or deleting a node-user triggers automatic reloading of the user database and the node's
configuration and license files. For more information on the Node API, see your transfer server's administrator
guide.

6. Verify that you correctly added the node user.

> /opt/aspera/bin/asnodeadmin -1
List of node user(s):
user system/transfer user acls

node api user system user [1]
Given the example in the previous step, the output should look like the following:

> /opt/aspera/bin/asnodeadmin -1
user system/transfer user acls

watchfolder user svcAspera [admin, impersonation]

7. Add the transfer node to Console as a managed node.

This transfer node is now ready to be added to Console as a managed node. For instructions on adding nodes to
Console, see Creating a Managed Node in Console on page 30.

Once you have successfully added the transfer node to Console as a managed node, you can use the node to create
watch folders. For instructions on creating a watch folder, see Creating a Watch Folder in Console on page 70.

Creating a Watch Folder in Console

A watch folder is an automation of file transfers from a source node to a destination computer; files placed into a
source folder are automatically transferred to the destination. Watch folders runs only on the client side, and the
receiving Aspera client does not need additional software components to support receiving data.

To use watch folders, you must enable the feature on the Console Defaults page, configure the node, and add it

as a managed node to Console. In Console, go to Configuration > Defaults and select Enable Watchfolder
management. On the node, start watchfolder services if they are not already running and configure the Node API
so that Console can add the transfer node as a managed node. For more information on preparing the node, see
Configuring a Watchfolder-enabled Transfer Node on page 68.

Once watch folders are enabled and your nodes are configured, create watch folders with the following steps:

1. Go to Activity > Watchfolders and click Create New Watchfolder.

2. Enter a name for your watch folder in the Name field.
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3. In the Local section, select the source node and path.

Click the Local Node drop-down menu and select a managed node. Only nodes configured to run watch folders
appear on the drop-down list. If you do not see any nodes, make sure your nodes are properly configured in
Console.

4. Click Browse and select the source directory, or enter the source path.
Tip: The source folder is relative to associated system user's docroot. For example, if you enter projectl/

final and the user's docroot is / root, the source path is /root/projectl/final. For instructions on
modifying the docroot, see Set a Docroot for a Node User or Group on page 35.

5. In the Remote section, enter the credentials to authenticate to the destination node and authorize transfers.

* Address: The hostname or IP address.
* Login: The username of the administrator account (for the SSH connection).

» Select Password or SSH Key and provide the credentials. To use public key authentication, you must have
your SSH private key configured in Console. For instructions, on how to configure SSH keys in Console, see
Configuring SSH Keys on page 90.

» Token: Optional. Enter a token string to use to authenticate the transfer, with the syntax "Basic foken_string".
To use token authorization, create an access key on the remote node and generate a token from it. For
instructions, see "Access Key Authentication" in the IBM Aspera Enterprise Server Admin Guide.

6. Set the TCP and UDP ports. By default, TCP uses port 22 and UDP uses port 33001.
7. Click Browse to test the connection and choose the target directory.
8. Configure additional watchfolder settings.

For more information on watch folder settings, see Watchfolder Options on page 80.
9. Click Create.
10. Test your watch folder.

Add files to the source directory. If the configuration is correct, Watchfolder detects the new files, starts a transfer,
and the added files appear in the target directory. You can see the transfer on the Activity Overview page.

Choosing User Accounts to Run Watchfolder Services

Watchfolder services must be run under a user with access to every area of your file system in which you intend to
create a watch folder. Watchfolders allows you to run multiple instances of these services under different users. Most
users run these services under one user. Choose a user that has access to your entire file system.

You may need to run multiple instances of these services to access every area of your file system. For example,
your file system may include mounted storage from the marketing department and another from the release

team. In such a scenario, you may not have a single user that can access files in both mounted storages, or your
administrative account has access to the entire file system, but your policy prohibits running the asperawatchd
and asperawatchfolderd services under that user account.

There are two ways to configure watch folders depending on your scenario. See the chart below for the configuration
that matches your scenario:


http://downloads.asperasoft.com/en/documentation/1
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Is there a user accaunt with
access to the entire file system?

Is there a problem running
these services from the
administrative account?

Mo

Configuration #1
Run one pair of asperawatchd and
asperwatchfolderd services under the
admin account. Use this user to create
as many watch folders as necessary,

Configuration #1

iz

Configuration #2
Run a pair of asperawatchd and asperawatchfol
services under each user with access to their par
area of the file system. Create watch folders usin
user with permissions for each file system.

This is the simplest and most common configuration of watchfolder services. Choose an account that has read
permissions for all your files and follow the instructions in Creating a Watch Folder in Console on page 70.

Configuration #2

If you cannot run watchfolder services under the administrative account or you do not have a single user that has
access to the entire file system, you must run pairs of asperawatchd and asperawatchfolderd services

under enough users to access your entire file system.

For example, if you have user mounted storage from the marketing department that can only be accessed by user
xaspl, and another storage from the release team, which can only be accessed by user xasp2, you need to run a pair

of asperawatchd and asperawatchfolderd services under each user. Aspera recommends using the Node
API to configure services and manage watch folders in a multi-user context. You can interact with the Node API using

IBM Aspera Console.
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Updating the Docroot of a Running asperawatchfolderd Service

If, when creating a watch folder, aswatchfolderadmin errors out with error code err=28672, check
that your docroot has been properly configured to provide access to the source directory specified in the JSON
configuration file. You may have specified a destination that is not permitted by the docroot of the user running
asperawatchfolderd, or you may have no docroot configured at all.

If you need to make changes to your docroot, follow the instructions below to update your docroot and restart the
asperawatchfolderd service.

1. Update the docroot for the user running asperawatchfolderd.

The docroot is a security feature that allows you to restrict the area of the file system that a user, and services run
by that user such as the Aspera Watch Service, can access. If a user needs access to the entire file system, set the
docroot path as C: \, but you cannot leave it empty.

Set the user's docroot by running the following command:
> asconfigurator -x "set user data;user name, username;absolute, docroot"
For example:

> asconfigurator -x "set user data;user name,root;absolute,/"
success
user name: root

The aspera.conf configuration file is in the following location:

/opt/aspera/etc/aspera.confC:\Program Files\Aspera\\etc\aspera.conf

2. Restart the asperawatchfolderd service to pick up the changes to the docroot.

Use the asrun utility to disable and enable the asperawatchfolderd service.

> /opt/aspera/bin/asrun send --disable="username"
> /opt/aspera/bin/asrun send --enable="username"

Working with Growing Files

Growing files are "in progress" files that continue to grow in size. For example, videos generated at live events
continue to grow in size and duration. Watchfolders can detect these growing files and start transferring them to a
target directory using Aspera faspstream technology.

Important: Both the source host and remote host must be running IBM Aspera Enterprise Server 3.6.0+ to support
the faspstream technology used to transfer growing files. Also, the remote host transfer user for the watchfolder must
not have a docroot.

To configure a watchfolder to work with growing files, first add the source host to Console as a managed node. Then,
follow the instructions below to a new watchfolder and configure the Growing Files options.

Important: The source host must be properly configured for watchfolders. For more information, see Configuring a
Watchfolder-enabled Transfer Node on page 68.

1. Go to Activity > Watchfolders and click Create New Watchfolder.

2. Name your watchfolder. For example, name your watchfolder "Camera Feed Transfers".

3. In the Local section, select the source node and path.

Click the Local Node drop-down menu and select a managed node. Only nodes configured to run watch folders
appear on the drop-down list. If you do not see any nodes, make sure your nodes are properly configured in
Console.



Local

Local Node: | watchiolder-de (173.192.206.85)

Coronse IS
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. In the Remote section, enter the credentials to authenticate to the destination node and authorize transfers.

* Address: The hostname or IP address.
* Login: The username of the administrator account (for the SSH connection).

+ Select Password or SSH Key and provide the credentials. To use public key authentication, you must have
your SSH private key configured in Console. For instructions, on how to configure SSH keys in Console, see

Configuring SSH Keys on page 90.

» Token: Optional. Enter a token string to use to authenticate the transfer, with the syntax "Basic token_string".
To use token authorization, create an access key on the remote node and generate a token from it. For
instructions, see "Access Key Authentication" in the IBM Aspera Enterprise Server Admin Guide.

. Set the TCP and UDP ports. By default, TCP uses port 22 and UDP uses port 33001.

. Click Browse to test the connection and choose the target directory.

Remote

Address: watehfolder-s). asperademo. com

Login: rocd

Remaote Authentication: [ =] Passward 55H Kay
Password: ——

TCP Port: 22

fasp™ Port (UDP): 33001

Path: /dataftargetigrawing

. Configure the Growing Files section to configure the session bandwidth policy and the growing files detection

policy.
Note: Sessions with growing files are not affected by settings in the Transfer section.

Expand the Growing Files section. Configure the following options.

Option Description Example
Target rate Specify the target transfer rate. 10000
Transport Select aes-128 to transfer with this encryption method. aes128
encryption

TCP port Enter the TCP port to use for this watch folder. 22

fasp™ port Enter the UDP port to use for this watch folder. 33001
(UDP)

Completion Specify the amount of time to wait for the file to no longer change for the |10
timeout session to finish.



http://downloads.asperasoft.com/en/documentation/1

| Working with Watchfolders | 75

Option Description Example
Growing file The growing file filter allows watchfolders to define which files are *m2p
filters considered growing files. Click the button to add a new filter to

identify the growing file. You can set a filter to include or exclude files by
globbing or by regular expression.

For more information on watchfolder settings, see Watchfolder Options on page 80.

* File Handling [show)

= Growing Files [(hide)

Maximurm parallel transfers g

Target rate 100000 Kbps

Bandwidth policy fair %

Transport encryption [aes128 %]

TCF port 22

fasp™ port (UDF) 33001

Completion timegut 10 saconds

Mermory 128 Mb

Chunk size 128 Kb

Growing filie fitters |Gl¢t| =I [h:h.n:la =J - m2o E
(&
Lisod Tor identifying growirg fes

» Packages ! Drops (show)

8. Click Create.

Activity Overview
Successfully created watchfolder

Transfers  Sync Jobs  Watch Folders
» Watch Folders

HAME LOCAL NODE LOCAL PATH REMOTE NODE REMOTE PATH STATUS TRANSFERRED  SKIF

Camora Food Transfors  walchloker-de famafwlipioming  watchiolGnr-a| A3porademo.com  /SMAapaligrowing  idio i] a

Working with Package Sending

A user can control the order of transfer for files added to a watchfolder by configuring the watchfolder to send with
packages. Watchfolder uses a file list to determine the files in a package and the order in which they are transferred.
The last file in a file list is designated to be transferred last. It will not be transferred until all other files included in
the file list have been transferred. Using watchfolders with file lists supports workflows that trigger when detecting
the presence of a particular file, but require the presence of a particular set of files to function correctly. For example,
a workflow that builds a project dependent on the existence of other files will fail if the trigger file is transferred
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before those other files have been transferred. Using a file list ensures the trigger file is not transferred until the rest of
the files have been transferred.

To configure a watchfolder to work with package sending, first add the source host to Console as a managed node.
Then, follow the instructions below to create a new watchfolder and configure the Package List options.

Important: The source host must be properly configured for watchfolders. For more information, see Configuring a
Watchfolder-enabled Transfer Node on page 68.

1. On the source host, create a file list of the files you want transferred and the file that needs to be transferred last.

The first line has to be "#aspera-filelist". Enter the names of the files you want transferred in the following lines.
The last file in the file list is not transferred until the rest of the preceding files are finished transferring. The last
file transferred is always the last file in the filelist. Here is an example file list:

#aspera-filelist

superhero epic the musical-english.mp4
superhero epic the musical-spanish.mp4
superhero epic the musical-chinese.mp4
superhero epic the musical.png

superhero epic_the musical-english-trailer.mp4
ADT.XML

Note: The paths listed in the file list should be entered as paths to files relative to the watchfolder directory. Paths
to directories are not supported.

2. Go to Activity > Watchfolders and click Create New Watchfolder.
3. Name your watchfolder. For example, name your watchfolder "A Package of Files".
4. In the Local section, select the source node and path.

Click the Local Node drop-down menu and select a managed node. Only nodes configured to run watch folders
appear on the drop-down list. If you do not see any nodes, make sure your nodes are properly configured in
Console.

= Create Watch Folder

L A Package of Files

Local

Local Mode: | watchfolder-de (173.192.206.89) :J
Path: Browsa [ELCEEGEG T

5. In the Remote section, enter the credentials to authenticate to the destination node and authorize transfers.

* Address: The hostname or IP address.

* Login: The username of the administrator account (for the SSH connection).

» Select Password or SSH Key and provide the credentials. To use public key authentication, you must have
your SSH private key configured in Console. For instructions, on how to configure SSH keys in Console, see
Configuring SSH Keys on page 90.

» Token: Optional. Enter a token string to use to authenticate the transfer, with the syntax "Basic token_string".
To use token authorization, create an access key on the remote node and generate a token from it. For
instructions, see "Access Key Authentication" in the IBM Aspera Enterprise Server Admin Guide.

6. Set the TCP and UDP ports. By default, TCP uses port 22 and UDP uses port 33001.

7. Click Browse to test the connection and choose the target directory.


http://downloads.asperasoft.com/en/documentation/1

Remote

Address: watchiolder-s|. asperademo.com

Login: ool

Remate Authentication: [ - ] Password 55H Kay
Password: P

TCP Port: 22

fasp™ Port (UDF): 33001

Path: fdataftarget/package

8. Configure the Transfers section to configure the session bandwidth policy.
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Option Description Example
Target rate Specify the transfer target rate. 10000
Minimum rate Set the transfer minimum rate 0
Bandwidth policy Choose a transfer policy among fair
fixed/high/fair/low.
Transport Encryption Select aes-128 to transfer with this | aes128
encryption method.
Retry policy Specify the number of attempts and |, 3
the duration between each retry. . 30
¢ 50

+ Watchfolder Settings (show)
w Transfer (hide)

Target rate

Minimum rate

Bandwidth policy

Transport encryption

Retry policy

» File Handling {show)

10000 Kbps

0 Kbps

fair r

aesi2g v

3 number of retry attempts

30 seconds between file retries
30 seconds between drop retries

9. Configure the Packages / Drops section to configure the file list detection policy.
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Option

Description

Example

Package timeout

The package timeout defines the
time in which watchfolder waits for
required files. If the required files
do not appear within the duration,
files with dependencies are marked
as not transferred because of
unsatisfied dependencies.

10

Final transfer

e Last file in list: The last file in
the package list is transferred
last.

e File list: The last file transferred
is the file list itself.

+ Last file in list J

File list
=
Used for identifying file lists

Last file in list

File list filters

The file list filter allows
watchfolders to define which files
are considered file lists. Click the

button to add a new filter to
identify file lists. You can set a
filter to include or exclude files by
globbing or by regular expression.

* package

+ Packages / Drops (hide)
Package timeout 10 sBConds
Final trarsfar Last file in list ¢ |
Fila list filters | Glob 2 | nciude 2 | * package Ii]
E3]
U for ipntiying f
For more information on watchfolder settings, see Watchfolder Options on page 80.
10. Click Create.
Activity Overview
Successfully created watchfolder
Transiars  Sync Jobe  Wateh Felders
= Watch Folders
HAME LO:CAL RODE LOGCAL PATH REMOTE NODE REMOTE PATH ETATUS TRAMNSFERF
Camera Feod Trarafors  waiichioider-dc fdainfeiigroeing  walchiDicer-s asperacemo.com  Sdatafargetigrowing kil 3
A Package of Files amchinider-dc fdeafatipackage walchiolder-f.aperademo.com  idatatarpel/package  idls o
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Your watchfolder is now ready to transfer files with file lists. Once you add the files and the file list into the source
directory, watchfolder detects the addition and starts transferring the files. Watchfolder transfers all files before
transferring the last file in the list.

Compes root (s
Started va: Aspern Watchboider 105 Waf
16.0 FE
140 BB
180
10.0 =S
T
LR
40
Session State 0 W
SEELT UM unning LY T
Fi: 3 Complets, 0 Faded, O
oy [ Mark tnactive
Tranapao famp2
Ercryption: AEE-128
— 19E2610L- 0o B Endpoints Snatistics
cBbTANEdb Infaion fienren et S0 5120 TR Tgkal
Targed Rarla: 0.0 Mops. Souwroe: watohfolder-do (VT 62 206,68 Elagsad: 578
M rate: 0 ks Sowos pathis): Elytes written: 116:MB
Flane Poiicy Adaptvn Dostination Watchialder San Joas (5033 100238 Avoragn rte 16.0 MBbos
Network delay. Tama
Session Files Motifeasons: N
Soarch fes Ervors coly
provous 107i0s LRIRl  test 10 s |
WAMLE STATUS STARTED STOMPLD SIZE
VO W D g BT TG TsaC-englah mpd I [ T:VEpm 100 ME
Febata W Eac g T _ e T T -ngliah- trades mod == ] T:¥ipm T:98pm 1puE
Sat T g SR D e T el L herepa mipd [l ) T:hBpm T:98pm 100 B
n this example, watchfolders transfers all files before transferring the last file: "TADI.XML".
D M
BB M
4.0 M
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Semsion I0: i88881nt-Aoac: ] Endpoints Statistics
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Working with Filters
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When given a large set of files, you can configure filters to determine what files watchfolders detects and transfers.
Watchfolders support both globbing and regular expression filters.

To configure a watchfolder with filters, first add the source host to Console as a managed node. Then, follow the
instructions below to create a new watchfolder and configure the Package List options.

Configuring Filters

Go to Activity > Watch Folders and click Create New Watchfolder or edit an existing watchfolder. Expand the

Watchfolder Settings section.

More Opticns

* Watchfolder Settings (hide)

Drop detection strategy Coaol off onby T

Drop detection cool off 10 seconds

Snapshot creation pericd 5 seconds

Connect timeout 12 seconds

Sample period 2 seconds

Queue threshold 5 seconds

File detection cool off 10 seconds

File filters e v R
Files matching any of these filbers will be excluded from watchfolder

transfers

E3)

Next to the Click the File filters field, click the button to add a new filter to identify file lists. You can set a filter
to include or exclude files by globbing or by regular expression.

For example, to exclude text and backup files from a fileset, create two filters that exclude files that match the glob

expressions "*.txt" and "*.bak".

File list filters Clob

Glob

L

Ised for identifying file lists

Exclude v | |*tut

Exclude v | |*.bak

E3
(x]

Watchfolder Options

The following tables provide information on additional configurable settings that are available when creating

watchfolders.
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Watchfolder Settings

Note: A watchfolder groups new or updated files it detects in its source folder into "drops". A drop is defined by the
duration set by the snapshot creation period. All files in a given drop are transferred in the same transfer session, post-
processed together, and reported as a unit.

Option

Description

Drop detection
strategy

The strategy this watchfolder uses to detect files dropped into the source folder.

* Cool off only: Create a drop that includes new files added within the duration by the
snapshot creation period.

* Top level files: Create a drop for each file placed in the top level of the source folder.

* Top level directories: Create a drop for each directory placed in the top level of the
source folder. This drop also includes the sub-directories and files in the top level
directory.

Drop detection cool
off

The duration allowed for new files to be included in a drop. Aspera recommends choosing a
multiple of the specified snapshot creation period for predictable results.

Snapshot creation
period

The duration used to determine what files are included in the current drop.

Connect timeout

The duration the source node waits to connect to the destination node.

Sample period The frequency of the system estimateing the available bandwidth.

Queue threshold The duration watchfolder adds files to a session. Use this feature to limit the number of files
transferred based on the computed available bandwidth.

Retry duration The duration in which the source node tries to establish a connection with the destination

node.

Wait between retries

The duration the source node waits in between retries.

File detection cool
off

The duration watchfolder in which placing a new file in the source folder does not trigger a
new drop.

Note: This setting does not apply to the Cool off only detection strategy.

File filters

Click the button to add a new filter to identify file lists. You can set a filter to include or
exclude files by globbing or by regular expression.

Transfer

Option

Description

Target rate

The transfer target rate.

Minimum rate

The transfer minimum rate

Bandwidth policy

Choose a transfer policy among fixed | high | fair | low.

Transport Encryption

Select aes-128 to transfer with this encryption method.

Retry policy

The number of attempts and the duration between each retry.
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Option

Description

Content Protection

Select Encrypt transferred files with a password to enable content encryption. Enter and
confirm the password the recipient must use to decrypt the transferred files.

Note: When editing a watchfolder with content protection enabled, you must re-The
content protection password. A password must be provided in order to save changes to the
watchfolder.

File Handling

Option

Description

Resume policy

Specify a resume policy and the overwrite rule when the file exists on the destination.

File attributes

Preserve file UIDs, GIDs, or timestamps.

Source Archiving

The designated directory source files are moved to after completing a transfer. The transfer's
session details page display the archive directory's filepath as the After transfer path.

Note: The After transfer path will only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes will not have
access to the After transfer path.

Note: Re-running the transfer may generate a "No such file or directory" error since the
source files were moved to the archive directory.

You can use archive directory variables in the filepath to define specific archive paths for
each drop. Hover over the Archive directory variables link for a list of available variables.

Source deletion

Delete the transferred files from the source computer after transfer.

Growing Files

Option

Description

Maximum parallel
transfers

The maximum number of concurrent transfers of growing files watchfolder can initiate.

Target rate

The target transfer rate.

Bandwidth policy

The bandwidth policy.

Transport encryption

Select aes-128 to transfer with this encryption method.

TCP port

The TCP port to use for this watchfolder.

fasp™ port (UDP)

The UDP port to use for this watchfolder.

Completion timeout

The amount of time to wait for the file to no longer change for the session to finish.

Memory

The maximum amount of memory that the faspstream binary is allowed to use.

Chunk size

The size of data to pack before sending over the network.

Growing file filters

Click the button to add a new filter to identify growing files. You can set a filter to
include or exclude files by globbing or by regular expression.
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Packages / Drops

Option Description

Package timeout A package in watchfolder defines a set of files with dependencies. The package timeout
defines the time in which watchfolder waits for required files. If the required files do not
appear within the duration, files with dependencies are marked as not transferred because of
unsatisfied dependencies.

Final transfer Defines which file has to be transferred last.

» Last file in list: The last file in the package list is transferred last.
+ File list: The files are transferred without any specific order.

File list filters Click the button to add a new filter to identify file lists. You can set a filter to include or

exclude files by globbing or by regular expression.

Running Reports

Creating a Basic Report

Console allows you to create and export custom reports, as well as apply filters and scheduling options. The steps
below demonstrate how to configure new, basic reports. To view an example of a basic report, see the three samples
in this topic. To learn about creating advanced reports within Console, see Creating an Advanced Report on page
84. To create an advanced report, click the New Advanced button instead. You can also copy and edit Console's
built-in, advanced reports, which are listed on the Manage Report Types page. For further information on advanced
reporting, see Creating an Advanced Report on page 84.

1. Go to Reports > Manage Report Types. Click the New Basic button.
2. Enter a name for your report (limited to 75 characters) and a detailed description about the report.
3. Choose the level of detail to show on your report.

Select a field from the drop-down list to be used as the basis for organizing your report. Console generates a report
with a row for each item that matches a chosen field. If you choose more than one field, Console generates a
multi-level report. The data in the generated report is grouped in ascending order by the fields selected from the
drop-down list. For example, if you select Client address, the data in the report is grouped by the transfer initiator
IP addresses. For example, Console groups the five transfers initiated by IP Address 1 in the first grouping,the
three transfers initiated by IP Address 2 in the second grouping, and so on..

Note: Once a field is selected, the drop-down list updates automatically to allow for multiple levels of
organization. To remove a level of organization, click the Remove link that appears next to the selected field.

The drop-down list includes all Console built-in fields and custom fields. For a list of built in fields, see
Reference: Basic Report Organization Options on page 166. For more information on custom fields, see
Creating Custom Fields on page 88.

4. Seclect the data columns to include in your report. These include built-in and custom fields.
Select whether to use basic fields only or both basic fields and advanced fields from the Available Columns drop-
down menu. Use the blue arrows to add and remove selected data columns.
Note: The columns available in the list are determined by the organizational fields chosen in the step before.
5. Configure result sorting.
Select fields to sort by and whether to sort the data in ascending or descending order

Grouping and sorting options appear based on the data columns that you chose to include in the report. By default,
the report is sorted by the organization field selected in the previous step.
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6. Add a filter to show only results matching the entered value.
For detailed information on Console's filters, please see Reference: Reporting Filters on page 168.

7. Create your report. You can also run it at this time.

* Click Create: Save the report without running it. You are redirected to the Manage Report Types page
where you can see the new report in the list of reports. Custom reports have edit and delete links, which
differentiate them from Console's built-in reports. Both custom reports and built-in reports include a copy link
for duplicating the report and a run link to view run settings and generate the report.

* Click Create and Run: Save the report and run it. The new report is added to the Manage Report Types page,
but first, you are redirected to the New Report page where you must finalize the report run settings and click
the Run Report button to run the report.

Creating an Advanced Report

The following instructions describe how to create advanced reports. To view an example of an advanced report, see
Advanced Report Example: Transfer Sessions with High Packet Loss on page 201. For more informationabout
creating basic reports, see Creating a Basic Report on page 83.

Important: Aspera recommends you read through the Advanced Report Usage Notes on page 181 before
configuring an advanced report.

1. Go to Reports > Manage Report Types. Click the New Advanced button.
Note: You may also modify an advanced report by clicking the edit action for an advanced report that is listed on
the Manage Report Types page.

2. Enter a name for your report (limited to 75 characters) and a detailed description about the report.

3. Configure the SQL script text.
For information on available SQL variables or database field references, click on the Help link.
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SOl ScnptText CREATE TABLE $FIMAL_RESULT_TAEBLE
Help SELECT DISTINCT
t.name

, t.contact

.last_source_ip AS “from’
.last_dest_ip AS "to’
.started_at

.stopped_at

.status
.bytes_transferred
.files_complete

.files _failed

.Tfiles _skipped

H
oot ottt ot

FROM
3TEL_TRANSFERS t

WHERE
t.started_at <« '$REPORT_PERIOD_END®
AND (
t.stopped_at »>= '$REPORT_PERIOD START'
OR t.stopped_at IS NULL

)

ORDER BY
t.started_at
, t.id

For a list of available reference variables, see:

» Reference: SQL Variables for Advanced Reports on page 170
» Reference: Database Fields for Advanced Reports on page 171,
* Creating Custom Fields on page 88

When creating advanced reports, you may specify a custom variable within the WHERE clause (for example,

Scustom_variable). Once declared within the SQL script text, you can to view and edit the variable by clicking
Edit Parameters the Edit Advanced Report Template page. You are prompted to enter a value for the variable

when you run the report.

. Optional: Add a filter in the WHERE section of your script.

For example, this example script filters out transfers that do not have a reported policy and transfers that do not
fall within the specified date range.

WHERE

ts.reported policy IS NOT NULL

AND
ts.started at < 'SREPORT PERIOD END'
AND (

ts.stopped at >= 'SREPORT PERIOD START'
OR ts.stopped at IS NULL
)

For a list of available SQL variables you can use, Reference: SQL Variables for Advanced Reports on page
170.

5. Create your report. You can also run it at this time.
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* Click Create: Save the report without running it. You are redirected to the Manage Report Types page
where you can see the new report in the list of reports. Custom reports have edit and delete links, which
differentiate them from Console's built-in reports. Both custom reports and built-in reports include a copy link
for duplicating the report and a run link to view run settings and generate the report.

* Click Create and Run: Save the report and run it. The new report is added to the Manage Report Types page,
but first, you are redirected to the New Report page where you must finalize the report run settings and click
the Run Report button to run the report.

Finalizing and Running a Report

Console requires you to finalize the report's run settings before running a report.

1.

You can initiate finalizing and running a report in the following ways:

» After configuring your basic or advanced report, click Create and Run.

* Go to Reports > Manage Report Types from the Console menu and clicking the run link From the Actions
column.

* Go to Reports > Run a Report. Select a built-in or custom report from the list.

* Go to Reports and click the rerun link from the Actions column for a recently run report.
You are redirected to the New Report page.

Name the report.

. Run the report now or schedule it to run later.

* Select Run Now: Run this report immediately.

» Select Run Later: Schedule a report by setting the run date. You may also select Repeat to schedule a
repeating report.

Define the report period.

Option Description

Report on Select a pre-defined time period from the drop-down list.
» last hour
* last 24 hours
* last week
* month to date
* last month
¢ custom

Start date Select the start date of this report. You must select custom in the drop-
down menu to modify this field.

End date Select the end date of this report. You must select custom in the drop-
down menu modify this field.

Time zone Select the time zone for this report.

Enter values for your custom SQL variables under Report Parameters. If there are no values, no custom
variables were specified for this report.

For more information on custom variables, see Editing Custom Variables on page 87.
Optional: Enter an email address and click the Add button to email a recipient a copy of this report.
After adding an email address, select whether the report is sent as an XLSX or a CSV file.

Optional: Choose additional file formats (XLSX and CSV). These files can be downloaded after the report has
been generated.

Click Run Report after finalizing your settings.
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Your generated report is listed on the Scheduled and Recently Run Reports page. When viewing your report, you have
the following options:

» For a custom report, click Edit Report Type to configure report.
* To run the report again, click Rerun.
» Ifyou chose to export your report in CSV or XLSX, click the respective button to download the files.

Editing Custom Variables

When creating advanced reports, you can specify a custom variable within the WHERE clause. For example, to create
a search by contact, enter:

WHERE
contact = 'SCONTACT MATCH'; # SCONTACT MATCH is the custom variable.

Once you declare the variable within the SQL script text, you can view and edit the variable on the Edit Advanced
Report Template page.

1. To edit a custom SQL variable used in an advanced report, go to Reports and click the Manage Report Types
button. Find the advanced report and click edit. Click Edit Parameters.
2. Find the custom variable you want to configure and click edit.

3. Select the desired variable type from the Type drop-down menu.

Variable Type Description

string The value of this variable must be a string.

integer The value of this variable must be an integer.

date The value of this variable must be a valid date. Click the calendar icon to select a valid
date.

ip The value of this variable must be a valid IP Address.

4. Optional: Allow the user running the report to leave the variable undefined by clearing Is field required?. Custom
variables are required by default.

If Is field required? is selected, a user running this report is required to enter a value for the custom variable to
run the report.

Note: If the custom variable is not required and it is used with the AND operator, then write the report query as

follows:
WHERE
AND (
t.status = 'SFOO'
OR 'SFOO' = "'
)
Failure to include OR '$FOO' = '' results in an empty report because the data is filtered by t . status =

' ', which is always false.

5. Optional: Define the variable name that is displayed when Console asks for the value of this variable.
For example, if you want to search by contacts and included a custom variable named SCONTACT MATCH in
your SQL script, Console by default prompts the user running the report to enter a value for "Contact Match." If
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you enter "User Name" in the Label field, Console asks for a value called "User Name" instead and matches the
result to SCONTACT MATCH.

Optional: Add a hint to remind the user the purpose of this variable.

Continuing the previous example, if your custom variable, SCONTACT MATCH, is used to search your database
for contacts matching the value of this variable, a possible hint is: "Search by this CONTACT name."

When running the report, the user is prompted with the following:

Report Parameters

User Mame
Search by this CONTACT name.

When finished, click Update.

Creating Custom Fields

Custom fields are used to specify rules for automatically populating fields in basic and advanced reports.

1.
2.
3.

® AW

Go to Configuration > Custom Fields.
Click New Custom Field.

Select transfer or file from the Level drop-down list, depending on whether the new custom field stores transfer-
or file-related content.

Enter a name for the custom field. The name must be unique and lowercase.

The resulting SQL name is prefixed with "cf ". For example, the field name "metadata" appears as "cf metadata".
Note: Custom fields appear in the database with the "cf " prefix. Custom fields are utilized in the $TBL_FILES
and STBL TRANSFER tables.

Enter the start date (date on which to start custom field calculation).

Enter a custom field description.

Click Create.

Create and associate new rules for your custom field.

Rules are conditions that define when the custom field to comes into effect. To set up the rule's conditions,
configure the following settings:

» Select a built-in field from the drop-down list.

* Enter an operator.

* Enter an expression.

» Enter the value Console uses to populate the custom field if conditions are met.

For a list of field names and definitions, see Reference: Built-In Fields for Custom Field Rules on page 167.

For example, to create a custom field that is populated with your company name, create a new custom field and
associate it with the following rule:
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Defaults Cookies Iap S3H Keys Background Database Custom Fields License

= Editing Rule for Custom Field: company_name
Rule name My Campany

If the following conditions are met:

Built-in field NOT Operator Expression
Source Address T = T 10.0.0.1 remove
choose field... b

Then set the ‘company_name’ custom field value to:

Ny Comparny

9. Click Create.

For each custom field, you can create multiple rules that populate with different values based on various conditions.
When multiple rules are present, Console uses the first rule listed (as long as it matches the condition). To modify the
order of the custom field rules, use the drag-and-drop function to move the rules in the list.

When creating an advanced report, you can find your available custom fields by clicking the Help link in the SQL
Script Text section.

SQL_ScnptText CREATE TABLE $FIMAL_RESULT_TABLE
| Help SELECT DISTINCT
t.name

, t.contact

.last_source_ip AS “from’
.last_dest_ip AS "to’
.started_at

.stopped_at

.status
.bytes_transferred
.files_complete

.files _failed

.files _skipped

H
oot oottt oo

FROM
3TEL_TRANSFERS t

WHERE
t.started_at <« '$REPORT_PERIOD_END®
AND (
t.stopped_at »>= "$REPORT_PERIOD START'
OR t.stopped_at IS NULL

)

ORDER BY
t.started_at
, t.id
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For an example of using a custom field in a report, see Advanced Report Example: Transfer Sessions with High
Packet Loss on page 201.

Configuring SSH Keys

SSH Keys

SSH keys provide a more secure way to authenticate than using passphrases.Console generally uses SSH keys for two
purposes:

* Authentication to administer and configure a node.
* Authentication to make a transfer from one node to another.

You can store keys and find a list of existing keys by navigating to the SSH Private Key page in either of two
locations:

* Personal Preferences: Select Preferences from the drop-down menu next to your username in the upper right-
hand corner. Then, select the SSH Keys tab.
* Console Configuration: Go to Configuration > SSH Keys from the Console menu.

For more information on storing keys, see Storing SSH Keys on Console on page 90.

The steps to using an SSH key differs if you are using an SSH key to make a transfer or using one to make a transfer
to nodes with endpoints that use SSH keys.

Using SSH Keys in Transfers

A user must add an SSH key in his personal preferences before he can use that key in a transfer. Even if the SSH key
is configured in Console Configuration settings, if the user did not the key in his personal preferences, the key does
not appear when he enters the credentials for a node to set up a transfer.

Making Transfers to Nodes With Endpoints that Use SSH keys

When making transfers to nodes with endpoints using SSH keys, the transfer user on the initiating node also needs
to have the private key in the .ssh folder. For a walkthrough of this process, see Transferring Files with an Endpoint
Using SSH Keys on page 91.

Storing SSH Keys on Console

Console uses a node machine's private key to authenticate into the machine using public key authentication. You
must first store in Console the private key paired with the public key on the node machine. You can store private
keys privately in your user preferences or globally in Console configurations. These SSH keys can then be used to
authenticate endpoints or transfers.

1. Go to your private SSH keys or Console's stored SSH Keys.

* Personal Preferences: Select Preferences from the drop-down menu next to your username in the upper
right-hand corner.
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Then, click the SSH Private Keys tab.
* Console Configuration: Go to Configuration > SSH Keys.

2. Click New SSH Private Key.
3. Enter a descriptive name to represent the SSH key in Console.
4. Enter the filename of the key on the initiating node in the Filename on node field.
To use this key in a transfer, Console searches the initiating node for a file that matches the filename given.

You can enter the filename with or without the full path. For example, Console accepts both my-ssh-key and
path/to/my-ssh-key.

Make sure you or the node administrator uploads the SSH key to the node or nodes from which you want to
initiate transfers.
5. Click Choose File to upload the same private key uploaded to the initiating nodes to Console.

If you do not have direct access to the node, you must ask the node administrator to give you the private key. This
key is used to browse and configure the node.

6. Enter and confirm the passphrase of the key, if any.

7. Click Save.

8. Click Test to test the new SSH private key.
Provide the following information:

» The address of the computer that has the paired public key installed in their authorized_Kkeys file.
* The corresponding user name.

Then, click Connect with SSH Key to test against the computer.

Tip: If the connection fails, contact the node administrator to make sure the public key is properly installed in the
authorized_Kkeys file.

Transferring Files with an Endpoint Using SSH Keys

The objective of this example is to set up two nodes in Console to transfer files from one node to the other using
public key authentication.

»  User A: Transfer user found on Node A.

*  User B: Transfer user found on Node B.

* Node A: The node initiating the transfer. This node holds the private key.

* Node B: The node receiving the files. This node holds the public key matching the private key in Node A. We set
up an endpoint using SSH keys for this node.

Note: For the purpose of this example, both nodes are Linux machines.

1. Generate a private key as User A on Node A with the following command:
# ssh-keygen -t rsa

Choose the default location to store this new private key (Default is ~/ . ssh).
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2. Make sure User A has read and write permissions for the private key file.

$ chmod 600 ~/.ssh/id rsa
$ chmod 644 ~/.ssh/id rsa.pub

3. Copy the SSH public key into User B's authorized_keys file on Node B.

# cat ~/.ssh/id rsa.pub >> ~./ssh/authorized keys

4. In Console, add Node A as a managed node and Node B as an unmanaged node.

5. Go to Configuration > SSH Keys and upload the private key to Console. This key should be paired with the
public key copied to Node B.

6. Go to Nodes and edit Node B. Click Endpoints and add a new endpoint. Choose to use the SSH key that was
uploaded to Console.

7. Make a transfer from User A on Node A to the saved endpoint on Node B.

Working With SSL

Installing a Signed SSL Certificate Provided by Authorities

In a default IBM Aspera Console installation, Apache generates and uses a self-signed SSL certificate. You can find
this certificate at the following location:

OS Version File
32-bit Windows * C:\Program Files\Common Files\Aspera\Common
\apache\conf\server.crt
* C:\Program Files\Common Files\Aspera\Common
\apache\conf\server.key
64-bit Windows » C:\Program Files (x86)\Common Files\Aspera
\Common\apache\conf\server.crt
* C:\Program Files (x86)\Common Files\Aspera
\Common\apache\conf\server.key

To set up a signed SSL certificate, follow these steps:
1. Create a working directory

Go to Start menu > All Programs > Accessories > Command Prompt and create a new working directory:

> mkdir c:\ssl
> cd c:\ssl

2. Copy openssl.cnf to your working directory.

Enter the following commands in your Command Prompt window:

OS Version Commands

32-bit Windows
> copy "c:\Program Files\Common Files\Aspera\common\apache

\conf\openssl.cnf" "c:\ssl\"
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OS Version Commands
> cd c:\ssl

64-bit Windows
> copy "c:\Program Files (x86) \Common Files\Aspera\common

\apache\conf\openssl.cnf" "c:\ssl\"
> cd c:\ssl

3. Enter the OpenSSL command to generate your Private Key and Certificate Signing Request (CSR).

Run the following command (where key name.key is the name of the unique key that you are creating and
csr_name.csr is the name of your CSR):

> openssl req -config "c:\ssll\openssl.cnf" -new -nodes -newkey rsa:2048 -
keyout key name.key -out csr name.csr

Note: In the example above, the .key and .csr files will be written to the c:\ssl\ directory. Windows does not, by
default, have a ¢:\ssl directory. If the directory does not exist on your machine, first create it with this command:

> mkdir c:\ssl

After entering the command, you are prompted to enter several pieces of information, which are the certificate's
X.509 attributes.

Important: The Common Name field must be filled in with the fully qualified domain name of the server to be
protected by SSL. If you are generating a certificate for an organization outside of the US, see https://www.iso.org/
obp/ui/#search/code/ for a list of 2-letter, ISO country codes.

Generating a 1024 bit RSA private key
.................... ++++++

You are about to be asked to enter information that will be incorporated
into your certificate request.

What you are about to enter is what is called a Distinguished Name or a
DN.

There are gquite a few fields but you can leave some blank

For some fields there will be a default value,

If you enter '.', the field will be left blank.

Country Name (2 letter code) [US]:Your 2 letter ISO country code

State or Province Name (full name) [Some-

State] :Your State Province or County

Locality Name (eg, city) []:Your City

Organization Name (eg, company) [Internet Widgits Pty Ltd]:Your Company

Organizational Unit Name (eg, section) []:Your Department

Common Name (i.e., your server's hostname) []:secure.yourwebsite.com

Email Address []:johndoe@yourwebsite.com

Note: You are prompted to enter "extra" attributes, including an optional challenge password. Manually entering
a challenge password when starting the server can be problematic in some situations (for example, when starting

the server from the system boot scripts). You can skip entering values for any extra attribute by hitting the "enter"
button.

Enter the following 'extra' attributes
to be sent with your certificate request
A challenge password []:


http://www.iso.org/iso/english_country_names_and_code_elements
http://www.iso.org/iso/english_country_names_and_code_elements
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An optional company name []:

After finalizing the attributes, the private key and CSR will be saved to your root directory.

Important: If you make a mistake when running the OpenSSL command, you may discard the generated files
and run the command again. After successfully generating your key and Certificate Signing Request, be sure to
guard your private key, as it cannot be re-generated.

. Send CSR to your signing authority.
You now need to send your unsigned CSR to a Certifying Authority (CA). Once the CSR has been signed, you

have a real Certificate. Follow the key provider's instructions to generate and submit both your private key and the
Certificate Signing Request (CSR) to acquire the certificate.

Important: Some Certificate Authorities provide a Certificate Signing Request generation tool on their Website.
Check with your CA for additional information.

At this point, you may need to generate a self-signed certificate because:

*  You don't plan on having your certificate signed by a CA.
*  You wish to test your new SSL implementation while the CA is signing your certificate.

For information on how to generate a self-signed certificate for temporary use, see Generating a New Self-Signed
SSL Certificate on page 95.

. Store your certificates on your machine.

For example:

* C:\my server.crt
* C:\my server.key

Your certificate provider may require you to also install an Intermediate CA Certificate file. Copy the file to the
following location:

OS Version Path
32-bit Windows C:\Program Files\Common Files\Aspera\Common\apache\conf\server-ca.crt
64-bit Windows C:\Program Files (x86)\Common Files\Aspera\Common\apache\conf\server-ca.crt

. Install the SSL certificate with the following command:
> asctl apache:install ssl cert cert file key file [chain file]
For example:

> asctl apache:install ssl cert C:\my server.crt C:\my server.key C:
\Program Files\Common Files\Aspera\Common\apache\conf\server-ca.crt

You can find the installed certificate at the following location:

OS Version File

32-bit Windows »  C:\Program Files\Common Files\Aspera\Common
\apache\conf\server.crt

e C:\Program Files\Common Files\Aspera\Common
\apache\conf\server.key

64-bit Windows »  C:\Program Files (x86)\Common Files\Aspera
\Common\apache\conf\server.crt

* C:\Program Files (x86)\Common Files\Aspera
\Common\apache\conf\server.key
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Generating a New Self-Signed SSL Certificate

You may need to generate a self-signed certificate because:

1.

You don't plan on having your certificate signed by a CA.
You wish to test your new SSL implementation while the CA is signing your certificate.

Create a working directory

Go to Start menu > All Programs > Accessories > Command Prompt and create a new working directory:

> mkdir c:\ssl
> cd c:\ssl

Generate a self-signed certificate using OpenSSL.

This temporary certificate will generate an error in the client's browser that warns the client that the signing
certificate authority is unknown and not trusted. To generate a temporary certificate (which is good for 365 days),
run the following command:

> openssl x509 reqg -days 365 -in csr name.csr -signkey key name.key -
out cert name.crt

Regenerating Self-Signed SSL Certificate (Apache)

When you initially set up Console on your system a pregenerated, self-signed SSL certificate is also installed. If you
have changed your Apache hostname, regenerate the self-signed certificate by following the instructions below.

1.

Open a Command prompt window and run the asct/ command.

In a command prompt window (Start menu > All Programs > Accessories > Command Prompt), run the
following command to generate a new, self-signed SSL certificate for your installation of Console (where you will
replace the HOSTNAME with your Apache server's IP address or host name):

> asctl apache:make ssl cert HOSTNAME

Answer yes when prompted to overwrite the existing certificate.
Confirm that your certificates are updated.

Check the following location to confirm your self-signed SSL certificates have been updated:

OS Version File

32-bit Windows » C:\Program Files\Common Files\Aspera\Common\apache\conf\server.crt

* C:\Program Files\Common Files\Aspera\Common\apache\conf\server.key

64-bit Windows « C:\Program Files (x86)\Common Files\Aspera\Common\apache\conf\server.crt

* C:\Program Files (x86)\Common Files\Aspera\Common\apache\confiserver.key
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Working with Shares and Directory Services

Console and Shares on Same Machine

Important: This topic assumes that you have already installed IBM Aspera Shares. If you have not installed Shares
yet, please see the IBM Aspera Shares Administrator's Guide.

If you installed Console on the same machine as Shares, you must update the host and port settings in Shares'
database.yml file. Your database.yml file can be found in the following directory:

C:\shares\www\config\database.yml
Open database.yml with a text editor and perform the following modifications:

» Comment out the socket location.
* Change the host to 127.0.0.1.
» Change the TCP port to 4406.

After performing these modifications, your database. yml file should look similar to the example below.

production:
adapter: mysqgl2
encoding: utfs
reconnect: false
database: web production
pool: 5
username: admin
password: v00d00
# socket: /tmp/mysqgl.sock
# socket: /var/lib/mysgl/mysqgl.sock
host: 127.0.0.1
port: 4406

Configuring the Directory Service

Important: You must install IBM Aspera Shares locally or on a remote host before you can configure a directory
service. For information on installing the latest version of Shares, please review the Administrator's Guide.

Before continuing, please ensure that the following prerequisites have been satisfied:

» Shares is installed locally or on a remote host: For instructions on how to install Shares on the same machine as
Console, see Console and Shares on Same Machine on page 96.

» Console is installed on the same machine as Shares: Configure your Shares web server to use a non-standard
HTTPS port (for example, 8443, rather than 443). See the Shares Administrator's Guide (the "Setting up Shares"
topic).

* Console is installed on the same machine as Shares: Configure your Shares database with the correct host and port
settings. For more information, see Working with Shares and Directory Services on page 96.

1. Go to Accounts > Directories from the Console menu.

2. Select Remote Authentication to enable remote authentication so that Console can access the groups and users
on your Shares server.

3. Enter the base URL.

Shares users and groups are authenticated through this Node API base URL. The standard base URL is
https://shares IP address/api/vl.


http://downloads.asperasoft.com/en/documentation/34
http://downloads.asperasoft.com/en/documentation/34
http://downloads.asperasoft.com/en/documentation/34
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Note: Because you must use HTTPS to connect to your Shares directory service, ensure that your Node API base
URL uses HTTPS, rather than HTTP.

4. Enter the admin Shares user with API login capabilities. You can set API login abilities for a user from the Shares
Admin page (Admin > Users > username > Security > API login).

5. Click Save and test settings.

Once the directory service is successfully connected, you can add remote users and remote groups by boing to Users
> Groups. For more information, see Adding Remote Users on page 97 and Adding Remote Groups on page
97.

Adding Remote Users

1. Go to the Users menu. Click Add Remote User.

Note: The Add Remote User button does not appear if you have not configured the directory service.
2. Enter the full or partial name of an existing remote user. Click Search.
3. Once your search results appear, select the remote user by clicking Add.

4. Configure the remote user's Console permissions and assign the user to a group.

Adding Remote Groups
1. Go to Groups. Click Add Remote Group.

Note: The Add Remote User button does not appear if you have not configured the directory service.

2. Enter the full or partial name of an existing remote user. Click Search.
Note: Console does not find remote groups that start with a backslash (\) or an asterisk ( * ). Avoid naming
groups that start with these characters.

3. Once your search results appear, select the remote group by clicking Add.

4. Configure the remote group's transfer paths and members.

Working with SAML

SAML and Console

IBM Aspera Console supports Security Assertion Markup Language (SAML) 2.0, an XML-based standard that
allows secure web domains to exchange user authentication and authorization data. With the SAML model, you can
configure Console as a SAML online service provider (SP) that contacts a separate online identity provider (IdP) to
authenticate users. Authenticated users can then use Console to access secure content.

With SAML enabled, Console redirects a user to the IdP sign-on URL. The user signs in with the IdP and the IdP
sends a SAML assertion back to Console, which grants the user access to Console. When a SAML user logs in to
Console for the first time, Console automatically creates a new user account based on the information provided by the
SAML response. Any changes subsequently made to the account on the DS server are not automatically picked up by
Console. For more information about user provisioning for SAML users, see User Accounts Provisioned by Just-In-
Time (JIT) Provisioning on page 98.

IdP Requirements
To use SAML with Console, you must already have an identity provider (IdP) that meets the following requirements:

* Supports SAML 2.0
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» Able to use an HTTP POST Binding.

* Able to connect to the same directory service that Console uses.

* Not configured to use pseudonyms.

» Can return assertions to Console that include the entire contents of the signing certificate.
» If prompted, set to sign the SAML response. (Signing the SAML assertion is optional.)

Configure the SAML IdP
Before configuring SAML in Console, make sure you configure your IdP to send a correct SAML response to
Console. For more information, see Configuring Your Identity Provider (IdP) on page 99.

For instructions on configuring SAML, see Configuring SAML on page 99.

SAML and Directory Services

Console supports the use of both SAML and directory services. If you configure both services to Console, ensure the
services use different Active Directory domains. Aspera advises against configuring LDAP directly to Console if the
SAML IdP acts as a frontend for the same Active Directory domain.

Bypassing the Default SAML IdP

Console provides a mechanism for users to bypass the SAML redirect and log in using a local username and
password. This feature allows admins to correct server settings, including a mis-configured SAML setup, without
logging in through SAML.

To bypass the SAML login, add 1login?local=true to the end of the login URL. For example:
https://198.51.100.48/1login?local=true

User Accounts Provisioned by Just-In-Time (JIT) Provisioning

When a SAML user logs in to IBM Aspera Console for the first time, Console automatically creates a new user
account based on the information provided by the SAML response. If the SAML response also contains group
information, and that group does not yet exist in Console, Console automatically creates a new SAML group for each
group of which the user is a member.

Group Permissions

A SAML user belonging to multiple groups is given the permissions and settings of all groups it belongs to with
permissions overriding restrictions. For example, if Group A disallows sending to external users but Group B does
not, users who belong to both groups are allowed to send to external users. Settings that require specific handling are
as follows:

* Account expiration is only enabled if all groups to which a user belongs specify account expiration. If account
expiration is enabled, the expiration date is set to the latest expiration date from among all groups.

» For any settings that use Server Default, Yes or Allow, and No or Deny, the setting is set to Yes if any group
specifies Yes, and it is set to No if all groups are set to No. Otherwise, it is set to use the server default.

» For package deletion policy, override is enabled if all groups specify override, or if the least restrictive group
setting is less restrictive than the server-wide setting. If override is enabled, the least restrictive group setting is
used. Do nothing is less restrictive than Delete files after all recipients download all files, which in turn is less
restrictive than Delete files after any recipient downloads all files.

» For advanced transfer settings, override is enabled if all groups specify override or if any group specifies any
transfer rate that is higher than the server default. If override is enabled, each transfer rate is set to the higher of the
highest value from among the groups and the server default. The minimum rate policy is locked only if all groups
specify the setting.
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IdP Requirements

To use SAML with Console, you must already have an identity provider (IdP) that meets the following requirements:

Supports SAML 2.0

Able to use an HTTP POST Binding.

Able to connect to the same directory service that Console uses.

Not configured to use pseudonyms.
Can return assertions to Console that include the entire contents of the signing certificate.

If prompted, set to sign the SAML response. (Signing the SAML assertion is optional.)

IdP Metadata Formats

You must configure formats to set up your IdP to work with Console:

Tag Format

Entity ID: https://server_name_or_ip/aspera/console/auth/saml/metadata
ACS: https://server_name or_ip/aspera/console/auth/saml/callback
Base URL: https://server_name_or_ip/aspera/console

If the IdP is capable of reading SAML XML metadata for a service provider, you can upload a saved XML
metadata file to configure the IdP. You can retrieve the XML metadata for an existing Console by going to
https://server ipaspera/console/auth/saml/metadata and saving the XML as an XML file.

SAML Assertion Requirements

Console: expects assertion from an IdP to contain the following elements:

Default Attribute Console User Field Required

NameID/SAML SUBJECT Username Yes, with the format:
urn:oasis:names:tc:SAML:1.
format:unspecified

email Email address Yes

given name First name Optional

surname Last name Optional

member of SAML group Necessary for SAML groups

Configuring SAML

Before following the instructions below, have the following information on hand:

IdP Single Sign-On URL (SSO)
IdP Certificate Fingerprint or IdP Certificate

1. Go to Accounts > SAML to open the SAML Configuration page.
Select SAML Authentication.

3. Enter the SSO Target (Redirect) URL.

SAML | 99

1:nameid-
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4. Enter the certificate fingerprint and choose the certificate fingerprint algorithm that matches the certificate

fingerprint.

5. Click Save.

Backing Up Console Database

Back Up Console with asctl

There are two different ways to back up the Console database:

1.

Through the asct1 command, which backs up only the MySQL database. Use this method before a Console
upgrade procedure, or to guard against possible database corruption.

Through the Console web UI, which backs up the MySQL database in addition to all the files required to fully
restore the Console application. Use this method for disaster recovery purposes, in order to restore Console when
the entire server is lost.

Back up the Console database using an asct1l command. Open a Command Prompt (Start > All Programs >
Accessories >Command Prompt) and execute the following command:

> asctl console:backup database

This command uses mysqldump to create Console's MySQL database backup. The backup file, aspera_console.sql,
is saved in the following directory:

OS Version Path

32-bit Windows C:\Program Files\Aspera\Management Console\backup\<year-

month-day time>

64-bit Windows C:\Program Files (x86) \Aspera\Management Console\backup

\<year-month-day time>

For instructions on restoring your Console database, see Restoring the Console database on page 101.

Backing Up Console with the Web Ul

There are two different ways to back up the Console database:

1.

Through the asct1 command, which backs up only the MySQL database. Use this method before a Console
upgrade procedure, or to guard against possible database corruption.

Through the Console web UI, which backs up the MySQL database in addition to all the files required to fully
restore the Console application. Use this method for disaster recovery purposes, in order to restore Console when
the entire server is lost.

1. Select Configuration > Database from the Console menu. Click Back Up.

Enter the desired path of the Console machine into the Save to field. This path is the destination folder for the
console_full backup YYYY-MM-DD_hhmmss backup file.

Schedule the backup to Run Now or to Run Later.

* Click Run now: Back up the database immediately.
* Click Run later: Specify a time in the future or configure a repeating backup operation.

Click Back Up Now.
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Once Console has been backed up, the backup file appears on the Database Backups page, where scheduled, current,
and recent backups are listed. To view details on a particular backup, click anywhere in the backup's row.

Restoring the Console database

1. Stop Console.

> asctl console:stop

2. Restore the Console database.

» If you made a back up of the Console database with the asctl command, you can restore it with the following
command:

> asctl -v console:restore database C:\path\to\dir
For example:

> asctl -v console:restore database C:\Program Files (x86)\Aspera
\Management Console\backup\2013-1-16 164305

» If you made a back up of the Console database with the web UI, you can restore it with the following
command:

> asctl -v console:restore C:\path\to\dir
For example:

> asctl -v console:restore C:\temp
\console full backup 2013-1-16 00.57.28 UTC

Important: The restore command does not support relative paths to the backup directory. The path must be an
absolute path in order for the restore command to work.

3. Start Console.

> asctl console:start

Migrating Console Database from a Linux Server

1. Back up the Console database on the Linux server.

> asctl console:backup database

2. Copy the backed up folder to your server.

3. Stop Console services on your server.

> asctl console:stop

4. Restore the backed up database to your server.

> asctl -v console:restore database database folder

5. Copy the secret.yml file from the old server to the new server.

The secret. yml file is located at:

* Linux: /opt/aspera/console/config/secret.yml
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* Windows: C:\Program Files (x86)\Aspera\Management Consolel\config\secret.yml
6. Regenerate the Console configuration file using the new settings:

> asctl console:generate config

Managing the MySQL Database

Configure MySQL Settings

You may want to modify the MySQL settings for security or management purposes.

To begin, open a Command Prompt (Start menu > All Programs > Accessories > Command Prompt) and execute
the following commands:

Change the Database root Login Password
MySQL database's root account's password is set during the setup process. For security reason, it is recommended
to update the password. Use the following command to change the password. Enter the new and old password when
prompted:

> asctl mysqgl:set root password
Change the MySQL Port
By default, Console's MySQL uses TCP port 4406. Use the following command to change it.

> asctl mysqgl:port 1234

If the MySQL's port number is changed, you will need to provide the updated Console settings to all the nodes, and
reflect the new settings in all the nodes' aspera.conf files.

Running MySQL on a Separate Machine

After you have installed Console, you can further configure it to run the MySQL database on a remote machine.
Follow these steps to run the web application and the MySQL database on two separate machines:

Note: This setup procedure involves steps on the Console machine and the MySQL machine. A MySQL machine or

Console machine is indicated at each step.

1. (MySQL machine) Download and execute the Console installer and install only Aspera Common Files.
Download and execute the Console installer on the remote MySQL database computer.

2. Select Custom.


http://www.asperasoft.com/en/products/transfer_management_3/aspera_console_3

| Managing the MySQL Database | 103

i'EJ Azpera Management Console Setap

Choose Setup Type

iZhoose the setup bvpe that best suits vour needs

| Typical |

Inskalls the most common program features, Recommended For mosk users,

( _uskam ]

Allaws users to choose which program Features will be installed.
Recommended for advanced users,

3. De-select the Aspera Console feature in the following screen.
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i';%'* Azpera Management Conzole Setap

Custom Setup
Select the way ywou want Features to be installed.
Click the icons in the tree below to change the way Features will be installed.
SR . Installs Aspera Management
Console, Inchudes installation of the
=3 ~ | Aspera Common Files Apache Server, Ruby, and ASCTL.
= ~ | MvSQL Database
This Feature requires 35MB on wour
hard drive, It has 1 of 1
subfeatures selected, The
subfeatures require 9936KE on wour
hard drive,
Resek | | Disk Usage | | Back “ Mexk | | iZancel

4. Create or update an Aspera service account.

By default, the user name is svcAspera. If the server is configured to accept the domain user login, use a domain
account that has been added to the local administrator's group to run the services.

If the local account does not already exist, enter new credentials and click Next. The installer will create an
account with the information you have entered. If the account exists (created through the previous installation),
enter the account's password and click Next. If the existing user's password you have entered is incorrect, or you
wish to change the Aspera service user, see Managing the Aspera Service Account on page 118.
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i'.EJ Azpera Management Conzole Setap

Aspera Management Console Setup

Associate the Aspera services with a User Account,

This package installs multiple Aspera services, Enter a dedicated account ko run the
services (for example: swohspera or sycAspera@mydornain, example,org). IF the local
account doesn't exist, it will be created. Domain accounts musk exisk priar,

Mote: IF Aspera kransfers run to and From network shares, wou must run the Aspera
services as a domain user with access to the necessary network resources,

Lser name: svCAspEra

Passward: [+

Back. ” ek | | Cancel |

5. Select Install to start the installation.

i'él Azpera Management Conszole Setap

Ready to install Aspera Management Console

Click Inskall ko beqin the installation, Click Back to rewview or change any of wour
installation sektings. Click Cancel bo exit the wizard,

Back. ” Inskall | | Cancel

When finished, clear the Launch Asctl to configure Console option and click Finish to finish the installation.
6. (MySQL machine) Setup MySQL database.
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On the MySQL machine, bring up a Command Prompt and execute this command to configure MySQL.:
asctl mysgl:setup

When started, the configuration program will ask you to use streamlined or detailed setup. Expect the following
setup items in each setup method: (In detailed setup, answer y in the first question.)

Item Streamlined | Detailed
MySQL will run on this machine (y/n)? (default: y) X

What port would you like MySQL to listen on? (default: 4406) X X
Where would you like MySQL to store data: (default: C:/Program files/ X
Common Files/Aspera/Common/myql/data)

MySQL will need to start/restart during configuration. Continue (y/n)? X X
(Current: y)

Lastly, a setup summary shows your settings. Enter y to confirm, n to change settings, or x to quit the program
without saving.

When finished, execute this command to allow access for the Console machine. Replace the highlighted items
to match your configuration (Enter the Console machine's address in <Console_server IP>, and your MySQL
password in <mysql password>):

asctl mysqgl:grant remote access <Console server IP> root <mysqgl password>

7. (Console machine) Configure Console to use a remote MySQL database.

On the Console machine, execute this command to configure it to run MySQL on a remote machine:
> asctl console:setup

Answer n to the following question:

MySQL will run on this machine (y/n)? (default: y)

Purging Data from Console

You can archive or purge data from Console (for example, purge all sessions before January 1, 2000) by clicking the
Purge button from the Database Backups page and completing the fields.

1. Schedule Console to purge the data now or at a later date.

*  Run now: Back up the database immediately.
* Run later: Specify a time in the future or configure a repeating purge operation.
2. Select time frame of data to purge.

Choose the date by entering a number and selecting day, week, or month from the drop-down menu. Make sure
the automatically updated date displayed next to the drop-down menu is the desired day before proceeding.
3. Choose the type of transfers to include.

Select All closed transfers or choose from the following list:

* All successful transfers
» All cancelled transfers
» All error transfers

* All inactive transfers

* All zero-byte transfers
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4. Save the data being purged for archiving purposes.
Select Save data being purged? and enter the desired absolute path into the Save to field (for example, /tmp/
data or D:\data\). The purged data will then be stored in the file purged_data.sql in the directory: [absolute
path]\console purge YYYY-MM-DD hhmmss\.
Tip: Saved purged data can be restored by following the instructions in Restoring Purged Data on page 107.

5. When finished, click the Purge Now or Schedule Purge button (depending on whether you selected Run now or
Run later above).

Restoring Purged Data

To restore purged data, you can run a MySQL data import (as shown below).

asctl console:stop

cd "C:\Program Files (x86)\Common Files\Aspera\Common\mysqgl\bin"

mysgl -uUSERNAME -pPASSWORD aspera console < C:\path\to\purged data.sqgl
asctl console:start

vV V V V

Troubleshooting Console

Updating your Console License

IBM Aspera Console requires a valid license key before you can configure users and send or receive packages. If your
Console license has expired or cannot be found, the Console login screen displays the following message:

Console license not found
Only admin logins permitted until this problem is resolved.

Aspera Console Login

Username

Password

sSword

[+¥]
T3]

An administrator must update the license before any other usage of Console is allowed for any user, including the
administrator.

The license can be updated in the Console web Ul or by running a rake task on the computer where Console is
installed.
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From the GUI:

1. Login with an administrator account and go to Configuration > License.
2. Click Upload a license file or paste the license text into the text window.
3. Click Save.

From the Command Line (Rake task):

1. Set the license text as an environment variable.

> set LICENSE TEXT='<ASPERA LICENSE> <DETAILS expiration date=... </KEY>
</ASPERA LICENSE>'

In this example, only part of the license text is shown. You must paste the entire license text for the license to be
valid.
2. Update the Aspera license:

> asctl console:rake aspera:update license

Restart Console Services

If Console is not working properly, it is recommended you restart the Console service utilizing the asct1 command,
so that Apache and MySQL continue to run uninterrupted. If the Console server's MySQL service is stopped, then
Aspera Central will need to be restarted on all nodes to re-establish a connection.

To view the services that Console has installed on your Windows system, go to Control Panel > Administrative
Tools > Services.

Service Description

Apache HTTPD Server Apache Server for Aspera Console.
(Aspera)

Aspera Console Aspera Console main application.

MySQL Server (Aspera) MySQL Database for Aspera Console.

Right-click any of these services select Restart from the menu.

Execute the following asct1 command to restart Console (while keeping Apache and MySQL running):
> asctl console:restart

For more asctl commands, see asctl Command Reference on page 121

Resetting Console Admin Password

Run the following asct/ command, replacing name with your existing admin login, email with the current admin email
address, and password with the new admin password:

> asctl console:admin user name email password
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Encrypting and Decrypting Database.yml

The database. yml file contains passwords to Console components including its MySQL database. Console
automatically encrypts these passwords so that they are not stored in plain text. Console also supports two rake tasks
to encrypt or decrypt all passwords in the file.

If you made manual changes to the database. yml file, you can run the following command to encrypt all
unencrypted passwords:

> asctl console:rake aspera:db:encrypt database passwords

If you want to see the passwords in plain text, you can run the following command to decrypt all encrypted
passwords:

> asctl console:rake aspera:db:decrypt database passwords

Log Files
Console's log files are located in the following directories:
OS Version Path
32-bit Windows » Console: C:\Program Files\Aspera\Management Console\log\

+ asctl: C:\Program Files\Common Files\Aspera\Common\asctl\
*  MySQL: C:\Program Files\Common Files\Aspera\Common\mysql\data\mysqld.log
* Apache: C:\Program Files\Common Files\Aspera\Common\apache\logs\

64-bit Windows + Console: C:\Program Files (x86)\Aspera\Management Console\log\

+ asctl: C:\Program Files (x86)\Common Files\Aspera\Common\asctl\

*  MySQL: C:\Program Files (x86)\Common Files\Aspera\Common\mysql\data
\mysqld.log

* Apache: C:\Program Files (x86)\Common Files\Aspera\Common\apache\logs\

In Console's Apache HTTP server logs directory, you will find the following files:
» access_log

» error_log

* ssl access_log

» ssl error log

* ssl request_log

Important: All Apache logs are, by default, rotated by size (defaulting to 10MB files and only retaining the last 10
rotated logs).

httpd_template_windows.conf
/opt/aspera/common/apache/conf/httpd template windows.conf

» ErrorLog "|${log_path}bin/asrotatelogs ${log path}logs/error log 10M 10"
* CustomLog "|${log_path}bin/asrotatelogs ${log_path}logs/access _log 10M 10" common



httpd-ssl_template.conf
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/opt/aspera/common/apache/conf/extra/httpd-ssl template.conf

» ErrorLog "|${log_path}bin/asrotatelogs ${log path}logs/ssl error log 10M 10"
» TransferLog "|${log_path}bin/asrotatelogs ${log path}logs/ssl access log 10M 10"

» CustomLog "[${log path}bin/asrotatelogs ${log path}logs/ssl request log 10M 10" "%t %h
%{SSL_PROTOCOL}x %{SSL CIPHER}x \"%r\" %b"

You can further configure Console's Apache log settings by running the following commands in a Command Prompt
(Start > All Programs > Accessories > Command Prompt):

Setting

Command

Specify an Apache log level (for
example, error level)

> asctl apache:log level error

Enable Apache log (set to notice)

> asctl apache:enable logs

Disable Apache log (set to emerg
level)

> asctl apache:disable logs

Locate Configuration Files

Important: Aspera recommends that you DO NOT modify Console's configuration files manually. Instead, use
the asctl command. For additional information on utilizing asct1l commands, see the topic asctl Command

Reference on page 121.

Console's configuration files are listed below. If you plan to modify these files, Aspera encourages backing up
Console through the GUI or by using the asct/ command. The asct/ command is limited to backing up the Console
database, while the GUI backs up the database, as well as all files required to fully restore the system. For instructions
on backing up Console through the GUI, please see Backing Up Console with the Web UI on page 100. To back up
Console's database using the asct/ command, please see Back Up Console with asctl on page 100.

Component Configuration File Path

Apache *  (32-bit) C:\Program Files\Common Files\Aspera\Common\apache\conflapache.conf
*  (64-bit) C:\Program Files (x86)\Common Files\Aspera\Common\apache\conflapache.conf

MySQL *  (32-bit) C:\Program Files\Common Files\Aspera\Common\mysql\my.conf
*  (64-bit) C:\Program Files (x86)\Common Files\Aspera\Common\mysql\my.conf

Console *  (32-bit) C:\Program Files\Aspera\Management Console\config\*.yml
*  (64-bit) C:\Program Files (x86)\Aspera\Management Console\config\*.yml

Appendix

Configuring Console Defaults

The Console Defaults configuration page lets you to set up system defaults for Console, such as IP address and SSH
timeout), as well as defaults for transfers (target rate, minimum rate, bandwidth policy, and so on) and login security.
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To access the Console and Transfer Defaults configuration page, select Configuration > Defaults from the Console

menu.

Console Defaults

Item

Description

Console database IP
address

Enter the Console database IP address.

Warn when database free
space less than

The space watcher background jobs warns you when available space drops below the
set number of gigabytes. Set to zero to disable space watcher warnings.

Skip non-error transfers
older than

If a submitted transfer doesn't start after the specified number of minutes, then flag it
as having an error.

Mongrel Timeout

Enter the number of seconds to wait for a response when testing mongrels.

Node Polling Timeout

Enter the number of seconds the SOAP Poller background process waits for a response
when testing a node.

Mark Inactive Timeout

Enter the number of seconds Console waits before marking a session as inactive.

Submitted Job Timeout

Enter the number of seconds Console waits before marking a submitted Console job as
inactive.

Note: If record processing is slow, transfers can inaccurately be reported with the
error: "DB never reported session end." To work around this issue, increase the
submitted job timeout.

File Browsing Timeout

Enter the number of seconds to wait for a response from a node when browsing file
lists (over and above the SSH timeout to connect).

File Browsing Max Items

Enter the maximum number of items to retrieve from a node when browsing file lists.

Default SSH Encryption

Select the default SSH encryption algorithm for non-Console nodes.

Note: Console presents this algorithm as the standard, but you can change the
algorithm when adding a new node.

Remote Login Connection
Timeout

Enter the number of seconds Console waits before timing out when establishing a
connection to a remote server.

Remote Login Response
Timeout

Enter the number of seconds Console waits before timing out when waiting for the
remote server's response.

SSH Timeout

Enter the timeout value in seconds for the SSH connection.

SSH Tunnel Start Port

Start assigning SSH tunnel ports at the specified port number.

Advanced Search Timeout

Enter the timeout value in seconds before advanced search returns current results.

Email Notification Delay

Enter the number of seconds to wait after initiating a transfer before producing
notification emails.

Total Bandwidth Graph

Select this option to track total bandwidth usage across all notes on the Dashboard
graph.

Advanced File Search

Select this option to allow users to search the entire database for filenames when using
advanced search.

Note: This may slow down Console if your database contains a large number of files.

Email Recipients

Select this option to allow email recipients to see each other's addresses.
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Item Description

Session notifications Select this option to allow non-admins to access the session notifications page.

Smart Transfer Start
Permissions

Select this option to allow users whose transfer path includes "Any" or addresses
without a username to start any matching smart transfer that is shared and uses non-
personal endpoints. For example, userA is authorized to use a transfer path that has
one endpoint set to 10.0.123.45 and the other set to "Any". If userB's shared smart
transfer is set up with non-personal endpoints on 10.0.123.45 (source) and 10.0.111.11
(destination), it will appear in userA's smart transfers list and can be started by userA.

Smart Transfer Sharing Select this option to allow users to share smart transfers with personal logins.

Smart Transfer Editing Select this option to allow administrators to edit each other's smart transfers.

Failover / Load balancing | Select Failover + Load balancing for Console to use the least busy node(s) first. For

Behavior more information, see Configure Failover Groups on page 66.

Watchfolders Enable the watchfolder feature in Console.

Watchfolders per page Configure the number of watch folders to display per page when browsing configured
watch folders.

Proxy Select this option to turn on the proxy. This feature enables Console to remotely

browse nodes when Console is prohibited from making SSH connections to public IP
addresses.

Proxy: Address

Enter the IP address of the proxy.

Proxy: Port

Enter the port number for the proxy.

Proxy: Use SSL

Select this option to use SSL with your proxy.

Proxy: Login

Enter the login for the proxy user.

Proxy: Password

Enter the password for the proxy user.

Transfer Defaults

Item

Description

Target Rate

Set the default target rate.

Minimum Rate

Set the minimum rate.

Bandwidth Policy

Set the default transfer policy (choose among low, high, fair, and fixed).

Max. Retry Attempts

Set the maximum retry attempts.

Retry Interval Set the retry interval in seconds.
Transport Encryption Select between not-encrypted or aes-128 encryption.
File Compare Type Select a file comparison type to verify transferred files.

File Overwrite Policy

Select an overwrite policy.

Report Generation

Item

Description

Retention Period

The number of days to keep generated reports before deleting them automatically.
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Item

Description

Maximum Email
Attachment Size

The maximum size in megabytes of CSV/XLSX files that may be sent by email.
(Generated files can still be downloaded from the Reports page.)

File Maximum Data
Length

The maximum size in megabytes of the result table for which CSV/XLSX files may
be generated. (CSV/XLSX files are not generated if the result table is larger than this.)
This setting is useful for preventing Console from trying to convert a giant data set
into a file and running out of disk space.

Maximum XLS file rows

The maximum number of rows allowed for generated XLS files.

Security

Item

Description

Session Timeout

Sessions will timeout after the specified number of minutes of inactivity.

Deactivate Users

Deactivate a Console user if there has been "X" failed login attempts within "X"
minutes.

Prevent concurrent login

If this checkbox is enabled, users can only be logged in from one client at a time.

Suppress logging of
transfer tokens

Select this option to suppress tokens from being written to the database. Existing
tokens already in the database are unaffected.

Note: After enabling this feature, you may experience some lag before the setting
takes effect if a request is already in progress and the node is taking a long time to

reply.

Console Password Options

Item

Description

Password Expiration

Select this option to expire number of days

Password Duration

Enter the number of days before passwords expire. Setting the value to 0 will disable
this feature.

Password Reuse Limit

Enter the number of passwords users need to go through before they can reuse an old
password. Setting the value to 0 disables this feature.

Password Requirement
Regular Expression

Enter a regular expression to specify password requirements. Leave blank to set no
requirements.

Note: You can select the Restore Default link to reset the password requirement to
the following: "Passwords must be at least six characters long, with at least one letter,
one number, and one symbol."

Password Requirement
Message

Set a message describing the password requirements for users setting a new password.

Empty sessions (successfully completed with 0 bytes transferred)

A zero-byte transfer occurs when an Aspera product initiates a transfer but finds that the file already exists at
the destination and that there are no changes between the source file and the file at the destination. If Console is
monitoring the transfer, it marks the transfer as a success and records that zero bytes were transferred.

Nodes using hot folders regularly make these successful, zero-byte transfer sessions, and Console logs each one in
its database. One workaround is to use Aspera Watch Folders instead of hot folders. Watch Folders only attempts to




| Appendix | 114

transfer a file when there is a change between the source and destination. For requirements and information on Watch
Folders, see Creating a Watch Folder in Console on page 70.

You can also configure Console to mark zero-byte transfers for deletion by the DatabaseIngest background job.

Note: Console might still display the most recent zero-byte sessions on heavy loaded systems if DatabaseIngest
job backlog is high. Once the backlog is processed, Console will not display zero-byte transfers on the dashboard.

Item Description
Leave in database Leave all zero-byte transfers in the database.
Delete if hot folder Mark for deletion zero-byte transfers initiated from hot folder sessions, leaving all

other zero-byte transfers in the database.

Delete all Mark for deletion all zero-byte sessions regardless of origin.

Understanding Space Watcher

Space watcher is a background process that checks the amount of free space in the database and gives warning when
space is running low.

Space Watcher Functionality
Once a minute, space watcher runs a 1s or dir command, then writes the free space in bytes to a table named
aspera_db_disk_space_free. The exact command it executes is:

dir /-C "aspera console db directory path"

It only writes one record, always with "id=1". The aspera_db_disk_space_free table will never have more than one
record in it. This table only has three fields:

Field Value
id Always equal to 1.
bytes_free BIGINT, max value = 9223372036854775807, which is

approximately 8191 petabytes

last_reported_at The time space watcher last stored an entry in the table.

If the process fails to figure out free space for any reason or fails to connect to MySQL, it does nothing and logs
nothing. Successful or not, it then closes its connection and then sleeps for a minute before repeating the process.

Space Watcher Messages in Console

Unless warnings have been disabled (by setting the warning threshold to zero), Console checks the

aspera_db_disk space_free table when rendering a page. If it sees that there are no records in the table, or that it
has been longer than 10 minutes since space watcher last reported, Console displays the following message at the top
of the page: "WARNING: No recent data from database free space watcher". If the last entry is recent (within
10 minutes) but the number of free bytes is less than the configured warning level (default: 10 gigabytes), it shows a
message such as the following: "WARNING: Database free space low (7.5 GB remaining)".
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Working with Tags

Tags in Aspera products are JSON (JavaScript Object Notation) strings. Console uses tags to identify transfers and to
label Console-initiated transfers. You can find a specific transfer's tags by navigating to a transfer's Session Details
page and selecting the Session ID link under the Session State column.

Tags are used in the following tasks:

* Creating simple transfers.

* Creating and starting smart transfers.

» Creating advanced rulesets to filter by tags.

* Creating custom fields with rules involving tags.
» Searching using the Advanced Search.

The JSON Match Comparison Operator

Console includes a JSON match operator in the Custom Fields and Advanced Rulesets features, which provide a
simple syntax for matching JSON formatted tags included in Aspera transfers. Below are examples of transfer tags in
Console and Faspex transfers and instructions for matching them using the JSON match operator.

Console Transfers

A Console transfer is defined as any transfer initiated by Console using simple or smart transfers. Tags can be
specified in both simple and smart transfers. A Console transfer tag is formatted in the following way:

{"aspera™:
{"console":
{"user specified"
{"keyl":"vall", .. , "key3":"val3"}
}

}
An example of a corresponding JSON match value is shown below:
[aspera] [console] [user specified] [keyl]vall
Faspex Transfer
A Faspex Transfer is any transfer initiated by Faspex. A Faspex transfer tag is formatted in the following way:
{"aspera":
{"faspex":
{ "keyl":"vall", .., "key3":"val3"}
}
}
The corresponding JSON match value is shown below:

[aspera] [faspex] [keyl]vall

Note: It is recommended to use the Faspex Metadata filter for Faspex transfers instead. See Basic Report Example:
Faspex Metadata on page 196 for more information on Faspex Metadata.
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Regular Expressions in JSON Matches
You can also use regular expressions in a JSON match. Define the regular expression using forward slashes (/) like
in the example below:

[aspera] [console] [user specified]/+./
Important: Aspera advises against using regular expressions in keys, because the result will be the first value that
matches the regular expression. In the example below, Console will return the first Faspex transfer it hits without

backtracking to check for other transfers that meet the requirements.

[asperal [faspex] [/+./1/.+/

Configure Background Processes

The Background Processes configuration page displays all Console processes and allows you to perform the
following tasks:

* View a process log

» Edit a process

» Stop a process (although this is not available for all processes)

* Restart a process (although this is not available for all processes)

To access the Background Processes page, select Configuration > Background from the Console menu.
The following background processes can be accessed from the table:

» Controller

* Mongrel Manager

» Database Ingest

» Session Data Collector

* Node Info Collector

» File Data Collector

» Data Canonicalizer

* Custom Field

» Database Utility

* Transfer Initiator

* Email

* Report

To modify the settings for a given process, click the edit link in the corresponding table row. After clicking edit, the
Editing Background Process page appears, along with the following options:

Options Description

Startup type Select the way that the background process starts (that is, manually or automatically)
or disable the process from starting altogether.

Log level Select the preferred level of logging for the log file output to control the verbosity of
the log file output). Choose debug, info, warn, error or fatal.

Batch Size (Not available for all processes) Input the number of rows to process each work
interval.

Daily restart time (Not available for all processes) Input the time of day to restart the process in 24-hour

(HH:MM) time, UTC. Leave blank for no auto-restart.

Sleep Interval Input the sleep interval time in seconds.
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Options Description

Maximum Startup Interval | Input a time (in seconds) that must elapse before the given process is assumed to be

hanging.
Maximum Heartbeat Input a time (in seconds) that must elapse between heartbeats before the given process
Interval is assumed to be hanging.

Configure the Apache HTTP Server

You may configure Console's Apache HTTP Server to use a different host name, communication port, and namespace
using asctl commands.

Change the Number of Mongrel servers
By default, Console opens four mongrel servers. To change it, for example, from the default (4) to 10, use the
following command:

> asctl console:mongrel count 10
Update the Hostname
During the installation, you should have configured the Console's hostname. Use this command to print the current
hostname:
> asctl apache:hostname
To change the hostname, use the following command. Replace HOSTNAME with the new hostname:

> asctl apache:hostname HOSTNAME

Important: When changing the hostname, the server's SSL certificate should be regenerated. Select (y) when
prompted to generate a new SSL certificate.

When the hostname is updated, advise your clients of the new URL. In this example, use the following address:

http://HOSTNAME/aspera/console

Change HTTP and HTTPS ports
By default, Console's web servers are running on TCP/80 (HTTP) and TCP/443 (HTTPS). Use the following
commands to update these ports (where, in this example, we TCP/7080 for HTTP and TCP/7443 for HTTPS):

Item Command

HTTP
> asctl apache:http port 7080

HTTPS
> asctl apache:https port 7443

Change Console namespace
Console uses the namespace /aspera/console by default. Use this command to print the current namespace:

> asctl console:uri namespace



| Appendix | 118

To set the namespace to, for example, /console, use the following command:
> asctl console:uri namespace /console

When the namespace is updated, advise your client of the new URL. For example, if your Console server's address is
10.0.0.10, use this URL:
https://10.0.0.10/console

Note: Refer to asctl Command Reference on page 121 for a complete asctl command reference.

The Aspera Service Account

The Aspera service account runs services for Aspera products, including:

* Aspera Console
» Aspera DB Space Watcher
* Apache HTTPD Server (Aspera)

By default, the user name is svcAspera.

A local account (such as the default svcAspera) is all that is required to run Aspera services if your machine is
not joined to a Windows domain. If your machine is joined to a domain, if you need to provision Active Directory
accounts, or if transfer users store files remotely, see the following table for the type of service account to use:

Requirement Type of Service Account User

Provision local transfer users only. Local account. Domain account with local admin
privileges can be used, but is not required.

Provision Active Directory accounts for transfer Domain account with local admin privileges.
users (users who wish to transfer with your server are
authenticated through Active Directory).

Transfer users store files on a remote file system (not on | Domain account with local admin privileges.

your server machine), such as an SMB file share. Additional actions may required. Please see the aspera
knowledgebase or contact your Aspera account manager
for assistance.

Local Accounts

If a local account does not already exist, enter new credentials and click Next. If the account already exists (for
example, if it was created for the previous installation), enter the account password and click Next. If the existing
user's password you have entered is incorrect, or you wish to change the Aspera service user, see Managing the
Aspera Service Account on page 118.

Domain Accounts

If the server is configured to accept a domain user login, use a domain account that has been added to the local
administrator's group to run the services. You must create this domain account in your Domain Controller first. The
username for a domain account must be in the form usernameQfully.qualified.domain.name.

Managing the Aspera Service Account

On Windows, the Aspera service account is special user account that is used to run services for Aspera products.


https://support.asperasoft.com/categories/20004723_aspera_knowledgebase
https://support.asperasoft.com/categories/20004723_aspera_knowledgebase
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Update the Aspera Service Account Password

During installation, you were prompted to create a new Aspera service account or add an existing user account for
this purpose. If you have problems entering the credentials for the existing Aspera service account, change the user
password.

Note: You must have administrative credentials to change the password of the Aspera service account.

1. Open the Windows User Accounts management tool (Start > Control Panel > User Accounts).
2. Click the user name of the Aspera service account.

3. Click Change your password and follow the onscreen instructions.

Change the Aspera Service Account

1. Open the Windows Services management tool (Start > Control Panel > Services).
2. Right-click the name of the service (for example, Aspera Central) and click Properties.
3. Click the Log On tab and edit the information for This account.

Aspera Central Properties (Local Computer) @
| General | Log On | Recoveny | Dependenciesl
Log on as:

i) Local System account
Allow service to interact with deskdop

@ This account: ‘\svchspera

PESSWDFI:I: SRR RERRRBRRERED

Confirm password: TITITIITIIIIIY

Help me corfigure user accourt log on options.

QK ] [ Cancel Apply
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You can change the Aspera service account from the default account (svcAspera) to a Managed Service Account
(MSA).

The Aspera service account runs services for Aspera products, including:

Aspera Console
Aspera HTTPD Service
Aspera DB Space Watcher

Note: For more information on MSA, see the Microsoft article: Managed Service Accounts: Understanding,
Implementing, Best Practices, and Troubleshooting.

To use a MSA with Console, do the following:

1.
2.

Start PowerShell.
Create an MSA in Active Directory.

PS> Import-Module ActiveDirectory

PS> New-ADServiceAccount —-name serviceAccountName -enabled S$Strue

In Active Directory, associate the MSA with the Console server.

PS> Add-ADComputerServiceAccount -identity Console server name -

serviceaccount serviceAccountName

On the Console server, open the Server Manager and enable the following features:

* Active Directory Module for Windows PowerShell
* .NET Framework 3.5.1+

5. Start PowerShell.
6. Install the MSA on the Console server.

PS> Import-Module ActiveDirectory
PS> Install-ADServiceAccount -identity

Stop the following services:

» Aspera Console
» Aspera HTTPD Service
* Aspera DB Space Watcher

servi ce _accoun t_name

Grant "Full control" permissions to the MSA for the following folders:

* C:\Program Files (x86)\Aspera\Management Console

* C:\Program Files (x86)\Common Files\Aspera\Common

For each of the folders listed above, do the following:

a) Right-click the folder and select Properties > Security.
b) Click Edit > Add.

¢) Inthe Select Users or Groups window, set the following properties:

Field Value
Object type Service Accounts
Location active_directory _domain\Managed Service

Account

Object names

service_account name



https://blogs.technet.microsoft.com/askds/2009/09/10/managed-service-accounts-understanding-implementing-best-practices-and-troubleshooting/
https://blogs.technet.microsoft.com/askds/2009/09/10/managed-service-accounts-understanding-implementing-best-practices-and-troubleshooting/
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d) Click OK.
9. Change the following services to log in with the MSA account:

* Aspera Console
» Aspera HTTPD Service
* Aspera DB Space Watcher

For each of the above services, do the following:

a) Right-click the service and select Properties > Log On.
b) Set This account: to the domain name of your MSA.
For example, if your MSA was called “AspDS” in the “asperasoft.com” domain, the name would be
asperasoftl\aspdss.
c) Click Apply.
10. Restart the following services:

» Aspera Console
* Aspera HTTPD Service
* Aspera DB Space Watcher

asctl Command Reference

You can use asctl commands in a Command window to display or modify IBM Aspera Console's component
settings. Console configuration options that can be modified using asctl are listed below. If there are modifications
that cannot be accomplished with asct1, notify Aspera Support.

Important: You must be an admin to run asct1. Right click the Command window and select Run as

administrator.
Component Description
Apache Apache web server.
Console Console main application.
MySQL MySQL database.

All components commands

Important: The commands in this section control all Console components.

Task Command Description

Show config info

asctl all:info

Print info about all components.

Restart all components

asctl all:restart

Restart all components.

Setup status

asctl all:setup_status

Information about configuring all
components.

Start asctl all:start Start all components.

Show status asctl all:status Display the status of each
component.

Stop asctl all:stop Stop all components.

Show version

asctl all:version

Display the current version of each
component.
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Task

Command

Additional Information

Create a setup file

asctl apache:create_setup_file file

Create a reusable file that contains
answers to the setup questions.
Replace file with a file name.

Disable Apache

asctl apache:disable

Disable the Aspera Apache server.
When disabled, the service will not
start when rebooting computer, does
not print reminders or update its
configurations.

Disable Apache logs

asctl apache:disable logs

Set the Apache's log level to 'emerg'.

Enable Apache logs

asctl apache:enable logs

Set the Apache's log level to 'notice'.

Re-generate conf

asctl apache:generate config

Generate the component's
configuration file using the current
settings.

Display hostname asctl apache:hostname Display the hostname or IP address
of the server.

Change hostname asctl apache:hostname host Change the hostname or IP address
of the server. Replace host with a
new hostname or IP address.

Display HTTP port asctl apache:http_port Display the HTTP port the web
server listens to.

Change HTTP port asctl apache:http _port port Change the HTTP port the web
server listens to. Replace port with a
new port number.

Display HTTPS port asctl apache:https_port Display the HTTPS port the web
server listens to.

Change HTTPS port asctl apache:https_port port Change the HTTPS port the web

server listens to. Replace port with a
new port number.

Show config info

asctl apache:info

Print configuration info about
Apache.

Copy your SSL files into the Aspera
default location (under default
names)

asctl apache:install_ssl cert cert file

key_file [chain_file]

After upgrading Faspex and
Common, use this command to copy
your original SSL certificate, key
and optional chain file to /opt/
aspera/common/apache/conf
and give them Aspera-standard
names. The httpd-ssl.conf file
is also re-rendered and permissions/
ownership is set for the cert files.

Set Apache log level

asctl apache:log_level option

Specify the Apache's log level.
Replace option with crit, error,
warn, notice, info or debug.
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Task

Command

Additional Information

Create SSL certificate

asctl apache:make ssl cert hostname

Create a self-signed SSL certificate
for the specified hostname. Replace
hostname with your hostname.

Restart Apache

asctl apache:restart

Configure Apache

asctl apache:setup

Configure Apache using saved file

asctl apache:setup from_file
filename

Run setup using the answers
from a file created using the
"create _setup_file" command.

Start Apache

asctl apache:start

Show Apache status

asctl apache:status

Stop Apache

asctl apache:stop

Upgrade Apache

asctl apache:upgrade

Show Apache's version

asctl apache:version

Console

Task

Command

Description

Create or update admin

asctl console:admin_user login email
[password]

Create a new admin, or update

an existing admin account.

Replace login with a login, email
with its email. You can add the
account's password in the command
(/password]), or enter it when
prompted. If the login you have
entered exists, the account is updated
with new email and password.

Backup database

asctl console:backup_database dir

Backup Console database and
associate files to the specified
directory. Replace dir with a path to
store the backup.

Display base port

asctl console:base port

Display the base port of the
mongrels.

Change base port

asctl console:base_port [arg]/

Change the base port of the
mongrels. Replace [arg] with the
new base port number.

Create setup file

asctl console:create_setup_file file

Create a reusable file that contains
answers to the setup questions.
Replace file with a file name.

Disable Console

asctl console:disable

Disable Console. When disabled, the
service will not start when rebooting
computer, does not print reminders or
update its configurations.

Re-generate conf

asctl console:generate config

Generate Console component's
configuration file using the current
settings.
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Task Command Description
Config info asctl console:info Print Console configuration info.
Update database asctl console:migrate_database Update database to the latest schema.

Display mongrel count

asctl console:mongrel count

Display the number of mongrels to
spawn.

Change mongrel count

asctl console:mongrel count arg

Change the number of mongrels to
spawn. Replace arg with a number.

Rake command

asctl console:rake arg

Evoke a rake command.

Restart Console

asctl console:restart

Restart mongrel web servers and all
background processes.

Restore config and data

asctl console:restore dir

Restore Console database and
configuration from a backup
directory.

Restore database

asctl console:restore_database dir

Restore Console database from a
backup directory.

Configure Console component

asctl console:setup

Configure this component.

Configure Console using saved file

asctl console:setup from_file file

Run setup using the answers
from a file created using the
"create_setup_file" command.

Start Console

asctl console:start

Starts mongrel web servers and all
background processes.

Show Console status

asctl console:status

Display Console status.

Stop Console

asctl console:stop

Stops mongrel web servers and all
background processes.

Upgrade

asctl console:upgrade

Upgrade Console from a previous
version.

Display namespace

asctl console:uri_namespace

Display Console's URL namespace.

Change namespace

asctl console:uri_namespace arg

Change Console's URL namespace.
Replace arg with the new
namespace.

Show Console's version

asctl console:version

Display the currently set up version.

Generate email templates

asctl
console:generate_email templates

Recreate email template files.

MySQL

Task

Command

Description

Create setup file

asctl mysql:create_setup_file file

Create a reusable file that contains
answers to the setup questions.
Replace file with a file name.

Display database directory

asctl mysql:data_dir

Display the directory that the
databases are kept in.
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Task

Command

Description

Disable MySQL

asctl mysql:disable

Disable the Aspera MySQL. When
disabled, the service will not start
when rebooting computer, does
not print reminders or update its
configurations.

Grant access on MySQL-only server

asctl mysql:grant_remote access
host mysql_user password

If MySQL server is running on

a different computer, use this
command on the MySQL machine

to allow access from the specified
machine. Replace host, mysql_user
and mysql_password with the server's
hostname, MySQL's user name, and
the user's password, respectively.

Show config info

asctl mysql:info

Print configuration info about
MySQL.

Show port asctl mysql:port Display the port the MySQL server
listens to.

Change port asctl mysql:port port Change the port the MySQL server
listens to. Replace port with a new
port number.

Restart MySQL asctl mysql:restart Restart the Aspera MySQL.

Set root password

asctl mysql:set root password

Set the password for 'root' in
MySQL.

Configure MySQL-only server

asctl mysql:setup

If MySQL server is running on

a different computer, use this
command on the MySQL machine to
configure it.

Configure MySQL using saved file

asctl mysql:setup from_file file

Run setup using the answers
from a file created using the
"create_setup_file" command.

Start MySQL asctl mysql:start Start the Aspera MySQL.
Show MySQL status asctl mysql:status Display the Aspera MySQL status.
Stop MySQL asctl mysql:stop Stop the Aspera MySQL.

Upgrade MySQL-only server

asctl mysql:upgrade

If MySQL server is running on

a different computer, use this
command on the MySQL machine to
upgrade the database.

Show MySQL's version

asctl mysql:version

Display the currently set up version.

Advanced Search

Search
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You can search for a transfer from any page in IBM Aspera Console by using the search bar in the top right corner of
the page. If you want to refine your search, you can access the Advanced Search dialog by selecting the blue drop-

down arrow next to the search bar.

Advanced Search

Transfer Name:
Contact:

SSH User:
Session 1D:

File Name Start:
Source Path:

Destination Path:

Mode: =MNode Name=
Tags:
Fram: 10222015 03:559 PM
To: 102372015 03:558 PM
Status: All v
Fesults: 10 v
Clear Form
Filter Description

Transfer Name

Include transfers with this name

Contact Include transfers initiated by this user.
SSH User Include transfers involving this SSH user.
Session ID Include transfers with this unique session ID

File Name Start

Include transfers with files that start with this string.

Source Path

Include transfers with files that originated from this
location.

Destination Path Include transfers with files transferred to this location.

Node Include transfers involving this selected node or this
node IP address.

From Include transfers started from this date and onwards.
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Filter Description

To Include transfers from this date and onwards.

Status Include transfers with the current state designated:
*  Active

+  Completed
e Cancelled
¢ Error

Results The number of results you want Console to display.

Setting Up the Console Environment

Setup Example #1: Monitoring Transfers with Another Organization

This example shows how to create a user group that can monitor all transfers between your organization and a partner
organization. The configuration in this example uses the following values:

» Partner node address: 10.0.0.0
* Console user: partner-1-staff (non-admin)

1. Add the partner's node as an unmanaged node, and add an endpoint.

To do so, go to Nodes from the Console menu, click List Unmanaged Nodes > New Unmanaged Node.
Enter the partner node's information. You can add the partner's node as an unmanaged node without further
configuration.

New Unmanaged Node

List Unmanaged Nodes

= Creating New Unmanaged Node

Address 10.0.00

Name Partrer #1
limit 100 characters

SSH Port 22

SSH Encryption AES256-ctr g

2. Create a new endpoint with saved login information.

The addition of a new node creates an endpoint in Console with a wildcard (*@10.0.0.0). Wildcard endpoints
require a user to enter login credentials every time the user uses it for a transfer. To create an endpoint with saved
login credentials, go to the Endpoints tab and click Add Endpoint. Enter the login credentials for a user on the
node and click Create.
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Unmanaged Nodes

B Partner #1(10.0.0.0)

Details Map Queueing Endpoints

= New Endpoint

Name Partner #1
descriptive name for this endpoint

Login partner_login

~ Use SSH Key

Password

Password confirmation ||

Email Notifications
Email address m

EMAIL ADDRESS ON START ON SUCCESS ON ERROR

For more information on the actions listed in this step, see Adding Unmanaged Nodes on page 31.
3. Create a group with permission to monitors transfers with the partner's node.

Go to Groups from the Console menu and click New Group. In the Create New Group page, enter the group's
name and description. Click Create when finished.

Users Groups  Directories SAML  Accesslog  New Group

= Creating New Group

MName Monitor transfers with Partner #1
limit 45 characters

. o1 Permissions to monitor transfers with the
Description partner_login@10.0.0.0 endpoint.
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When the group is created, select Transfer Path > Add Path. The following is an example of the Transfer Path

settings:

Users Groups Directories SAML Access Log New Path for 'Monitor transfers with Partner #1'

» New Transfer Path

Endpoint 1
Direction

Endpoint 2

Group permissions

Description

Partner #1 {10.0.0.0) u
to / from a
Any a

Soictai

Start Simple Transfers

Start Smart Transfers

Create Smart Transfers

Share Smart Transfers

Control Transfers started by others
View Transfers started by others
Opt-in to email notifications
’Monitor transfers with Partner #1]

Back to Edit Group

Field Description

Endpointl Choose the Partner's node or endpoint.

Direction Set to / from for inbound and outbound transfers.
Endpoint2 Choose Any so that users can make transfers with any node.

Group permissions

Check these options:

* View transfers started by others
*  Opt-in to email notifications

Click Create.

For more information on the tasks listed in this step, see Creating Console Groups on page 41.

4. Create a Console user and add it to the group.

To create a user account to monitor the transfers, go to Users from the Console menu and click New User. Fill out
the form and click Create.
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Users  Groups  Directories  SAML  Access Log  New User

» User Information

Login partner-1-staff
limit 40 characters
First name Partner 1
Last name Staff
Email group1@partneri.com
Time zone (GMT-08:00) Pacific Time {US & Canada) E

Set password

If unchecked, user will be sent a temporary password via email upon account creation

Password perens

Confirm Password

= Permissions

Active (allow user to login)
Reports Allowed

Console Administrator

5. Assign the user to the group.
In the User Maintenance page's Groups tab, select the group from the drop menu and click Add.

Users  Groups Directories ~ SAML  Access Log  Permissions for Partner 1 Staff (partner-1-staff)

= Group Memberships

Manitor transfers with Partner #1 E Add

NAME DESCRIPTION DIRECTORY ACTIONS

When logging into Console with this user account, you can monitor all the transfers with the partner's node.
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For more information on the tasks listed in this step, see Creating Console Users on page 42.

Setup Example #2: Managing Aspera Faspex Transfers

This example shows how to monitor and control transfers on a node running IBM Aspera Faspex, a file exchange
application built upon IBM Aspera High-Speed Transfer Server for a centralized transfer solution. The configuration
in this example is as follow:

* Faspex node address: 10.0.0.0
* Console user: faspex-monitor-1
1. Add Faspex as a managed node, and create an endpoint.

Go to Nodes from the Console menu and click New Managed Node. Enter the Faspex node information and click
Create.

» Creating New Node

IP Address 10.0.0.0
cannot be a domain name

Name Faspex Server
limit 100 characters

Communication

SSH Port 22

SSH Encryption AES256-ctr Ky

Node API Port 9092
Default: 9091 for hitp, 9092 for https

Use HTTPS to connect to node (recommended)

~ Require signed SSL certificate

Failover

_ Enable failover and load balancing for Console-initiated transfers on this node

All nodes with the same failover group name must have the same user accounts and docroot paths
Failover Group Name (none) v
Other

Create default Console groups

Important: If you wish to configure the Faspex node transfer settings using Console, go to the Node
Maintenance page, select the Credentials tab, and enter the SSH login.

When the node is added, go to the Endpoints tab and click Add Endpeint. Enter Faspex in the Login field, leave
password fields blank. When finished, click Create.
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= New Endpoint

Name Faspex
descriptive name for this endpoint

Login faspex_server

| Use SSH Key

Password

Password confirmation

Email Notifications

Email address m

EMAIL ADDRESS ON START ON SUCCESS ON ERROR

For more information on the tasks listed in this step, see xfer user/projectlsvcAspera.

2. Create a group with the proper permissions.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.

Users  Groups  Directories SAML  Access Log  New Group

= Creating New Group

Name Faspex Monitors
limit 45 characters

Description Et:::ﬁr and control transfers on the Faspex

When the group is created in the Group Maintenance page, go to the Transfer Paths tab and click Add Path. Use
the following settings for this Transfer Path (change the Faspex node address to match yours):
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Users Groups Directories SAML Access Log New Path for 'Faspex Monitors'

= New Transfer Path

Back to Edit Group

Endpoint 1 faspex_server (10.0.0.0) H
Direction to /from g
Endpoint 2 Any <)

Group permissions Select all

Start Simple Transfers

(< <

Start Smart Transfers

<]

Create Smart Transfers

<]

Share Smart Transfers

Control Transfers started by others
View Transfers started by others
Opt-in to email notifications
Description Eﬁec:;itrr)r and control transfers on Faspex
Item Description
Endpointl faspex(@22.33.44.55
Direction to / from
Endpoint2 Any
Options Check these options:
* View Transfers started by others
*  Opt-in to email notifications

For more information on the tasks listed in this step, see Creating Console Groups on page 41.
3. Add users to the group.

In the Group Maintenance page, go to the Members tab, select the Console user from the menu and click Add.
When added, the Console user can monitor and control transfers on the Faspex node through Console.
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= Editing Group Details

Name Faspex Monitors
limit 45 characters

Monitor and control transfers on the Faspex

Description
server.

» Transfer Paths

TRANSFER PATH USER PERMISSIONS OTHER PERMISSIONS
START START CREATE SHARE
ENDPOINT DIRECTION ENDPOINT SMART SIMPLE SMART SMART CONTROL VIEW EMAIL
faspex_server (10.0.0.0) - Any o v o v o o o
= Members
-- Select User -- L Add
LOGIN NAME ACTIONS
faspex-monitor-1 delete

For more information on the tasks listed in this step, see Creating Console Users on page 42.

Setup Example #3: Create Groups of Different Permissions

This example shows how to assign different permissions to different project members. The configuration in this
example is as follows:

Endpointl: project@]1.2.3.4

Endpoint2: project@5.6.7.8

Userl (Project admin): adminl

User2 (Project member): memberl

Group - Project admin: All permissions between Endpointl and Endpoint2
Group - Project member: Limited permissions between Endpointl and Endpoint2

Prepare the nodes, endpoints and the Console user accounts.

* Add a managed or unmanaged node with an endpoint for transfer: project@1.2.3.4
* Add a managed or unmanaged node with an endpoint for transfer: project@5.6.7.8
* Add a Console user: adminl

* Add a Console user: memberl

For more information on the tasks listed in this step, see xfer user/projectlsvcAspera, Adding Unmanaged Nodes

on page 31, and Creating Console Users on page 42.

Create a group for the project administrator.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.
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= Creating New Group

Name Project admin
limit 45 characters

All permission between Endpoint1 and

Description Endpoint2.

In the Group Maintenance page, click the Transfer Paths tab. Enter the following information:
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Accounts

Users Groups Directories  Access Log MNew Path for 'Project admin'

= New Transfer Path

Endpoint 1 project@1.2.3.4 v
Direction to / from -
Endpoint 2 project@3.6.7.8 v

Group permissions Select all Deselect all

Start Simple Transfers

Start Smart Transfers

Create Smart Transfers

Share Smart Transfers

Control Transfers started by others
View Transfers started by others

Opt-in to email notifications

Description
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Item Description

Endpointl project@1.2.3.4

Direction to / from

Endpoint2 project@5.6.7.8

Options Select All
Click Create.

In the Group Maintenance page, go to the Members tab and add the user adminl1 into this group.

Users  Groups  Directories  Access Log  Members for Group 'Project admin'

= Members of this Group

admin 1 (admin1) -

For more information on the tasks listed in this step, see Creating Console Groups on page 41.

3. Create a group for the project members.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.

= Creating New Group

Name Project member
limit 45 characters

Restricted permission between Endpoint1

Description and Endpoint2.

In the Group Maintenance page, click the Transfer Paths tab. Enter the following information:

Item Description

Endpointl project@1.2.3.4

Direction to / from
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Item Description
Endpoint2 project@5.6.7.8
Options Check these options:

o Start Smart Transfers
* View Transfers started by others
* Opt-in to email notifications

When finished, click Create.

In the Group Maintenance page, go to the Members tab and add the user member1 into this group.

Users  Groups  Directories  Access Log  Members for Group 'Project member'

= Members of this Group

member 1 (member1) -

For more information on the tasks listed in this step, see Creating Console Groups on page 41.
4. Create a Smart Transfer template with the project admin account.

At this point, both Console users should have the proper permissions. Use the project admin account (admin1) to
create a Smart Transfer template.

New Smart Transfer

Description

Transfer name
Endpoint1 -> Endpoint2

share this smart transfer

[l Allow changes to transfer settings at submit time

When the user admin1 creates and share a Smart Transfer template, member1 will be able to execute the Smart
Transfer template.
For more information on the tasks listed in this step, see Sharing a Smart Transfer on page 62
5. Execute the Smart Transfer with the project member account.
The Project member group, which has the same Transfer Path as the Project admin group, has access to the

shared Smart Transfer templates. Go to Transfer from the Console menu, the Project member will see the Smart
Transfer template listed in the Saved Smart Transfers table.
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Email Template Examples

Email Template Example: Creating a Simple Notification for a Successful Transfer

The following example shows how to create an email template that notifies a user of a successful transfer with
minimal information.

1. Select Create new transfer success email template and then edit.

2. Name your template "Client Success Email".

3. Enter a From Name and Reply-to Address if you don't want the notification to come from the default email
address.

4. Enter a new email subject: "Client Transfer Notification - Success".

5. Click Edit Plain Template and make remove variables to limit information provided to the recipient.
For example:

Description of the Transfer: DESCRIPTION
Client Name: CONTACT

Total Bytes Transferred: BYTES TRANSFERRED
Total Time for Transfer: ELAPSED TIME
Average Transfer Rate: AVERAGE RATE

You are receiving this message because your Aspera Console preferences
are set to receive these notifications or someone else thought you
should know about this particular transfer.

The end result should look like the following:

Client #1 Transfer Notification

Description of the Transfer: TEMPLATE TEST: File from Sydney to LA
Client Name: econl (ssh)

Total Bytes Transferred: O Bytes

Total Time for Transfer: 44s

Average Transfer Rate:

You are receiving this message because your Aspera Console preferences
are set to receive these notifications or someone else thought you
should know about this particular transfer.

6. Edit HTML Template to match the information in the basic template.
The end result should look like the following:
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Client #1 Transfer Notification

Description of the Transfer: TEMPLATE
TEST: File from
Sydney to LA

Client Name: econl (ssh)

Total Bytes Transferred: 0 Bytes

Total Time for Transfer: 44s

Average Transfer Rate:

You are receiving this message because your Aspera Console preferences
are set to receive these notifications or someone else thought you should
know about this particular transfer.

7. Click the Send Test Email button to test the new email template.

Email Template Example: Adding Company Branding to Your Template

The following example shows how to create an email template that shows company branding when opened in HTML
format.

1. On the Template preview screen, click the Edit HTML Template button to modify the template's HTML code.
2. Locate the URL of your company logo. Your image must be hosted on a server that is accessible to the recipient.

3. Open the HTML Template and insert the following code in the desired location.
<IMG SRC="http://<IMAGE URL>">

In this example, we've inserted the logo into the header.

The result may look like the following:
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Description:
Started by:

Started at:

Source:

First 5 Source Paths:

Destination:

Node References

TEMPLATE TEST: File from Sydney to LA
econl (ssh)

2009-03-30 13:50:03 Pacific Time (US & Canada)

Sydney (10.0.75.201)

C:/demo files/test
C:/demo files

LA (10.0.85.108)
/home/econl/uploads

Node-Level Configuration Options

To start node configuration, go to Nodes in the Console menu. Click edit for an existing node that you wish
to configure. The server's admin credentials are required for the configuration. See Updating a Node's Admin

Credentials on page 31.

The node configuration options can be found in the Configuration tab. The following is a summarized chart for
navigating and changing values when you click on an individual section. Click Save changes when finished:

Note: Configuration at the node level will affect all user accounts and group accounts on that node performing

Aspera transfers.

Section

Configuration Details

Database

Configuring policy and logging level settings.

Transfer Server

Setting transfer server IP address and port.

HTTP Fallback Server

Enable and configure HTTP / HTTPS fallback server.
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Section Configuration Details

Docroot Setting document root and its access permissions.

Authorization Connection permissions, token key, and encryption
requirements.

Bandwidth Incoming and outgoing transfer bandwidth and policy
settings.

Advanced File Handling File handling settings, such as file block size, overwrite

rules, and exclude pattern.

Advanced Network Options

Network IP address, port, and socket buffer settings.

Database
# Field Description Values Default
1 Host IP Enter the Aspera Console server's IP address, valid IPv4 127.0.0.1
default 127.0.0.1 address
2 Port The default value for an Aspera Console Integer 4406
installation is 4406. Valid port numbers range between 1 and
between 1 and 65535. 65535
3 User User login for the database server. text string blank
4 Database Name Name of the database used to store Aspera transfer | text string blank
data.
5 Threads The number of parallel connections used for Integer 10
database logging. A higher value may be useful between 1 and
when a large number of files are being transferred |40
within a given time frame.
6 Stop Transfers on Quits all ongoing transfers and no new transfers o true false
Database Error are permitted when a database error prevents . false
data from being written to the database. Set this
to true if all transfers must be logged by your
organization.
7 Session Progress Setting this value to true will log transfer status . true true
such as number of files transferred, and bytes . false
transferred, at a given interval.
8 Session Progress The frequency at which an Aspera node logs Positive integer | 1
Interval transfer session information, up to 65535 seconds.
9 File Events Setting this value to true enables the logging of . true true
complete file paths and file names. Performance |, oo
may be improved when transferring datasets
containing thousands of files. Also see File Per
Session for setting a threshold for the number of
files to log per session.
10 File Progress Setting this value to true will log file status such . e true
as bytes transferred at a given interval. . false
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# Field Description Values Default
11 File Progress Interval The frequency at which an Aspera node logs file | Integer 1
transfer information, up to 65535 seconds. The between 1 and

default setting of 1 logging sessions every second. | 65535

12 Files Per Session The value is the cut-off point for file names Positive integer | 0
logged in a given session. For example, if the or Zero
value is set to 50, the first 50 file names will be
recorded for any session. The session will still
record the number of files transferred along with
the number of files completed, failed, or skipped.
The default setting of 0 will log all file names for
a given session.

13 Ignore Empty Files Setting this to true will block the logging of zero- . {1e false
byte files. . false
14 Ignore No-transfer Files | Setting this to true will block the logging of files |+ rye false
that have not been transferred because they exist |, ..
at the destination at the time the transfer started.
15 Rate Events Setting this to true will log changes made to e true true
the Target Rate, Minimum Rate, and Transfer . false
Policy of a transfer by any user or Aspera node
administrator during a transfer.
Transfer Server
# Field Description Values Default
1 Bind Address This is the network interface address on Valid IPv4 127.0.0.1
which the transfer server listens. The address
default value 127.0.0.1 enables the transfer
server to accept transfer requests from
the local computer. Setting the value to
0.0.0.0 allows the Aspera transfer server
to accept transfer requests on all network
interfaces for this node. Alternatively, a
specific network interface address may be
specified.
2 Bind Port The port at which the transfer server will Integer between | 40001
accept transfer requests. 1 and 65535

HTTP Fallback Server

Note: While Console can change a node's settings for HTTP fallback, Console does not support HTTP fallback for
transfers it initiates.

# Field Description Values Default

1 Cert File The absolute path to an SSL certificate file. If left | file path blank
blank, the default certificate file that came with
your Aspera Enterprise Server will be used.
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# Field Description Values Default
2 Key File The absolute path to an SSL key file. If left blank, [ file path blank
the default certificate file that came with your
Aspera Enterprise Server will be used.
3 Bind Address This is the network interface address on which valid IPv4 0.0.0.0
the HTTP Fallback Server listens. The default address
value 0.0.0.0 allows the Aspera HTTP Fallback
Server to accept transfer requests on all network
interfaces for this node. Alternatively, a specific
network interface address may be specified.
4 Restartable Transfers | Setting this to #rue allows interrupted transfers to [+ {re true
resume at the point of interruption. . false
5 Session Activity Any value greater than 0 sets the amount of Positive integer |0
Timeout time, in seconds, that the HTTP Fallback Server
will wait without any transfer activity before
canceling the transfer. Notice that this option
cannot be left at 0, otherwise interrupted HTTP
Fallback sessions will get stuck until server or
asperacentral is restarted.
6 Enable HTTP Enables the HTTP Fallback Server that allows e true false
failed UDP transfers to continue over HTTP. . false
7 HTTP Port The port on which the HTTP server listens. Valid | positive integer | 8080
port numbers range between 1 and 65535.
8 Enable HTTPS Enables the HTTPS Fallback Server that allows |+ e false
failed UDP transfers to continue over HTTPS. . false
9 HTTPS Port The port on which the HTTPS server listens. positive integer | 8443
Valid port numbers range between 1 and 65535.
Docroot
# | Field Description Values Default
1 [ Absolute Path The Absolute Path describes the area of the file file path N/A
system that is accessible by Aspera users. The
default empty value gives users access to the entire
file system.
2 [ Read Allowed Setting this to true allows users to transfer fromthe [, {7 N/A
designated area of the file system as specified by the |, false
Absolute Path value.
3 | Write Allowed Setting this to true allows users to transfer to the . true N/A
designated area of the file system as specified by the |, false
Absolute Path value.
4 | Browse Allowed Setting this to true allows users to browse the o true N/A
directory. . false
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Field

Description

Values

Default

Incoming Transfers

The default setting of allow allows users to transfer
to this computer. Setting this to deny will prevent
transfers to this computer. When set to require
token, only transfers initiated with valid tokens will
be allowed to transfer to this computer. Token-based
transfers are typically employed by web applications
such as Faspex and require a Token Encryption Key.

e allow

* deny

* require
token

allow

Incoming External
Provider URL

The value entered should be the URL of the

external authorization provider for incoming
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organizations requiring custom authorization rules.

HTTP URL

blank

Incoming External
Provider SOAP Action

The SOAP action required by the external
authorization provider for incoming transfers.
Required if External Authorization is enabled.

text string

blank

Outgoing Transfers

The default setting of allow allows users to transfer
from this computer. Setting this to deny will prevent
transfers from this computer. When set to require
token, only transfers initiated with valid tokens will
be allowed to transfer from this computer. Token-
based transfers are typically employed by web
applications such as Faspex and require a Token
Encryption Key.

o allow

* deny

* require
token

allow

Outgoing External
Provider URL

The value entered should be the URL of the

external authorization provider for outgoing
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organizations requiring custom authorization rules.

HTTP URL,
default blank

Outgoing External
Provider Soap Action

The SOAP action required by the external
authorization provider for outgoing transfers.
Required if External Authorization is enabled.

Text string

blank

Token Encryption Cipher

The cipher used to generate encrypted authorization
tokens.

e aes-128
e aes-192
e aes-256

aes-128

Token Encryption Key

This is the secret token that will be used to authorize
those transfers configured to require token.

Token generation is part of the Aspera SDK. See

the Aspera Developer's Network (Token-based
Authorization Topic) for more information.

Text string

blank

Token Life (seconds)

Sets token expiration for users of web-based transfer
applications.

Positive integer

1200

10

Encryption Allowed

Describes the type of transfer encryption accepted
by this computer. When set to any the computer

e any

any
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Field

Description

Values

Default

allows both encrypted and non-encrypted transfers.
When set to none the computer restricts transfers

to non-encrypted transfers only. When set to
aes-128 the computer restricts transfers to encrypted
transfers only.

* none
e aes-128

Bandwidth

Field

Description

Values

Default

Incoming Vlink ID

The value sets the Vlink ID for incoming transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables Vlinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to a node, group, or user. Vlink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID is a unique numeric identifier. See
Configuring Virtual Links on page 37

Pre-defined
value

0

Incoming Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for incoming
transfers. The Target Rate Cap is the maximum
target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

Incoming Target Rate
Default (Kbps)

This value represents the initial rate for incoming
transfers, in kilobits per second. Users may be
able to modify this rate in real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

Incoming Target Rate
Lock

After an incoming transfer is started, its target
rate may be modified in real time. The default
setting false gives users the ability to adjust the
transfer rate. A setting of true prevents real-time
modification of the transfer rate.

e true
« false

false

Incoming Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for incoming
transfers. The Minimum Rate Cap is a level
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

Incoming Minimum Rate
Default (Kbps)

This value represents the initial minimum rate for
incoming transfers, in kilobits per second. Users
may be able to modify this rate in real time as
allowed by the software in use. This setting is not
relevant to transfers with a Fixed policy.

Positive integer

Incoming Minimum Rate
Lock

After an incoming transfer is started, its minimum
rate may be modified in real time. The default

false
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Field

Description

Values

Default

setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed
policy.

* false

Incoming Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for incoming transfers. The default policy value
may be overridden by client applications initiating
transfers.

o fixed
* high
e fair

o low

fair

Incoming Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth Policy
for incoming transfers. Aspera transfers use fixed,
high, fair and low policies to accommodate network-
sharing requirements. When set to any, the server
will not deny any transfer based on policy setting.
When set to high, transfers with a Policy of high
and less aggressive transfer policies (such as, fair

or low) will be permitted. Fixed transfers will be
denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

« fixed
* high
e fair

« low

fair

10

Incoming Bandwidth
Policy Lock

After an incoming transfer is started, its Policy may
be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.
A setting of true prevents real-time modification of
the Policy.

* false

false

11

Outgoing Vlink ID

The value sets the Vlink ID for outgoing transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables Vlinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to a node, group, or user. Vlink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID is a unique numeric identifier. See
Configuring Virtual Links on page 37

Pre-defined
value

12

Outgoing Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for outgoing
transfers. The Target Rate Cap is the maximum
target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

13

Outgoing Target Rate
Default (Kbps)

This value represents the initial rate for outgoing
transfers, in kilobits per second. Users may be
able to modify this rate in real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

14

Outgoing Target Rate
Lock

After an outgoing transfer is started, its target
rate may be modified in real time. The default
setting of false gives users the ability to adjust the

« false

false
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Field

Description

Values

Default

transfer rate. A setting of true prevents real-time
modification of the transfer rate.

15

Outgoing Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for outgoing
transfers. The Minimum Rate Cap is a level
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

16

Outgoing Minimum Rate
Default

This value represents the initial minimum rate for
outgoing transfers, in kilobits per second. Users may
be able to modify this rate in real time as allowed
by the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

17

Outgoing Minimum Rate
Lock

After an outgoing transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed
policy.

« false

false

18

Outgoing Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for outgoing transfers. The default policy value
may be overridden by client applications initiating
transfers.

e fixed
* high
* fair

e low

fair

19

Outgoing Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth Policy
for outgoing transfers. Aspera transfers use fixed,
high, fair and low policies to accommodate network-
sharing requirements. When set to any, the server
will not deny any transfer based on policy setting.
When set to high, transfers with a Policy of high
and less aggressive transfer policies (for example,
fair or low) will be permitted. Fixed transfers will

be denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

e any
* high
e fair
 low

any

20

Outgoing Bandwidth
Policy Lock

After an outgoing transfer is started, its Policy may

be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.
A setting of true prevents real-time modification of
the Policy.

« false

false

Advanced File Handling

Field

Description

Values

Default

File Create Mode

Specify file creation mode (permissions). If
specified, create files with these permissions (for
example 0755), irrespective of File Create Grant
Mask and permissions of the file on the source

Positive integer
(octal)

undefined
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Field

Description

Values

Default

computer. Only takes effect when the server is a
non-Windows receiver.

File Create Grant Mask

Used to determine mode for newly created files

if File Create Mode is not specified. If specified,
file modes will be set to their original modes plus
the Grant Mask values. Only takes effect when the
server is a non-Windows receiver and when File
Create Mode is not specified.

Positive integer
(octal)

0644

Directory Create Mode

Specify directory creation mode (permissions). If
specified, create directories with these permissions
irrespective of Directory Create Grant Mask and
permissions of the directory on the source computer.
Only takes effect when the server is a non-Windows
receiver.

Positive integer
(octal)

undefined

Directory Create Grant
Mask

Used to determine mode for newly created

directories if Directory Create Mode is not specified.

If specified, directory modes will be set to their
original modes plus the Grant Mask values. Only
takes effect when the server is a non-Windows
receiver and when Directory Create Mode is not
specified.

Positive integer
(octal)

0755

Read Block Size (bytes)

This is a performance tuning parameter for an
Aspera sender. It represents the number of bytes an
Aspera sender reads at a time from the source disk
drive. Only takes effect when server is sender. The
default of 0 will cause the Aspera sender to use its
default internal buffer size, which may be different
for different operating systems.

Positive integer

Write Block Size (bytes)

This is a performance tuning parameter for an
Aspera receiver. Number of bytes an ascp receiver
writes data at a time onto disk drive. Only takes
effect when server is receiver. The default of 0 will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.

Positive integer

Use File Cache

This is a performance tuning parameter for an
Aspera receiver. Enable or disable per-file memory
caching at the data receiver. File level memory
caching improves data write speed on Windows
platforms in particular, but will use more memory.
We suggest using a file cache on systems that are
transferring data at speeds close to the performance
of their storage device, and disable it for systems
with very high concurrency (because memory
utilization will grow with the number of concurrent
transfers).

e true
* false

true

Max File Cache Buffer
(bytes)

This is a performance tuning parameter for an
Aspera receiver. This value corresponds to the
maximal size allocated for per-file memory cache
(see Use File Cache). Unit is bytes. The default of

Positive integer
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Field

Description

Values

Default

0 will cause the Aspera receiver to use its internal
buffer size, which may be different for different
operating systems.

Resume Suffix

Extension name of a class of special files holding
metadata information of regular data files. Useful
in the context of resuming partially completed
transfers. During resume mode (-k1/2/3), each data
file has a corresponding metadata file with the same
name and the pre-specified resume suffix.

text string

aspx

10

Preserve Attributes

Configure file creation policy. When set to none, do
not preserve the timestamp of source files. When set
to times, preserve the timestamp of the source files
at destination.

none / times

undefined

11

Overwrite

Overwrite is an Aspera server setting that
determines whether Aspera clients are allowed to
overwrite files on the server. By default it is set to
allow, meaning that clients uploading files to the
servers will be allowed to overwrite existing files
as long as file permissions allow that action. If set
to deny, clients uploading files to the server will not
be able to overwrite existing files, regardless of file
permissions.

e allow
* deny

allow

12

File Manifest

When set to text a text file "receipt" of all files
within each transfer session is generated. If set to
disable no File Manifest is created. The file manifest
is a file containing a list of everything that was
transferred in a given transfer session. The filename
of the File Manifest itself is automatically generated
based on the transfer session's unique ID. The
location where each manifest is written is specified
by the File Manifest Path value. If no File Manifest
Path is specified, the file will be generated under the
destination path at the receiver, and under the first
source path at the sender.

e text
¢ disable

none

13

File Manifest Path

Specify the location to store manifest files. Can be
an absolute path or a path relative to the transfer
user's home.

text string

blank

14

Pre-Calculate Job Size

Configure the policy of calculating total job size
before data transfer. If set to any, follow client
configurations (-o PreCalculateJobSize={yes|no}).
If set to no, disable calculating job size before
transferring. If set to yes, enable calculating job size
before transferring.

e any
e yes

any

15

Storage Rate Control

Enable/Disable disk rate control. When enabled,
adjust transfer rate according to the speed of
receiving I/O storage, if it becomes a bottleneck.

e true
* false

false

16

File checksum method

Specify the type of checksum to calculate for
transferred files. The content of transfers can be

* any

¢ shal

any
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# | Field Description Values Default
verified by comparing the checksum value at the
destination with the value read at the source.
16 | Partial Suffix Set the file suffix for partially downloaded files. .aspx
Advanced Network Options
# | Field Description Values Default
1 |Bind IP Address Specify an IP address for server-side ascp to bind Valid IPv4 blank
its UDP connection. If a valid IP address is given, address
ascp sends and receives UDP packets ONLY on the
interface corresponding to that IP address.
2 [ Bind UDP Port Specify a port number for server-side ascp to bind Positive integer | 33001
its UDP connection. This also prevents client ascp
processes from binding to same UDP port. Valid
port numbers range between 1 and 65535.
3 [ Disable Packet Batching | When set to true, send data packets back to back . true false
(no sending a batch of packets). This results in . false
smoother data traffic at a cost of higher CPU usage.
4 [ Maximum Socket Buffer | Upper bound the UDP socket buffer of an ascp Positive integer |0
(bytes) session below the input value. The default of 0 will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.
5 [ Minimum socket buffer | Set the minimum UDP socket buffer size for an ascp | Positive integer |0
(bytes) session.

Node Account-Level Configuration Options

When configuring users and groups on a node from Console, both group-level and user-level settings share the same
configuration options. This topic covers the following configuration sections:

Section Configuration Details

Docroot Setting document root and its access permissions.

Authorization Connection permissions, token key, and encryption requirements.

Bandwidth Incoming and outgoing transfer bandwidth and policy settings.

Advanced File Handling File handling settings, such as file block size, overwrite rules, and exclude pattern.
Advanced Network Network IP, port, and socket buffer settings.

Options
Docroot

# | Field Description Values Default
1 [ Absolute Path The Absolute Path describes the area of the file file path N/A

system that is accessible by Aspera users. The
default empty value gives users access to the entire
file system.
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Provider Soap Action

authorization provider for outgoing transfers.
Required if External Authorization is enabled.

Field Description Values Default
Read Allowed Setting this to true allows users to transfer fromthe [. (e N/A
designated area of the file system as specified by the |, £,
Absolute Path value.
Write Allowed Setting this to true allows users to transfer to the e frue N/A
designated area of the file system as specified by the |, false
Absolute Path value.
Browse Allowed Setting this to true allows users to browse the . true N/A
directory. . false
Authorization
Field Description Values Default
Incoming Transfers The default setting of allow allows users to transfer |+ gl1ow allow
to this computer. Setting this to deny will prevent « deny
transfers to this computer. When set to require . require
token, only transfers initiated with valid tokens will token
be allowed to transfer to this computer. Token-based
transfers are typically employed by web applications
such as Faspex and require a Token Encryption Key.
Incoming External The value entered should be the URL of the HTTP URL blank
Provider URL external authorization provider for incoming
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organizations requiring custom authorization rules.
Incoming External The SOAP action required by the external text string blank
Provider SOAP Action | authorization provider for incoming transfers.
Required if External Authorization is enabled.
Outgoing Transfers The default setting of allow allows users to transfer |, 4jjow allow
from this computer. Setting this to deny will prevent |, deny
transfers from this computer. When set to require . .
token, only transfers initiated with valid tokens will iglc(llellllre
be allowed to transfer from this computer. Token-
based transfers are typically employed by web
applications such as Faspex and require a Token
Encryption Key.
Outgoing External The value entered should be the URL of the HTTP URL,
Provider URL external authorization provider for outgoing default blank
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organizations requiring custom authorization rules.
Outgoing External The SOAP action required by the external Text string blank
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Field

Description

Values

Default

Token Encryption Cipher

The cipher used to generate encrypted authorization
tokens.

e aes-128
e aes-192
e aes-256

aes-128

Token Encryption Key

This is the secret token that will be used to authorize
those transfers configured to require token.

Token generation is part of the Aspera SDK. See

the Aspera Developer's Network (Token-based
Authorization Topic) for more information.

Text string

blank

Token Life (seconds)

Sets token expiration for users of web-based transfer
applications.

Positive integer

1200

10

Encryption Allowed

Describes the type of transfer encryption accepted
by this computer. When set to any the computer
allows both encrypted and non-encrypted transfers.
When set to none the computer restricts transfers

to non-encrypted transfers only. When set to
aes-128 the computer restricts transfers to encrypted
transfers only.

* any
e none
e aes-128

any

Bandwidth

Field

Description

Values

Default

Incoming Vlink ID

The value sets the Vlink ID for incoming transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables Vlinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to a node, group, or user. Vlink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID is a unique numeric identifier. See
Configuring Virtual Links on page 37

Pre-defined
value

Incoming Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for incoming
transfers. The Target Rate Cap is the maximum
target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

Incoming Target Rate
Default (Kbps)

This value represents the initial rate for incoming
transfers, in kilobits per second. Users may be
able to modify this rate in real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

Incoming Target Rate
Lock

After an incoming transfer is started, its target
rate may be modified in real time. The default
setting false gives users the ability to adjust the
transfer rate. A setting of true prevents real-time
modification of the transfer rate.

e true
* false

false



http://developer.asperasoft.com/web/token_auth.html
http://developer.asperasoft.com/web/token_auth.html
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Field

Description

Values

Default

Incoming Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for incoming
transfers. The Minimum Rate Cap is a level
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

Incoming Minimum Rate
Default (Kbps)

This value represents the initial minimum rate for
incoming transfers, in kilobits per second. Users
may be able to modify this rate in real time as
allowed by the software in use. This setting is not
relevant to transfers with a Fixed policy.

Positive integer

Incoming Minimum Rate
Lock

After an incoming transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed
policy.

* ftrue
« false

false

Incoming Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for incoming transfers. The default policy value
may be overridden by client applications initiating
transfers.

o fixed
* high
e fair

e low

fair

Incoming Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth Policy
for incoming transfers. Aspera transfers use fixed,
high, fair and low policies to accommodate network-
sharing requirements. When set to any, the server
will not deny any transfer based on policy setting.
When set to high, transfers with a Policy of high
and less aggressive transfer policies (such as, fair

or low) will be permitted. Fixed transfers will be
denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

o fixed
* high
e fair

e low

fair

10

Incoming Bandwidth
Policy Lock

After an incoming transfer is started, its Policy may
be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.
A setting of true prevents real-time modification of
the Policy.

e false

false

11

Outgoing Vlink ID

The value sets the Vlink ID for outgoing transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables Vlinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to a node, group, or user. Vlink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID is a unique numeric identifier. See
Configuring Virtual Links on page 37

Pre-defined
value

12

Outgoing Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for outgoing
transfers. The Target Rate Cap is the maximum

Positive integer

Unlimited
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Field

Description

Values

Default

target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

13

Outgoing Target Rate
Default (Kbps)

This value represents the initial rate for outgoing
transfers, in kilobits per second. Users may be
able to modify this rate in real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

14

Outgoing Target Rate
Lock

After an outgoing transfer is started, its target

rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer rate. A setting of true prevents real-time
modification of the transfer rate.

e true
* false

false

15

Outgoing Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for outgoing
transfers. The Minimum Rate Cap is a level
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

16

Outgoing Minimum Rate
Default

This value represents the initial minimum rate for
outgoing transfers, in kilobits per second. Users may
be able to modify this rate in real time as allowed
by the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

17

Outgoing Minimum Rate
Lock

After an outgoing transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed
policy.

« false

false

18

Outgoing Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for outgoing transfers. The default policy value
may be overridden by client applications initiating
transfers.

o fixed
* high
e fair

e low

fair

19

Outgoing Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth Policy
for outgoing transfers. Aspera transfers use fixed,
high, fair and low policies to accommodate network-
sharing requirements. When set to any, the server
will not deny any transfer based on policy setting.
When set to high, transfers with a Policy of high
and less aggressive transfer policies (for example,
fair or low) will be permitted. Fixed transfers will

be denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

e any
* high
e fair
 low

any
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Field

Description

Values

Default

20

Outgoing Bandwidth
Policy Lock

After an outgoing transfer is started, its Policy may

be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.
A setting of true prevents real-time modification of
the Policy.

e true
« false

false

Advanced File Handling

Field

Description

Values

Default

File Create Mode

Specify file creation mode (permissions). If
specified, create files with these permissions (for
example 0755), irrespective of File Create Grant
Mask and permissions of the file on the source
computer. Only takes effect when the server is a
non-Windows receiver.

Positive integer
(octal)

undefined

File Create Grant Mask

Used to determine mode for newly created files

if File Create Mode is not specified. If specified,
file modes will be set to their original modes plus
the Grant Mask values. Only takes effect when the
server is a non-Windows receiver and when File
Create Mode is not specified.

Positive integer
(octal)

0644

Directory Create Mode

Specify directory creation mode (permissions). If
specified, create directories with these permissions
irrespective of Directory Create Grant Mask and
permissions of the directory on the source computer.
Only takes effect when the server is a non-Windows
receiver.

Positive integer
(octal)

undefined

Directory Create Grant
Mask

Used to determine mode for newly created

directories if Directory Create Mode is not specified.

If specified, directory modes will be set to their
original modes plus the Grant Mask values. Only
takes effect when the server is a non-Windows
receiver and when Directory Create Mode is not
specified.

Positive integer
(octal)

0755

Read Block Size (bytes)

This is a performance tuning parameter for an
Aspera sender. It represents the number of bytes an
Aspera sender reads at a time from the source disk
drive. Only takes effect when server is sender. The
default of 0 will cause the Aspera sender to use its
default internal buffer size, which may be different
for different operating systems.

Positive integer

Write Block Size (bytes)

This is a performance tuning parameter for an
Aspera receiver. Number of bytes an ascp receiver
writes data at a time onto disk drive. Only takes
effect when server is receiver. The default of 0 will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.

Positive integer

Use File Cache

This is a performance tuning parameter for an
Aspera receiver. Enable or disable per-file memory

true
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Field

Description

Values

Default

caching at the data receiver. File level memory
caching improves data write speed on Windows
platforms in particular, but will use more memory.
We suggest using a file cache on systems that are
transferring data at speeds close to the performance
of their storage device, and disable it for systems
with very high concurrency (because memory
utilization will grow with the number of concurrent
transfers).

* false

Max File Cache Buffer
(bytes)

This is a performance tuning parameter for an
Aspera receiver. This value corresponds to the
maximal size allocated for per-file memory cache
(see Use File Cache). Unit is bytes. The default of
0 will cause the Aspera receiver to use its internal
buffer size, which may be different for different
operating systems.

Positive integer

Resume Suffix

Extension name of a class of special files holding
metadata information of regular data files. Useful
in the context of resuming partially completed
transfers. During resume mode (-k1/2/3), each data
file has a corresponding metadata file with the same
name and the pre-specified resume suffix.

text string

aspx

10

Preserve Attributes

Configure file creation policy. When set to none, do
not preserve the timestamp of source files. When set
to times, preserve the timestamp of the source files
at destination.

none / times

undefined

11

Overwrite

Overwrite is an Aspera server setting that
determines whether Aspera clients are allowed to
overwrite files on the server. By default it is set to
allow, meaning that clients uploading files to the
servers will be allowed to overwrite existing files
as long as file permissions allow that action. If set
to deny, clients uploading files to the server will not
be able to overwrite existing files, regardless of file
permissions.

* allow
* deny

allow

12

File Manifest

When set to text a text file "receipt" of all files
within each transfer session is generated. If set to
disable no File Manifest is created. The file manifest
is a file containing a list of everything that was
transferred in a given transfer session. The filename
of the File Manifest itself is automatically generated
based on the transfer session's unique ID. The
location where each manifest is written is specified
by the File Manifest Path value. If no File Manifest
Path is specified, the file will be generated under the
destination path at the receiver, and under the first
source path at the sender.

¢ text
¢ disable

none

13

File Manifest Path

Specify the location to store manifest files. Can be
an absolute path or a path relative to the transfer
user's home.

text string

blank
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# | Field Description Values Default
14 [ Pre-Calculate Job Size Configure the policy of calculating total job size « any any
before data transfer. If set to any, follow client .« yes
configurations (-o PreCalculateJobSize={yesno}). | o
If set to no, disable calculating job size before
transferring. If set to yes, enable calculating job size
before transferring.
15 [ Storage Rate Control Enable/Disable disk rate control. When enabled, . true false
adjust transfer rate according to the speed of . false
receiving I/O storage, if it becomes a bottleneck.
16 | File checksum method Specify the type of checksum to calculate for . any any
transferred files. The content of transfers can be -
verified by comparing the checksum value at the .« chal
destination with the value read at the source.
16 | Partial Suffix Set the file suffix for partially downloaded files. .aspx
Advanced Network Options
# | Field Description Values Default
1 |Bind IP Address Specify an IP address for server-side ascp to bind Valid 1Pv4 blank
its UDP connection. If a valid IP address is given, address
ascp sends and receives UDP packets ONLY on the
interface corresponding to that IP address.
2 | Bind UDP Port Specify a port number for server-side ascp to bind Positive integer | 33001
its UDP connection. This also prevents client ascp
processes from binding to same UDP port. Valid
port numbers range between 1 and 65535.
3 | Disable Packet Batching | When set to true, send data packets back to back e true false
(no sending a batch of packets). This results in . false
smoother data traffic at a cost of higher CPU usage.
4 [ Maximum Socket Buffer | Upper bound the UDP socket buffer of an ascp Positive integer |0
(bytes) session below the input value. The default of 0 will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.
5 [ Minimum socket buffer | Set the minimum UDP socket buffer size for an ascp | Positive integer |0
(bytes) session.

Transfer References

Simple Transfer Options

The following tables provide information on additional configurable settings that are available when creating simple
transfers.

Connection

Fasp Port (UDP)

Specify the UDP port for FASP file transfers.
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Fasp proxy Enable transferring through a FASP proxy server, and specify the proxy host address, port,
username, and password. This feature enables the source node to bypass restrictions to the
destination node for this specific transfer by using a proxy.

Security

Content protection Check the option to enable the content protection that encrypts the files on destination, using
the entered password.

Transport encryption | Select aes-128 to transfer with this encryption method.

Transfer

Target rate

Specify the transfer target rate.

Minimum rate

Set the transfer minimum rate

Bandwidth policy

Choose a transfer policy among fixed/high/fair/low.

Retry policy

Check the option to enable the retry policy, as well as specify the number of attempts and the
duration.

Notifications

Email address

To send status notifications for transfer events (start, success, or error), enter an email
address and click Add. When the email address appears in the table, specify which email
template to use for each transfer event.

File Handling

Timestamp Filtering

Select this option to exclude files modified in the designated number of seconds.

Resume policy

Specify a resume policy and the overwrite rule when the file exists on the destination.

File attributes

Check the option to preserve the file permissions on the destination.

Symlinks

Specify how to deal with symbolic links: follow, copy, copy and force, or skip. Leave this
option blank if the source is on Windows. For all others, leaving it blank is the same as
choosing "follow".

Source Archiving

Move source files to a designated directory after completing a transfer. The transfer's session
details page displays the archive directory's filepath as the After transfer path. For more
information on session details, see Transfer Details on page 47.

Note: The After transfer path is only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes do not have
access to the After transfer path.

Note: Rerunning the transfer may generate a "No such file or directory” error since the
source files were moved to the archive directory.

Delete empty source
subdirectories

This option becomes available if you selected Source Archiving. Select this option to delete
any subdirectory that is emptied by the source archiving.

Note: Console does not delete the top-most directory in the source path.

Source Deletion

Delete the transferred files from the source computer. Select Delete empty source
subdirectories to remove any empty folders in the source directory.
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Deletes all files at the destination path.

Exclude filter

Enter file-name pattern Console uses to determine what files to exclude from the transfer.
You can use the following two symbols in the pattern:

+ *:The wildcard (*) symbol represents zero to many characters in a string. For example,
the "*.tmp" pattern matches ".tmp" and "abcde.tmp".

* ?7: The question mark (?) represents any one character. For example, the "t?p" pattern
matches "tmp" but not "temp".

Include filter

Enter file-name pattern Console uses to determine what files to include in the transfer. Only
files matching the filter are transferred.

You can use the following two symbols in the pattern:

« *:The wildcard (*) symbol represents zero to many characters in a string. For example,
the "*.tmp" pattern matches ".tmp" and "abcde.tmp".

* 7 : The question mark (?) represents any one character. For example, the "t?p" pattern
matches "tmp" but not "temp".

Advanced

Initiator

Check this option to initiate transfers from the destination node (if possible). Console
normally initiates transfers from the source node unless the source is an unmanaged node.

ascp version

Select the option to use ascp4 for this transfer. The initiating node must have ascp4
available.

Note: Both nodes need to be running the same version of Enterprise Server to use ascp4.
Also, the apply local docroot parameter in aspera.conf isnot currently
supported.

Note: ascp4 is only available for Aspera Enterprise Server 3.8 and later.

fasp datagram size
(MTU)

Select the option and enter the datagram size in bytes.

Read block size

Check the option and enter the read block size in bytes.

Write block size

Check the option and enter the write block size in bytes.

Transfer Time

Transfer

Specify when to submit the transfer.

Note: You can cancel scheduled simple transfers by going to Activity > Transfers. Click
the Scheduled drop-down menu and select All. In the row for the transfer, click Cancel.
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Transfers
Scheduled: | All A
= Future
NAME DETAILS SCHEDULED
Cancel Scheduled Transfer admin (console), Node 1 fo Node 1 4:39pm 30-Cct

ACTIONS

o

tart

[y

<&}

Smart Transfer Options

The following tables provide information on additional configurable settings that are available when creating smart

transfers.
Connection

Fasp Port (UDP) Specify the UDP port for FASP file transfers.

Fasp proxy Enable transferring through a FASP proxy server, and specify the proxy host address, port,
username, and password. This feature enables the source node to bypass restrictions to the
destination node for this specific transfer by using a proxy.

Security

Content protection Check the option to enable the content protection that encrypts the files on destination, using
the entered password.

Transport encryption | Select aes-128 to transfer with this encryption method.

Transfer

Target rate

Specify the transfer target rate.

Minimum rate

Set the transfer minimum rate

Bandwidth policy

Choose a transfer policy among fixed/high/fair/low.

Retry policy

Check the option to enable the retry policy, as well as specify the number of attempts and the
duration.

Notifications

Email address

To send status notifications for transfer events (start, success, or error), enter an email
address and click Add. When the email address appears in the table, specify which email
template to use for each transfer event.

File Handling

Timestamp Filtering

Select this option to exclude files modified in the designated number of seconds.

Resume policy

Specify a resume policy and the overwrite rule when the file exists on the destination.
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Check the option to preserve the file permissions on the destination.

Symlinks

Specify how to deal with symbolic links: follow, copy, copy and force, or skip. Leave this
option blank if the source is on Windows. For all others, leaving it blank is the same as
choosing "follow".

Source Archiving

Move source files to a designated directory after completing a transfer. The transfer's session
details page displays the archive directory's filepath as the After transfer path. For more
information on session details, see Transfer Details on page 47.

Note: The After transfer path is only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes do not have
access to the After transfer path.

Note: Rerunning the transfer may generate a "No such file or directory” error since the
source files were moved to the archive directory.

Delete empty source
subdirectories

This option becomes available if you selected Source Archiving. Select this option to delete
any subdirectory that is emptied by the source archiving.

Note: Console does not delete the top-most directory in the source path.

Source Deletion

Delete the transferred files from the source computer. Select Delete empty source
subdirectories to remove any empty folders in the source directory.

Destination Deletion

Deletes all files at the destination path.

Exclude filter

Enter file-name pattern Console uses to determine what files to exclude from the transfer.
You can use the following two symbols in the pattern:

+ *:The wildcard (*) symbol represents zero to many characters in a string. For example,
the "*.tmp" pattern matches ".tmp" and "abcde.tmp".

* ?:The question mark (?) represents any one character. For example, the "t?p" pattern
matches "tmp" but not "temp".

Include filter

Enter file-name pattern Console uses to determine what files to include in the transfer. Only
files matching the filter are transferred.

You can use the following two symbols in the pattern:

« *:The wildcard (*) symbol represents zero to many characters in a string. For example,
the "*.tmp" pattern matches ".tmp" and "abcde.tmp".

* ?: The question mark (?) represents any one character. For example, the "t?p" pattern
matches "tmp" but not "temp".

Advanced

Initiator

Check this option to initiate transfers from the destination node (if possible). Console
normally initiates transfers from the source node unless the source is an unmanaged node.

ascp version

Select the option to use ascp4 for this transfer. The initiating node must have ascp4
available.

Note: Both nodes need to be running the same version of Enterprise Server to use ascp4.
Also, the apply local docroot parameter in aspera.conf isnot currently
supported.

Note: ascp4 is only available for Aspera Enterprise Server 3.8 and later.
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Select the option and enter the datagram size in bytes.

Read block size Check the option and enter the read block size in bytes.
Write block size Check the option and enter the write block size in bytes.
Scheduling

Start Click the calendar icon to select a date and time that serves as the starting basis for your
recurring smart transfers. Based on the "Start" entry, Console calculates the run time for the
next occurrence (that matches the repeat rules). For example, if your start date is Friday,
April 8, but your transfer is scheduled to run on Saturdays, then the first transfer occurs on
Saturday, April 9.

Repeat every Select the number of minutes, hours, days, weeks, or months to repeat this transfer. When
weeks is selected, you can enable the requisite days of the week. When months is selected,
you can specify whether to perform the transfer on a specific day of the month or on the "nth
____day" of the month (for example, 1st Sunday).

Until Click the calendar icon to select a "do not go beyond" date and time. Your smart transfer
does not repeat beyond this entry.

Time zone Select your timezone from the drop-down list.

Important: When you have more than one destination, you can override the default smart transfer settings (with the
exception of scheduling) shown in the More Options panel for each individual destination.

Watchfolder Options

The following tables provide information on additional configurable settings that are available when creating

watchfolders.

Watchfolder Settings

Note: A watchfolder groups new or updated files it detects in its source folder into "drops". A drop is defined by the
duration set by the snapshot creation period. All files in a given drop are transferred in the same transfer session, post-
processed together, and reported as a unit.

Option

Description

Drop detection
strategy

The strategy this watchfolder uses to detect files dropped into the source folder.

* Cool off only: Create a drop that includes new files added within the duration by the
snapshot creation period.

+ Top level files: Create a drop for each file placed in the top level of the source folder.

» Top level directories: Create a drop for each directory placed in the top level of the
source folder. This drop also includes the sub-directories and files in the top level
directory.

Drop detection cool
off

The duration allowed for new files to be included in a drop. Aspera recommends choosing a
multiple of the specified snapshot creation period for predictable results.

Snapshot creation
period

The duration used to determine what files are included in the current drop.

Connect timeout

The duration the source node waits to connect to the destination node.

Sample period

The frequency of the system estimateing the available bandwidth.
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Option Description

Queue threshold The duration watchfolder adds files to a session. Use this feature to limit the number of files
transferred based on the computed available bandwidth.

Retry duration The duration in which the source node tries to establish a connection with the destination

node.

Wait between retries

The duration the source node waits in between retries.

File detection cool
off

The duration watchfolder in which placing a new file in the source folder does not trigger a
new drop.

Note: This setting does not apply to the Cool off only detection strategy.

File filters

Click the button to add a new filter to identify file lists. You can set a filter to include or
exclude files by globbing or by regular expression.

Transfer

Option

Description

Target rate

The transfer target rate.

Minimum rate

The transfer minimum rate

Bandwidth policy Choose a transfer policy among fixed | high | fair | low.

Transport Encryption | Select aes-128 to transfer with this encryption method.

Retry policy The number of attempts and the duration between each retry.
Security

Option Description

Content Protection

Select Encrypt transferred files with a password to enable content encryption. Enter and
confirm the password the recipient must use to decrypt the transferred files.

Note: When editing a watchfolder with content protection enabled, you must re-The
content protection password. A password must be provided in order to save changes to the
watchfolder.

File Handling

Option

Description

Resume policy

Specify a resume policy and the overwrite rule when the file exists on the destination.

File attributes

Preserve file UIDs, GIDs, or timestamps.

Source Archiving

The designated directory source files are moved to after completing a transfer. The transfer's
session details page display the archive directory's filepath as the After transfer path.

Note: The After transfer path will only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes will not have
access to the After transfer path.

Note: Re-running the transfer may generate a "No such file or directory" error since the
source files were moved to the archive directory.
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Option Description

You can use archive directory variables in the filepath to define specific archive paths for
each drop. Hover over the Archive directory variables link for a list of available variables.

Source deletion Delete the transferred files from the source computer after transfer.

Growing Files

Option Description

Maximum parallel The maximum number of concurrent transfers of growing files watchfolder can initiate.
transfers

Target rate The target transfer rate.

Bandwidth policy The bandwidth policy.

Transport encryption | Select aes-128 to transfer with this encryption method.

TCP port The TCP port to use for this watchfolder.

fasp™ port (UDP) The UDP port to use for this watchfolder.

Completion timeout | The amount of time to wait for the file to no longer change for the session to finish.

Memory The maximum amount of memory that the faspstream binary is allowed to use.

Chunk size The size of data to pack before sending over the network.

Growing file filters Click the button to add a new filter to identify growing files. You can set a filter to

include or exclude files by globbing or by regular expression.

Packages / Drops
Option Description
Package timeout A package in watchfolder defines a set of files with dependencies. The package timeout
defines the time in which watchfolder waits for required files. If the required files do not
appear within the duration, files with dependencies are marked as not transferred because of
unsatisfied dependencies.
Final transfer Defines which file has to be transferred last.

+ Last file in list: The last file in the package list is transferred last.
+ File list: The files are transferred without any specific order.

File list filters Click the button to add a new filter to identify file lists. You can set a filter to include or

exclude files by globbing or by regular expression.

Specify Base for Source Path

When selecting the source for a simple or smart transfer, you have the option to select Specify base for source
path(s) to specify a portion of the source path to remove to place the transferred files directly into the destination
folder without its hierarchy of directories.

For example, a source computer has a sent_files/project directory containing the following folders and files:

» /shared_files/project/presentation
» /shared_files/project/video_footage/takel
» /shared_files/project/video_footage/take2
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+ /shared_files/project/video_footage/take3

If your select the shared_files/project directory as the source, by default, the transfer includes the sent files
directory and the entirety of its contents, including its hierarchy of directories. If the destination directory is specified
as /incoming, your transferred files appear as follows on the destination computer:

docroot/incoming/shared files/project/presentation

docroot/incoming/shared files/project/video footage/takel
docroot/incoming/shared files/project/video footage/take?2
docroot/incoming/shared files/project/video footage/take3

By selecting Specify base for source paths(s), the project folder can be excluded. Entering "/shared_files/project”
in the field removes that part of the source path. Only the presentation and video_footage directories are transferred.
The transferred files appear as follows on the destination computer:

docroot/incoming/presentation

docroot/incoming/video footage/takel
docroot/incoming/video footage/take?2
docroot/incoming/video footage/take3

If any files or folders selected for transfer fall outside the specified base path, they are omitted from the transfer.
For example, if the specified path is /shared_files/project/video_footage, then presentation is not transferred at
all because it is not in video_footage. Only takel, take2, and take3 are transferred. The transferred files appear as
follows on the destination computer:

docroot/incoming/takel
docroot/incoming/take?2
docroot/incoming/take3

Tip: Specify base for source paths(s) can also be used to include more path depth than the default. If the source-
base path is specified as /shared_files, then project and all files and folders in its folder hierarchy are included.
Similarly, if the source-base path is specified as /, the entire source path and all fields and folders in its folder
hierarchy are transferred.

Report References

Reference: Basic Report Organization Options

Field Description

Client Address Organize / summarize report by Client IP Address (client
= initiator of the transfer)

Contact Organize by the 'Contact' shown for a transfer. This
might be a Console user name, a Faspex Server user
name, SSH account, or customized value obtained from
a transfer cookie. Examples: "admin (console)", "aspera
(ssh)", "aspera (faspex)".

File Display a detail row for every file in every transfer.
File Extension Organize / summarize report by file extension.

Server Address Organize / summarize report by Server [P Address.
Session Display a row for every transfer session. A transfer

session represents one attempt to transfer.
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Field

Description

Transfer

Display a row for every transfer. A transfer may have
multiple sessions if it took multiple attempts to finish.

Reference: Built-In Fields for Custom Field Rules

Built-In Fields Available for Creating Custom Field Rules (for Transfer-Level Fields)

Transfer Field

Description

Client Address

IP address of transfer initiator.

Client User

Client-side username. Null for all transfers, except for
transfers initiated by the Console.

Contact

Contact assigned by Console. This can be a Console

user name, a Faspex Server user name, SSH account,

or customized value obtained from a transfer cookie.
nn

Examples: "admin console", "aspera ssh", "aspera
faspex".

Cookie

Custom identifying text attached to a transfer session.
This text is used by the Console to identify and name
transfers.

Destination Address

IP address of transfer destination (use for general
purpose).

Destination Path

The file path on the destination machine.

Destination User

If upload, dest user is the server user. If download,
dest_user is client user (NULL, unless initiated from
Console). For everyday purposes, recommend using
contact field instead.

Direction The direction of the transfer from the perspective of the
client. "Upload" if the transfer is a push; "Download" if
the transfer is a pull.

Meta-tags JSON hash used to tag transfers with additional data.

Faspex Metadata Information provided by Faspex, encoded in the transfer

cookie. See Basic Report Example: Faspex Metadata on
page 196.

Server Address

IP address of the server.

Server User

SSH account specified when the transfer starts (should
always be displayed).

Source Address

IP address of transfer source.

Source Paths

File paths on the source machine.

Source User

If upload, source user is the client user. If download,
source_user is server user.

Started Via

The name of the application (Aspera or custom) that
is responsible for initiating the transfer (for example,
aspera.scp, aspera.sync, etc.).
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Transfer Field

Description

Token

Security token used for the transfer (note that this
depends on whether or not the application that started the
transfer is configured to use tokens).

Transfer Name

Human-readable name assigned to a transfer. This name
may have been keyed in by the user or automatically set
by an application.

Built-In Fields Available for Creating Custom Field Rules (for File-Level Fields)

Note: Setting up file-level custom fields is NOT recommended for customers that transfer many small files, as this

will result in scaling issues.

File Field Name

Description

File Bytes Transferred

Total bytes successfully received over the network.

File Error Desc

Error message for the file, if any.

File Extension

Portion of the filename after the last period (.)

File Full Destination Path

File's full path from the destination's point-of-view.

File Full Source Path

File's full path from the source's point-of-view.

File Name Name of the file, without its path (for example,
"my file.txt" rather than "C:\temp
\my file.txt")

File Size Size of the file in bytes.

File Status

Status of transfer or file (for example, "running,"
"completed," "canceled" or "error").

Reference: Reporting Filters

IBM Aspera Console provides built-in filters that allow you to specify conditions for limiting the data included in

your report.
Column Heading Description
Filter By Select from a list of parameter names.
NOT Appears as a checkbox, where unchecked represents "is" and checked represents "is
not" (for example, file extension is not equal to tmp)
Comparison Select from a list of operators (for example,, equal to, greater than, etc.).
Value Input a parameter value to complete the filter expression.
Filters
Filter by NOT Comparison Value
File Extension - < equal to * mp3 remave
File Size - greater than ~ 10000 remave

select...

-

Important: Once you have added a filter, you may remove it by clicking the Remove hyperlink.

The following filter parameters are available within the Filter By drop-down list:
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Parameter Name

Parameter Description

{Custom Field Names}

Displays custom fields that you have configured for the SQL database.

File Bytes Transferred

File bytes successfully received over the network by the destination.

File Bytes Written

Files bytes successfully received over the network by the destination, plus bytes
skipped for data already present at the destination.

File Error Description

File's error message, if any.

File Extension

Portion of the filename after the last period (.)

File Fullpath

File's directory tree hierarchy.

File Name

Name of the file, without its path (for example, "my _file.txt," rather than "C:\temp
\my _file.txt").

File Session Status

nn

Status of file session (for example, "running," "completed," "canceled" or "error"),
where a file session is one file in a transfer session. A file record may group together
more than one file session record if, during a transfer session, one of the files fails or
is interrupted. In the next transfer session (when the transfer is retried or a hot folder
handles the next batch of files to arrive), then that particular file may be retried. This
will result in another file session record being created.

File Size

Size of the file in bytes.

File Status

The file status will be the status of the last/most recent file session for the file (for
example, "running," "completed," "canceled" or "error").

SSH Account

SSH account specified when the transfer starts.

Transfer Average Rate

Average transfer rate in bits per second.

Transfer Bytes Lost

Number of bytes sent by source for a particular file, but never received by destination,
or never written to disk.

Transfer Bytes Transferred

Total bytes successfully received over the network by the destination.

Transfer Bytes Written

Total bytes successfully received over the network by the destination, plus bytes
skipped for data already present at the destination.

Transfer Client Address

IP address of transfer initiator.

Transfer Contact

Contact assigned by Console. This can be a Console user name, a Faspex user name,
SSH account, or customized value obtained from a transfer cookie. Examples: "admin
(console)", "aspera (ssh)", "michael (faspex)"

Transfer Cookie

Custom identifying text attached to a transfer session. This text is used by the Console
to identify and name transfers.

Transfer Destination
Address

IP address of transfer destination.

Transfer Destination Path

The file path on the destination machine.

Transfer Error Description

Error message for transfer or file, if any.

Transfer Files Completed

Number of files successfully verified at destination (i.e., the number of files actually
transferred plus the number of files that were already at destination).

Transfer Files Failed

Number of files that failed to transfer.

Transfer Name

Human-readable name assigned to a transfer. This name may have been keyed in by
the user or automatically set by an application.
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Parameter Name Parameter Description
Transfer Server Address IP address of transfer server.
Transfer Session Status Indicates status of transfer session (for example, "running," "completed," "canceled"

or "error"), where the transfer session represents one execution of ascp (i.e., one
attempt to transfer).

Note: When a transfer session is interrupted or fails and is configured to retry, a
second transfer session will begin after the configured retry interval has elapsed.

Transfer Source Address IP address of transfer source.
Transfer Source Paths File paths on the source machine.
Transfer Status A transfer will group together transfer sessions into a single item. The transfer status

will be the status of the last/most recent transfer session for the transfer (for example,
"running," "completed," "canceled" or "error").

Reference: SQL Variables for Advanced Reports

When creating your advanced report, you may utilize the SQL variables listed below. These variables also appear
within Console's built-in, SQL script text help.

SQL Variable Description

$TBL_FILES Files table. One record in this table represents one file. At run time, this
variable gets replaced with the SQL name of the table containing the file
data (currently 'rpt_transfer files'). Please note the following distinction:

* A FILE record can have multiple associated TRANSFER SESSION
FILE records (if a file took more than one attempt to transfer).

* A FILE record has one and only one associated TRANSFER record
(STBL_TRANSFER FILES.transfer id = $TBL _TRANSFERS.id).

$TBL TRANSFER SESSIONS Transfer sessions table. One record in this table represents one attempt

to transfer data. If you start a transfer and it fails, then automatically
retries and succeeds, there will be two records in this table, one for the
initial attempt and one for the automatic retry. For hot folder transfers,
each session represents one attempt to transfer a batch of files that are
currently available. If new files become available while the first batch is in
progress, these may be transferred in a subsequent session, resulting in an
additional record in this table. At run time, this variable gets replaced with
the SQL name of the table containing the transfer session data (currently
'rpt_transfer_sessions'). Please note the following distinction:

* A TRANSFER SESSION record can have multiple TRANSFER
SESSION FILE records (if the session attempted to transfer more than
one file).

* A TRANSFER SESSION record has one and only one associated
TRANSFER record ($STBL_TRANSFER SESSIONS.transfer id =
$TBL TRANSFERS.id).

$TBL TRANSFER SESSION FILES | Files within a transfer session. One record in this table represents one
attempt to transfer a file. At run time, this variable gets replaced with
the SQL name of the table containing the file session data (currently
'rpt_transfer_session_files'). Please note the following distinction:

» A TRANSFER SESSION FILE record has
one and only one associated FILE RECORD
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SQL Variable

Description

(STBL_TRANSFER SESSION_FILES.transfer file id =
$TBL_FILES.id).

» A TRANSFER SESSION FILE record has one and
only one associated TRANSFER SESSION record
(STBL_TRANSFER SESSION FILES.transfer session id =
$TBL TRANSFER SESSIONS.id).

$TBL_NODES

A table containing one record for each node, whether managed or
unmanaged. At run time, this variable gets replaced with the SQL name of
the table containing the node data (currently 'rpt_transfer nodes").

$TBL_TRANSFERS

A TRANSFER groups together TRANSFER SESSIONS to tie together
retry attempts and hot folder file batches. Related TRANSFER
SESSIONS are grouped together so that no matter how many times the
session was interrupted and retried, only a single record will be present in
this table. At run time, this variable gets replaced with the SQL name of
the table containing the transfer data (currently 'rpt_transfers'). Please note
the following distinction:

* A TRANSFER record can have multiple TRANSFER SESSION
records (if multiple attempts or batches were required to transfer all the
data).

* A TRANSFER record can have multiple FILE records (if the transfer
consisted of more than one file).

$FINAL RESULT TABLE

This is the table where you place your final results. The data displayed

on reports comes directly from this table. At run time, this variable gets
replaced with a name based on an auto-generated numeric id (for example,
'report_100_results').

$TMP_TABLENAME

If you need any temporary tables for intermediate record

processing, give them names starting with "$STMP_" (for example,
$TMP_UNIQUE IP ADDRESSES). At run time, these variables get
replaced with a name based on an auto-generated numeric id (for example,
'report 100 temp unique ip addresses').

$USER_ID

This is the login id of user requesting report. At run time, this variable gets
replaced with the numeric id of the user requesting the report.

$REPORT PERIOD START

Report period start. The user running this report will be prompted for a
value at request time. (Value is converted to UTC before substitution).

$REPORT PERIOD END

Report period end. The user running this report will be prompted for a
value at request time. (Value is converted to UTC before substitution).

SANYTHING ELSE

Any $NAME that does not match one of the variables is presumed to be a
custom variable whose value will be provided by the report requester. See
Editing Custom Variables on page 87 for instructions on how to create
and configure a custom variable.

Reference: Database Fields for Advanced Reports

When creating your advanced report, you may utilize the database fields listed below. These fields (and corresponding

descriptions) also appear within Console's built-in, SQL script text help.

Note: The term "client" refers to the machine initiating a transfer request. The term "server" refers to the machine

receiving the request. These terms do not describe the direction of the file transfer. As long as a machine is the
transfer initiator, it does not matter whether the machine is sending a file or receiving a file.
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Database Field

Description

Table

args_attempted

Number of items specifically selected
by the user (either in GUI or command
line).

$TBL TRANSFER SESSIONS

args_completed

Out of the number of arguments
attempted, the number completed
successfully.

$TBL _TRANSFER SESSIONS

aspera_version

Aspera product version for the node
machine.

$TBL_NODES

avg loss pct Average packet loss over the network, | $STBL TRANSFER SESSIONS
which is calculated as a percentage.
avg rate Average transfer rate in bits per $TBL TRANSFERS,

second.

$TBL TRANSFER SESSIONS

bytes_config

The number of contiguous bytes
that have been transferred to the
destination.

$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

bytes_lost Number of bytes sent by source fora | $TBL_TRANSFERS,
particular file, but never received by $TBL TRANSFER SESSIONS,
destination, or never written to disk. $TBL TRANSFER SESSION FILES,
$TBL FILES
bytes pretransfer If the server is configured to do so, $TBL _TRANSFERS,

calculates size of the transfer before
the transfer starts. On the server, this
corresponds to the "pre-calculate job
size" setting.

$TBL _TRANSFER SESSIONS

bytes_remaining

Total bytes waiting to be sent over the
network to the destination.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

bytes_transferred

Total bytes successfully received over
the network by the destination.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS,
$TBL_TRANSFER SESSION FILES,
$TBL_FILES

bytes_written

Total bytes successfully received over
the network by the destination, plus
bytes skipped for data already present
at the destination.

STBL_TRANSFERS,
STBL_TRANSFER_SESSIONS,
$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

cipher

Encryption algorithm.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

client console ip

The client's IP address from the
perspective of the Aspera Console
application (advanced / debugging
field).

$TBL TRANSFER SESSIONS

client err code

Error code reported by the client.

$STBL_TRANSFER_SESSION_FILES,
$STBL_TRANSFER_SESSIONS

client err desc

Error code description reported by the
client.

$TBL_TRANSFER_SESSION_FILES,
$STBL_TRANSFER_SESSIONS
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Database Field

Description

Table

client external fasp port

The client's UDP port from the
perspective of the server (advanced /
debugging field).

$TBL TRANSFER SESSIONS

client external ip

The client's IP address from the
perspective of the server (advanced /
debugging field).

Note: If the client is a managed node
and the server is not, then this field is
null.

$TBL _TRANSFER SESSIONS

client_file basename

File's basename from client's point-of-
view.

$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

client file extension

File's extension from client's point-of-
view.

$TBL TRANSFER SESSION FILES,
$TBL FILES

client file fullpath

File's full path from the client's point-
of-view.

$TBL_TRANSFER SESSION FILES,
$TBL_FILES

client file index

Arbitrary, unique number assigned to
each file within a transfer session (on
the client).

$TBL _TRANSFER SESSION FILES

client ip

IP address of the transfer initiator (use
for general purpose).

$TBL_TRANSFER SESSIONS

client node id

ID number assigned to the client node.

$TBL TRANSFER SESSIONS

client node uuid

Universally, unique ID number
assigned to the client node.

$TBL TRANSFER SESSIONS

client_status

Either the file status (running,
completed, error) or the session status
reported by the client.

Note: In some cases, client and server
can see different statuses (for example,
canceled versus error).

$TBL_TRANSFER_SESSION_FILES,
$STBL_TRANSFER_SESSIONS

client_user

Client-side username. Null for all
transfers, except for transfers initiated
by the Console.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

contact

Contact assigned by Console. This can

be a Console user name, a Faspex user

name, SSH account, or customized

value obtained from a transfer cookie.
nmn

Examples: "admin (console)", "aspera
(ssh)", "michael (faspex)"

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

cookie

Custom identifying text attached to
a transfer session. This text is used
by the Console to identify and name
transfers.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

dest_endpoint_id

ID number assigned to the destination
endpoint.

$TBL _TRANSFER SESSIONS




| Appendix | 174

Database Field Description Table

dest_file basename File's basename from destination's $TBL_FILES
point-of-view.

dest_file extension File's extension from destination's $TBL_FILES
point-of-view.

dest file fullpath File's full path from the destination's $TBL_FILES

point-of-view.

dest ip

IP address of transfer destination (use
for general purpose).

$TBL_TRANSFER SESSIONS

dest_node id

ID number assigned to the destination
node.

$TBL TRANSFER SESSIONS

dest_path The file path on the destination $TBL_TRANSFERS,
machine. $TBL TRANSFER SESSIONS
dest_user If upload, dest_user is the server $TBL_TRANSFERS,
user. If download, dest user is client $TBL TRANSFER SESSIONS
user (NULL, unless initiated from
Console). For everyday purposes,
recommend using contact field instead.
dirs_pretransfer If the server is configured to do so, $TBL _TRANSFERS,

calculates number of directories to be
transferred. Only calculated if "pre-
calculate job size" setting is turned on.

$TBL _TRANSFER SESSIONS

dirscans_completed

Number of directory scans completed.

$TBL_TRANSFER SESSIONS

err_desc Error message for transfer or file, if $TBL_TRANSFER SESSION FILES,
any. $TBL_TRANSFER SESSIONS
fallback protocol If the transfer has been configured $TBL TRANSFER SESSIONS

to retry using the HTTP fallback
protocol, then this field will report
"http." If not, will be NULL.

file_basename

Name of the file, without its path (for
example, "my_file.txt," rather than "C:
\temp\my_file.txt")

$TBL TRANSFER SESSION FILES,

STBL_FILES

file extension

Portion of the filename after the last
period (.)

$TBL TRANSFER SESSION FILES,

$TBL FILES

file fullpath

Full path to the file.

$TBL_TRANSFER SESSION FILES,

$TBL_FILES

files attempted

Number of files attempted to be sent
over the network.

$TBL _TRANSFERS,
$TBL _TRANSFER SESSIONS

files_complete

Number of files successfully verified
at destination, that is, the number of
files actually transferred + number of
files that were already at destination.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

files_failed

Number of files that failed to transfer.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS
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Database Field

Description

Table

files pretransfer

If the server is configured to do
so, calculates number of files to be
transferred. Only calculated if "pre-

calculate job size" setting is turned on.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

files_skipped

Number of files skipped.

$TBL _TRANSFERS,
$TBL _TRANSFER SESSIONS

filescans_completed

The number of file scans completed.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

hostname

The local name of the node machine
(which is only filled in for managed
nodes). Note that a node machine will
be called "localhost" if it hasn't been
previously named.

$TBL_NODES

Unique integer ID assigned by the
Console (used as an internal field).

STBL_NODES, $TBL_TRANSFERS,
STBL_TRANSFER_SESSIONS,
$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

initiated_by_source

Identifies an "upload." If this field is
equal to 1, then whoever started the
transfer is uploading.

STBL_TRANSFERS,
STBL_TRANSFER_SESSIONS,
$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

last client ip

The client's IP address from the last
session of a multiple session transfer.

$TBL TRANSFERS

last_client node_id

ID number assigned to the client node
during the last session of a multiple
session transfer.

$TBL _TRANSFERS

last _dest ip

The destination's IP address from
the last session of a multiple session
transfer.

$TBL _TRANSFERS

last dest node_id

ID number assigned to the destination
node during the last session of a
multiple session transfer.

$TBL _TRANSFERS

last_err desc

Error description from the last session
of a multiple session transfer.

$TBL TRANSFERS, $TBL FILES

last_network delay

The lag on the network (RTT,
measured in milliseconds) from the
last session of a multiple session
transfer.

$TBL TRANSFERS

last restarted at

The last date/time that the node
machine was restarted (for managed
node's only).

$TBL_NODES

last retry timeout

The number of seconds that the server
waited to try again (after a failure),
during the last session of a multiple
transfer session.

$TBL _TRANSFERS
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Database Field

Description

Table

last server ip

The server's IP address from the last
session of a multiple session transfer.

$TBL TRANSFERS

last_server node id

ID number assigned to the server node
during the last session of a multiple
session transfer.

$TBL _TRANSFERS

last_source ip

The source's IP address from the last
session of a multiple session transfer.

$TBL _TRANSFERS

last_source node id

ID number assigned to the source node
during the last session of a multiple
session transfer.

$TBL _TRANSFERS

last transfer session_file id

ID number assigned to the file during
the last transfer session.

STBL_FILES

last_transport

Transport mechanism ("fasp2" for
Aspera protocol, "http" for fallback
protocol) from the last session of a
multiple session transfer.

$TBL TRANSFERS

max_rate Maximum transfer rate. $TBL TRANSFERS,
$TBL TRANSFER SESSIONS
min_rate Minimum transfer rate. $TBL _TRANSFERS,

$TBL _TRANSFER SESSIONS

mkdirs_attempted

Number of directories that were
attempted to be created at the
destination.

$TBL_TRANSFER SESSIONS

mkdirs_failed

Number of directories that failed to be
created at the destination.

$TBL_TRANSFER SESSIONS

mkdirs_passed Number of directories that were $TBL TRANSFER SESSIONS
created successfully at the destination.
name cf Human-readable name assigned to a $TBL NODES, $STBL_TRANSFERS,

transfer. This name may have been
keyed in by the user or automatically
set by an application.

$TBL TRANSFER SESSIONS

network delay

Lag on the network (RTT), which is
measured in milliseconds.

$TBL TRANSFER SESSIONS

operation Either upload or download from the $TBL _TRANSFERS,
perspective of the client (the initiator). | STBL TRANSFER SESSIONS
Upload if pushing; download if
pulling.

0s The node machine's Operating System. | STBL_ NODES

0s_version The version of the node machine's $TBL_NODES

Operating System.

paths_attempted

The total number of files and
directories attempted.

$TBL TRANSFER SESSIONS
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Database Field

Description

Table

paths_excluded

The number of files and directories
that were not transferred because of an
exclusion rules.

$TBL TRANSFER SESSIONS

paths_failed

The number of files and directories
that failed to transfer. A failure is
counted if the sender was unable to
read a source file or the destination
was unable to write the file.

$TBL _TRANSFER SESSIONS

paths_irreg

This is the total number of special files
(for example, nodes, pipes, memory
mapped files, page files or /proc files).
These files are never transferred.

$TBL_TRANSFER SESSIONS

pct_complete

Percent (%) of transfer that has been
completed. NULL if the node is server
is not configured to pre-calculate job
size.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

pretransfer_stats changed

Between one attempt to the next
(retries and sync), whether or not the
size of the transfer has changed (grew
or reduced in size).

$TBL TRANSFERS

primary_address

The node's actual IP address (which
has been keyed into the Console
interface).

$TBL NODES

priority

Normal or high (only valid when the
policy if adaptive).

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

reported by both sides

Database logger added information
to the Console from both ends of the
transfer (both source and destination
are managed nodes and both are
sending data back to the database).

$TBL _TRANSFERS

reported_by_server

If this field is equal to 1, then Console
received data from the server node. If
this field is equal to 0, then the server
was not a managed node or failed to
log.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

reported policy

High, fixed, adaptive or trickle.

$TBL_TRANSFER SESSIONS

reported_priority

Normal or high (only valid when the
policy if adaptive).

$TBL TRANSFER SESSIONS

retry_timeout

After a transfer fails, the number of
seconds the server will wait before
trying again.

$TBL TRANSFER SESSIONS

seconds_remaining

Seconds remaining for the file transfer.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

server_console ip

Internal IP address of the server
(inputted into the nodes page inside

$TBL _TRANSFER SESSIONS
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Database Field

Description

Table

Console). Note that this field is
primarily used for testing.

server_err_code

Error code reported by the server.

$STBL_TRANSFER_SESSION_FILES,
$STBL_TRANSFER_SESSIONS

server_err_desc

Error code description reported by the
server.

$TBL TRANSFER SESSION FILES,
$TBL TRANSFER SESSIONS

server_external fasp port

External fasp (UDP) port of the server.
Note that this field is primarily used
for testing.

$TBL TRANSFER SESSIONS

server_external ip

External IP address of the server. Note
that this field is primarily used for
testing.

$TBL _TRANSFER SESSIONS

server_file _basename

File's basename from server's point-of-
view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

server_file extension

File's extension from server's point-of-
view.

$TBL_TRANSFER SESSION FILES,
$TBL_FILES

server_file fullpath

File's full path from the server's point-
of-view.

$STBL_TRANSFER_SESSION_FILES,
STBL_FILES

server_file index

Arbitrary, unique number assigned to
each file within a transfer session (on
the server)

$TBL TRANSFER SESSION FILES

server_ip

IP address of transfer server.

$TBL TRANSFER SESSIONS

server node id

ID assigned to the server node.

$TBL _TRANSFER SESSIONS

server_node uuid

Universally, unique ID assigned to the
server node.

$TBL_TRANSFER SESSIONS

server_status

Either the file status (running,
completed, error) or the session status
reported by the server. Note that in
some cases, client and server can

see different statuses (for example,
canceled versus error).

$TBL TRANSFER_SESSION FILES,
$TBL_TRANSFER_SESSIONS

Server_user

SSH account specified when the
transfer starts (should always be
displayed).

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

session_count

Number of sessions required for the
transfer.

Note: Hot folders can span many
sessions.

$TBL TRANSFERS

session_file count

Number of sessions required to send a
particular file.

$TBL_FILES

session_id

ID assigned to transfer session.

$STBL_TRANSFER_SESSION_FILES,
STBL_TRANSFER_SESSIONS
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Database Field

Description

Table

size

Size of the file in bytes.

$TBL TRANSFER SESSION FILES,
$TBL FILES

size_changed The change in file size from one $TBL_FILES
transfer attempt to another.
soap_active sessions Number of transfer sessions running $TBL NODES

on the node.

source_endpoint_id

ID assigned to the source endpoint.

$TBL_TRANSFER SESSIONS

source_file basename File's basename from source's point-of- | STBL _FILES
view.

source_file extension File's extension from source's point-of- [ STBL_FILES
view.

source file fullpath File's full path from the source's point- | $TBL FILES

of-view.

source_ip

IP address of transfer source.

$TBL _TRANSFER SESSIONS

source node id

ID assigned to the source node.

$TBL_TRANSFER SESSIONS

source paths

File paths on the source machine.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

source_paths changed

Between one transfer attempt to the
next, whether or not the file source
paths have changed.

$TBL TRANSFERS

source_user

If upload, source_user is the client
user. If download, source user is
server user.

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

ssh_port

Node machine's SSH port.

$TBL_NODES

ssh_tunnel port

Node machine's SSH tunnel port.

STBL_NODES

start_byte

Displays the point at which data from
the file started transferring to the
destination (relevant if some of the file
has already been transferred). If the
file has already been transferred to the
destination, then the start byte equals
the total file size.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

started at

Date and time that a transfer or file
started.

$STBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS,
$TBL TRANSFER_SESSION FILES,
STBL_FILES

started via

The name of the application (Aspera
or custom) that is responsible for
initiating the transfer (for example,
aspera.scp, aspera.sync, etc.).

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

status

Status of transfer or file (for example,
"running," "completed," "canceled" or
"error").

STBL_TRANSFERS,
STBL_TRANSFER_SESSIONS,
$STBL_TRANSFER_SESSION_FILES,
STBL_FILES
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Database Field

Description

Table

stopped_at

Date and time that a transfer or file
stopped (value is blank if transfer or
file is still active).

STBL_TRANSFERS,
STBL_TRANSFER_SESSIONS,
$TBL_TRANSFER_SESSION_FILES,
S$TBL_FILES

target_rate

Target transfer rate.

$TBL _TRANSFERS,
$TBL _TRANSFER SESSIONS

tmp_actual rate

Reserved for future use.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

tmp_actual rate calculated at

Reserved for future use.

$TBL_TRANSFERS,
$TBL_TRANSFER SESSIONS

tmp_loss_pct

Reserved for future use.

$TBL TRANSFER SESSIONS

token

Security token used for the transfer
(note that this depends on whether
or not the application that started the
transfer is configured to use tokens).

$TBL TRANSFERS,
$TBL TRANSFER SESSIONS

transfer file id

Corresponds to the file ID field

$TBL TRANSFER SESSION FILES

transfer_id

Corresponds to ID field.

$TBL _TRANSFER SESSIONS,
$TBL_FILES

transfer session_id

Corresponds to transfer session ID
field

$TBL _TRANSFER SESSION FILES

transfer uuid

Universally, unique ID that is used

to identify the transfer as a whole.
May contain multiple sessions and is
generated by application that started
the transfer. Generally only populated
by transfers started by Console.

$TBL _TRANSFERS,
$TBL_TRANSFER SESSIONS

logging (for managed nodes only).

transport fasp2 for Aspera protocol, "http" for $TBL TRANSFER SESSIONS
fallback protocol

type Managed or unmanaged node. $TBL _NODES

udp_port Node machine's UDP port. $TBL NODES

use_ssh_tunnel Set up an SSH tunnel for database $TBL _NODES

generated on the node when installing
Aspera software (for managed nodes
only)

usecs Length of the transfer session (in $TBL _TRANSFERS,
milliseconds). Not authoritative $TBL TRANSFER SESSIONS,
(use only for transfer sessions and $TBL_TRANSFER SESSION FILES,
transfers). $TBL_FILES

uuid Universally, unique identifier that is $TBL_NODES

Important: If you have configured custom fields, they will be prefixed with "cf ". Custom fields are utilized in
the STBL FILES and $STBL TRANSFER tables. Please note that if you would like to add additional custom fields,
you may do so via the Configuration > Custom Fields. For instructions on setting up a custom field, see Creating

Custom Fields on page 88.
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Advanced Report Usage Notes

Advanced Report Usage Notes: Avoid Duplicating Identical Records

Console's security filtering prioritizes speed over the cost of potentially returning duplicate records. It is up to the
report writer to remove duplicate records returned when querying report tables directly.

For example, a user unaware of Console internals might expect the following to always return no more than a single
record:

SELECT ts.*
FROM
$TBL_TRANSFER SESSIONS ts
WHERE
ts.session id='ed0a9%b4039%bb40dfa86690ff7elf6fa2’

12

However, depending on the user's group memberships and permissions, the above could return multiple identical
records. To correct this, use SELECT DISTINCT. For example:

SELECT DISTINCT ts.*
FROM
$TBL_TRANSFER SESSIONS ts
WHERE
ts.session id='ed0a9%b4039%bb40dfa86690ff7elf6fa2’

12

Be aware that this means you cannot directly perform aggregate computations--such as SUM, AVERAGE, or
COUNT--on the reporting tables. For example, in the following, total bytes transferred could count some sessions
multiple times:

SELECT DISTINCT

ts.contact

;, SUM(ts.bytes transferred) AS total bytes transferred
FROM

STBL TRANSFER SESSIONS ts
WHERE

Instead, first extract just the data of interest to a temporary table, then summarize from there:

# Create holding table for filtered raw data
CREATE TABLE $TMP_FILTERED_TRANSFER_SESSIONS (
“id® INT(11) NOT NULL AUTO_ INCREMENT PRIMARY KEY
, ~contact’® VARCHAR (255)
, bytes transferred™ BIGINT (20)
) ;

# Extract relevant data (very important to include ts.id)
INSERT INTO $TMPiFILTEREDiTRANSFERﬁSESSIONS
SELECT DISTINCT

ts.id

, ts.contact

, ts.bytes transferred
FROM $TBL_TRANSFER_SESSIONS ts
WHERE

ts.started at < 'SREPORT PERIOD END'

AND (

ts.stopped at >= 'S$REPORT PERIOD START'
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OR ts.stopped at IS NULL
) ;

# Summarize by contact
CREATE TABLE $FINAL_RESULT_TABLE
SELECT

fts.contact

;, SUM(fts.bytes transferred) AS total bytes transferred
FROM

$TMP FILTERED TRANSFER SESSIONS fts
GROUP BY

fts.contact
ORDER BY

fts.contact

’

Advanced Report Usage Notes: Avoid Duplicating Redundant Records

Transfers between two managed nodes create two records per file, one in $TBL_TRANSFER_SESSION_FILES
and one in $TBL_FILES.

If both source and destination are managed nodes, then both sides log to the database. These records will not be
identical--the record logged by the server reports the server-side path, while the record logged by the client reports the
client-side path. Sometimes other fields, such as err_desc, may differ as well.

There are several fields in the canonical tables supplied specifically to address this issue:

Field Name Description Tables

reported_by both_sides |0 if transfer was only logged by | STBL._ TRANSFERS
one side.

1 if transfer was logged by both
server and client.

reported_by server 0 if the file record was logged | $TBL_FILES
by the client. $TBL_TRANSFER_SESSION_FILES

1 if the file record was logged
by the server.

initiated_by_source 0 if transfer is a pull (clientis | $STBL_TRANSFERS
the destination). $TBL_TRANSFER_SESSIONS $TBL_FILES

1 if transfer is a push (client is STBL_TRANSFER_SESSION_FILES

the source).

To ensure that each file is present only once in a result set, we need to use the above fields to give precedence to the
record from one side or the other.

Note: The previous caveat about record duplication (Advanced Report Usage Notes: Avoid Duplicating Identical
Records on page 181) also applies (i.e. the file record reported by the server node could itself be returned multiple
times, as well as the record reported by the client node).

Note: Certain edge cases cause a problem even when using the above filter. For example, if both nodes start reporting
a transfer session and one node loses its connection to the database, then reported_by_both_sides will equal 1, but
not all of the file records will have two records in the file tables.

The following SQL example, taken from the built-in Activity Summary By Contact report, gives the destination-
side file record precedence in cases where both sides logged the transfer.



# Set variables to hold report datetime parameters
# (all datetimes are converted to UTC)

#

SET @report period start = 'SREPORT PERIOD START';
SET @report period end = 'SREPORT PERIOD END';
fmmm=m=mmmmmee e e
# PRE-FILTER RECORD IDS

# Initially retrieve just the id columns from

# base tables (improves performance by avoiding

# queries with more than one join)

CREATE TABLE S$TMP_ TRANSFER IDS (
id INT NOT NULL PRIMARY KEY
, reported by both sides TINYINT (1) NOT NULL DEFAULT O
) ;
CREATE TABLE S$TMP_ TRANSFER SESSION IDS (
id INT NOT NULL PRIMARY KEY
, reported by both sides TINYINT (1) NOT NULL DEFAULT O
);
CREATE TABLE STMP FILE SESSION IDS (
id INT NOT NULL PRIMARY KEY
, transfer session id INT NOT NULL
)i

INSERT INTO STMP_ TRANSFER IDS
SELECT DISTINCT
t.id
, t.reported by both sides
FROM S$STBL TRANSFERS t
WHERE
(t.started at < @report period end
AND (t.stopped at >= @report period start
OR t.stopped at IS NULL

# Transfer Sessions
# (copy over 'reported by both sides'
# from transfers)

INSERT INTO $TMP TRANSFER SESSION IDS
SELECT DISTINCT
ts.id
, t.reported by both sides
FROM STBL TRANSFER SESSIONS ts
JOIN $TMP TRANSFER IDS t
ON ts.transfer id = t.id
WHERE
(ts.started at < @report period end
AND (ts.stopped at >= (@report period start
OR ts.stopped at IS NULL
)
)
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# File Sessions (choose destination-side
# info if both sides logged to db)

INSERT INTO $TMP FILE SESSION IDS
SELECT DISTINCT
fs.id
, fs.transfer session_ id
FROM $TBL_ TRANSFER SESSION FILES fs
JOIN $TMP TRANSFER SESSION IDS ts
ON fs.transfer session id = ts.id
WHERE
(fs.started at < @report period end
AND (fs.stopped at >= Qreport period start
OR fs.stopped at IS NULL)
)
AND (ts.reported by both sides=0
OR (
(fs.reported by server=1
AND fs.initiated by source=1)
OR (fs.reported by server=0
AND fs.initiated by source=0)
)
)

CREATE INDEX idx transfer session_ id
ON $TMP_FILE SESSION IDS (transfer session id);

Advanced Report Usage Notes: Filter on Raw Values

Filtering on computed values in most cases prevents MySQL from being able to take advantage of indexes. For
example, the following will force a scan of every record in TBL._TRANSFER_SESSIONS, because MySQL has to
perform the CONVERT( ) on ts.started_at for every record:

SELECT DISTINCT ts.*
FROM
STBL_ TRANSFER SESSIONS ts
WHERE
CONVERT (ts.started at, DATE) = DATE (NOW())

Instead, compute the correct criteria to compare the raw value against:

SET @todays date = DATE (NOW()) ;

SET @tomorrows date = DATE ADD(Q@todays date, INTERVAL 1 DAY);
SELECT DISTINCT ts.*

FROM

$TBL TRANSFER SESSIONS ts
WHERE

ts.started at >= @todays_date

AND ts.started at < @tomorrows_ date

12

Note: Even the above will only give expected results if you are in GMT time zone, as NOW( ) will return UTC time.

The builtin report variables SREPORT_PERIOD_START and SREPORT_PERIOD_END contain datetimes
converted from local time zone of input into UTC and are usually a better choice for date filtering (unless recipient is
fine with UTC-based filtering).
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Advanced Report Usage Notes: Filter Strings by Using "Begins With"

If possible, filter strings by matching “begins with” rather than “contains” or “ends with”. If that's not possible,
consider creating a custom field. For example, the following will not be able to use the index on ts.contact:

SELECT DISTINCT ts.*
FROM
$STBL_TRANSFER SESSIONS ts
WHERE
ts.contact LIKE '%Euro2012 Livex%'

12

If you know all the possible ways the string could begin, you could enumerate them like this:

SELECT DISTINCT ts.*
FROM
$TBL_TRANSFER SESSIONS ts
WHERE
ts.contact LIKE 'AA Euro2012 Livex%'
OR ts.contact LIKE 'BB Euro2012 Livex%'
OR ts.contact LIKE 'CC Euro2012 Livex%'

r

If the report is only to be run for a small date range and there are few transfer sessions then you may not need to
worry about this. If you expect to be running over large date ranges and large numbers of sessions, then you should
create a custom field that detects the presence of the match string and then copies it to the custom field -- you could
then filter on the custom field instead.

Advanced Report Usage Notes: Always Include a Date Filter

To avoid creating a report that might try to work on the entire database you should always include some kind of date
filter.

The recommended option is to use the built-in report variables SREPORT_PERIOD_START and
SREPORT_PERIOD_END to filter data. If an advanced report contains these variables, the web UI will include
date pickers when the user runs the report. A standard filter to find all transfers that were active at any time during the
report period would look like the following:

SELECT DISTINCT

ts.id

, ts.contact

, ts.bytes transferred

FROM
$TBL_TRANSFER SESSIONS ts

WHERE

ts.started at < 'SREPORT PERIOD END'
AND (
ts.stopped at >= 'SREPORT PERIOD START'
OR ts.stopped at IS NULL
) ;

Note the clause OR ts.stopped at IS NULL. Without this, the report would exclude any transfers that
were still running at the time the report was run. Depending on the intended purpose of the report, you might need
to prorate data for transfers that were active for only part of the reporting period, such as cases 2, 3, and 4 in the
following:
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report report
start end

| |
! case 1 » ‘

case2 »

CEIE‘;ES >

case 4 : >

As an alternative, you can avoid the use of SREPORT_PERIOD_START and SREPORT_PERIOD_END if you
are creating a report that always looks at the last X hours:

SET @min_start = DATE_SUB(NOW(), INTERVAL 24 HOUR);
CREATE TABLE $FINAL RESULT TABLE
SELECT DISTINCT ts.*
FROM
$TBL_TRANSFER SESSIONS ts
WHERE

ts.started at >= @min start

’

Note: As of Console 1.6 there is a bug in the report engine that causes the creation of Excel/CSV files to fail if you
do not reference SREPORT_PERIOD_START and SREPORT_PERIOD_END at all. To work around this, include
a dummy reference in the report SQL. For example:

SET @dummy = 'SREPORT PERIOD START';

When running the report, users are then asked for report period dates, but they will be ignored.

Advanced Report Usage Notes: Always Name Your Computed or Aggregated Columns

Always name your computed or aggregate columns, and avoid names that might be reserved words. In particular, do
not call a final result column "name", "count", "id", and so on.

B

INCORRECT:

CREATE TABLE $FINAL_RESULT_TABLE
SELECT

fts.contact

, COUNT (*)

; SUM(fts.bytes transferred)

CORRECT:

CREATE TABLE SFINAL RESULT TABLE
SELECT
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fts.contact
, COUNT (*) AS session_count
;, SUM(fts.bytes transferred) AS total bytes transferred

Advanced Report Usage Notes: Avoid Joining Reporting Views

MySQL often mis-optimizes queries that join reporting views directly to each other. The fact that the views can show
the same record multiple times can cause a geometric explosion in the number of temporary records inspected.

EXAMPLE:

# Find all sessions that contained file "foo.txt"
# List both session info and file info
# ASSUMES NO SESSIONS WERE BETWEEN TWO MANAGED NODES
SET @report period start = 'SREPORT PERIOD START';
SET Qreport period end = 'SREPORT PERIOD END';
CREATE TABLE $FINAL_RESULT_TABLE
SELECT DISTINCT
ts.session_id
ts.source ip
ts.dest ip
ts.started at
ts.stopped at
ts.status
tsf.file fullpath
tsf.size
tsf.started at AS file started at
tsf.stopped at AS file stopped at
, tsf.status AS file status
FROM
STBL_TRANSFER SESSIONS ts
JOIN $TBL TRANSFER SESSION FILES tsf
ON ts.id = tsf.transfer session id
WHERE
tsf.started at < @Qreport period end
AND (
tsf.stopped at >= @report period start
OR tsf.stopped at IS NULL
)
AND tsf.file basename = "foo.txt"
ORDER BY
ts.started at
, tsf.started at

N N SN N SN SN N NN

Although the above report uses SELECT DISTINCT, contains no aggregate functions such as COUNT and SUM,
and generates a correct final result (unless any of the transfer sessions were between two managed nodes), it is
potentially slow. For greater speed (and to prevent query misoptimization from MySQL), it is better to decompose the
above query into smaller steps, and join your temporary tables to the report views instead of joining the report views
together directly.

Note: In order to avoid complexity in the SQL, the example below assumes no sessions were between two managed
nodes. Therefore, the code for dealing with this has been left out (see Advanced Report Usage Notes: Avoid
Duplicating Redundant Records on page 182).

EXAMPLE

SET Q@report period start = 'SREPORT PERIOD START';
SET @report period end = 'SREPORT PERIOD END';



CREATE TABLE S$TMP TRANSFER SESSION IDS (

id INT NOT NULL PRIMARY KEY
) 8

CREATE TABLE S$TMP TRANSFER SESSION FILE IDS (

#
#

id INT NOT NULL PRIMARY KEY
, transfer session id INT NOT NULL
)i

Create table to hold all desired fields from
transfer sessions

CREATE TABLE S$TMP TRANSFER SESSION DATA (

#
#

C

“id® INT(11) NOT NULL AUTO INCREMENT PRIMARY KEY

, session id® VARCHAR(36)
, ~source ip  VARCHAR(255)
, dest ip  VARCHAR (255)

, started at® DATETIME

, stopped at® DATETIME

, status’ VARCHAR (255)

Create table to hold all desired fields from
transfer session files

REATE TABLE STMP TRANSFER SESSION FILE DATA (

“id® INT(11) NOT NULL AUTO INCREMENT PRIMARY KEY

, transfer session id’ INT(11)
, started at® DATETIME

, stopped at’ DATETIME

, ~Sstatus’® VARCHAR (255)

, file fullpath® TEXT

, ~size’ BIGINT (20)

For this report, we know we are
filtering on file name and can use
the index on that column, so it is
faster to find the records from
transfer session files first

INSERT INTO $TMP TRANSFER SESSION FILE IDS

S

F

ELECT DISTINCT

tsf.id

, tsf.transfer session id

ROM STBL TRANSFER SESSION FILES tsf

WHERE
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tsf.started at < @Qreport period end
AND (
tsf.stopped at >= @report period start
OR tsf.stopped at IS NULL
)
AND tsf.file basename = "foo.txt"

# Create an index on the join field -

# for speed, we wait until table is

# populated instead of defining the index
# during initial creation of table

CREATE INDEX idx transfer session_ id ON
$STMP_TRANSFER SESSION FILE IDS (transfer session id);

INSERT INTO $TMP_ TRANSFER SESSION IDS
SELECT DISTINCT ts.id
FROM S$STBL TRANSFER SESSIONS ts
JOIN $STMP TRANSFER SESSION FILE IDS tsf
ON ts.id = tsf.transfer session id
WHERE
ts.started at < Q@report period end
AND (
ts.stopped at >= (@report period start
OR ts.stopped at IS NULL

~.

Remove transfer file sessions that don't have an
associated transfer session record

(normally not supposed to happen, but we want
to protect against bad data that might be
caused by system crash, logger errors, console
purge errors, Canonicalizer shutdown, etc.)

For this particular report, this is not needed
since the final join will weed out such records,
but it is a good habit to maintain, this report
could be modified later into one where

it would make a difference.

= = S S S Sk S Sk S S S S Sk

DELETE tsf.*

FROM $TMP_TRANSFER SESSION FILE IDS tsf
LEFT JOIN STMP TRANSFER SESSION IDS ts
ON tsf.transfer session id = ts.id

WHERE ts.id IS NULL;

#
# Get all desired fields

INSERT INTO $TMP TRANSFER SESSION FILE DATA (
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, transfer session id"
, ~started at’

, stopped at’

, ~status’

, file fullpath’

, size’

SELECT DISTINCT
tsf.id
, tsf.transfer session id
, tsf.started at
, tsf.stopped at
, tsf.status
, tsf.file fullpath
, tsf.size
FROM
$TMP_TRANSFER_SESSION_FILE_IDS tsf ids
STRAIGHT JOIN $TBL_TRANSFER_SESSION_FILES tsf
ON tsf ids.id = tsf.id

CREATE INDEX idx transfer session_ id ON
$TMP_TRANSFER _SESSION FILE DATA ( transfer session id’);

INSERT INTO $TMP_TRANSFER_SESSION_DATA (
id

, ~session id’

, ~source ip°

, “dest ip°

, started at’

, stopped at’

, status’

SELECT DISTINCT
ts.id
, ts.session id
, ts.source ip
, ts.dest ip
, ts.started at
, ts.stopped at
, ts.status
FROM
$TMP TRANSFER SESSION_ IDS ts_ids
STRAIGHT JOIN STBLiTRANSFERisESSIONS ts
ON ts ids.id = ts.id

r

#
# Create final result table

CREATE TABLE SFINAL RESULT TABLE
SELECT
ts.session_ id
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ts.source ip
ts.dest ip
ts.started at
ts.stopped at
ts.status
tsf.file fullpath
tsf.size
tsf.started at AS file started at
tsf.stopped at AS file stopped at
, tsf.status AS file status
FROM
STMP TRANSFER SESSION DATA ts
JOIN $STMP TRANSFER SESSION FILE DATA tsf
ON ts.id = tsf.transfer session id
ORDER BY
ts.started at
, tsf.started at

N N SN SN SN SN SN N N

12

Example Reports

Basic Report Example: Faspex User Activity

The following example demonstrates the process of creating a new, basic report (following the instructions described
in Creating a Basic Report on page 83) for Faspex users. In our example, we will generate a report that displays
transfer activity by Faspex users only. The example report, once generated, will display total bytes transferred by each
Faspex Server user, along with file and transfer-level detail (where a transfer groups together transfer sessions into a
single item).

1. Go to the Manage Report Types page.

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

2. Configure your basic report to display file- and transfer-level details, organized by Faspex Users.

On the Create New Report Type page (for basic reports), enter the following information:
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Dashboard Activity Nodes Accounts Transfer Reports Notific ations

Reports

= Create New Basic Report Type

HMame
limit 75 characters

Description

» How would you like to organize this report?

select v
Field Description
Name Basic Faspex User Report
Description Basic Faspex Server User report, which includes total bytes per Faspex User, as

well as file- and transfer-level details.

How would you like to Select "Contact," "Transfer," and "File" as the fields by which to organize this
organize this report? report. In doing so, the report will be grouped by the following fields:

* Contact (Contact assigned by Console. This can be a Console user name, a
Faspex Server user name, SSH account, or customized value obtained from
a transfer cookie. Examples: "admin (console)", "aspera (ssh)", "michael
(faspex)".)

* Transfer (Human-readable name assigned to a transfer. A transfer represents
one or multiple executions of ascp (that is, one or multiple attempts to transfer).)

* File (File's name)

Columns to include Select the following basic fields to include as columns:

* bytes transferred
» average rate

+ files completed
+ files failed

+ started at

+ stopped at
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Field Description

+ status

+ error description

* source address

* destination address

Note: When you select a field, its definition will appear in the box below.
Sort Select the following fields to sort data inside your groups:

» Sort your contact groups by contact name.

* Sort your transfer groups by the time that the transfer started.

» Sort your file groups by file name.

Select ascending order for all fields.
Filters To narrow down the report so that only Faspex Users are displayed, specify the

Transfer Contact field as ending with the value (faspex).

3. Save, finalize run settings, and run your report.

Next, click the Create and Run button. Confirm the following settings on next page:

Title is as described above.

Report is scheduled to Run Now.

Report period is Month to date and time zone is Pacific.
Sorting is as described above.

Filter is as described above.

XLSX file format is checked.

Once confirmed, click the Run Report button.
4. View your Web and XLSX reports.

After clicking the Run Report button, the page updates to display the report queuing and then running. Once
generated, the Web version of your basic report appears as shown below.



Report: Basic Faspex User Report

As of 2013-06-12 11:45:09 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/12/2013 11:45 AM (PDT)
Transfer Contact ending with (faspex)

Bytes Transferred Average Rate Files Completed

- TOTAL: 118,168,806 0,453,504 10
~ admin (faspex) 104,969,480 0,330,620 5
- test package (upload) 47,308 383,184 2

o device.txt 488 3,904 1

o logeat.txt 47 410 379,280 1

- test 4 (upload) 104,857,600 9,320,676 1

o 100MB 104,857,600 0,320,676 1

» test 5 (upload) 63,982 511,856 2

~ user] (faspex) 13,199,326 10,550,461 5
» test 2 (upload) 11,072,036 11,072,936 4

- test 3 (upload) 2,126,390 8,505,560 1

© Snow.jpg 2,126,300 8,505,560 1

Files Failed

ol oo o o o o o o o o o
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Started At

2013-06-12 11:
2013-06-12 11:
2013-06-12 11:
2013-06-12 11:
2013-06-12 11
2013-06-12 11:

2013-06-12 11:
2013-06-12 11:
2013-06-12 11:

10:21
19:22
19:22
41:54
41:55
44:47

40:26
41:00
41:01

Stopped At

2013-06-12 11:19:23

2013-06-12 11:19:22

2013-06-12 11:19:22

2013-06-12 11
2013-06-12 11
2013-06-12 11

2013-06-12 11
2013-06-12 11
2013-06-12 11

-43:25
“43:25
44:48

-40:36
41:03
41:03

SX

Status  Error Source Address
completed 10.0.200.82
completed 10.0.200.82
completed 10.0.200.82
completed 10.0.200.8
completed 10.0.200.8
completed 10.0.200.82
completed 10.0.200.8
completed 10.0.200.8

10.0.200.8

m

View SQL

As you can see, the report's data is grouped and sorted in the following manner:

» Faspex Users

» Transfers (per Faspex User), which are sorted by the time they started

File name (per Transfer)

completed

In addition, all data columns appear as selected on the Create Advanced Report Type page. To download the Excel
version of the report for use in other applications, click the XLSX button.

Basic Report Example: Hot Folder Activity

The following example demonstrates the process of creating a new, basic report (following the instructions described
in the topic Creating a Basic Report on page 83) for Hot Folder transfers. In our example, we will generate a
report that displays transfer activity for Hot Folders that have been set up within Aspera Enterprise (or Connect)

B | [ [ D [ E [ F [ G H | I [
[BasigFaspexlserReport1_2013-06-12_184513_UTC xls
2 |BasicFaspex User Report
3 |Generated By: cheng
4 |Generated At: 2013/06/12 11:45:09 (GMT-06:00) Pacific Time (US & Canada)
5 |Report Period Start: 06/01/2013 12:00 AM
6 |Report Period End’ 06/12/2013 11:45 AM
7 |Report Time Zone: Pacific Time (US & Canada)
]
9 |Level Row Type Heading Bytes Transferred  Awverage Rate Files Completed Files Failled  Started At Stopped At Status Error’
10 0 Grand Total TOTAL: 118,168,806 9,453,504 10 0
11 1 Contact admin (faspex) 104,968 480 9,330,620 ] 0
12 2 |Transfer test package (upload) 47,898 383,184 2 0| 2013/06/1211:19:21  2013/06/12 11:19:23 completed
13 3 File device.txt 488 3,904 1 0 2013/06M12 11:19:22 2013/06/12 11:19:22 completed
14 3 File logcat. txt 47,410 379,280 1 0 2013/06/12 11:19:22  2013/06/12 11:19:22 completed
15 2 |Transfer test 4 (upload) 104,857,600 9,320,676 1 0 2013/06/12 11:41:54  2013/06/12 11:43:25 completed
16 3 File 100MB 104,857,600 9,320,676 1 0 2013/06/12 11:41:556  2013/06/12 11:43:25 completed
17 2 |Transfer test 5 (upload) 63,962 511,856 2 0 2013/06/12 11:44:47  2013/06/12 11:44:48 completed
18 3 File China 1.PNG 31,464 251,712 1 0 2013/06/12 11:44:48  2013/06/12 11:44:48 completed
19 3 [File China 2.PNG 32,518 260,144 1 0 2013/06/12 11:44:48  2013/06/12 11:44:48 completed
20 1 Contact userl (faspex) 13,199,326 | 10,559,461 5 0
2 2 Transfer test 2 (upload) 11,072,936 | 11.072,936 4 0 2013/06/12 11:40:26  2013/06/12 11:40:36 completed
2 3 [File Blue Pond jpg 3,864,665 7,729,330 1 0 2013/06/12 11:40:26  2013/06/12 11:40:30 completed
3 3 File Bristle Grass.jpg 1,869,268 | 15,114,304 1 0 2013/06/12 11:40:31  2013/06/12 11:40:31 completed
24 3 [File Lake_jpg 913,673 7,309,384 1 0 2013/06/12 11:40:32  2013/06/12 11:40:32 completed
25 3 File Lion.jpg 4,408,310 8.610.620 1 0 2013/06/12 11:40:32  2013/06/12 11:40:36 completed
26 2 Transfer test 3 (upload) 2,126,390 8,505,560 1 0 2013/06/12 11:41:00  2013/06/12 11:41:03 completed
Worksheetl U 4 1 (3

] »

mn
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Server, Point_to Point and Client. The example report, once generated, will display Hot Folder transfer start time, end
time and the number of files transferred.

1. Go to the Manage Report Types page

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

2. Configure your basic report to display file- and transfer-level details, organized by Faspex Users

On the Create New Report Type page (for basic reports), enter the following information:

Dashboard Activity Nodes Accounts Transfer Reports Notifications

Reports

= Create New Basic Report Type

Mame
limit 75 characters

Description

= How would you like to organize this report?

select v
Field Description
Name Basic Hot Folder Transfer Report
Description Basic Hot Folder Transfer report, which includes start time, stop time and the

number of files that were transferred.

How would you like to Select "Transfer" as the field by which to organize this report. In doing so, the
organize this report? report will be grouped the human-readable name that has been assigned to each hot
folder transfer. A transfer represents one or multiple executions of ascp (that is., one
or multiple attempts to transfer).

Columns to include Select the following basic fields to include as columns:

+ started at
* stopped at
+ files completed
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Field Description

* average rate

Note: When you select a field, its definition appears in the box below.

Sort Select the "transfer name" field (in ascending order) to sort data inside your group.

Filters In this example, we must set a filter that checks the value of the transfer cookie.
When files are transferred using Hot Folders, the transfer cookie contains the
following information:

aspera.sync?2:

Thus, the filter must be set to only include transfers that have a transfer cookie
starting with the value aspera.sync2:.

3. Save, finalize run settings, and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

+ Title is as described above
* Report is scheduled to Run Now
* Report period is Month to date and time zone is Pacific
» Sorting is as described above
» Filter is as described above
Once confirmed, click the Run Report button.
4. View your Web report.

After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report appears as shown below.

Report: Basic Hot Folder Transfer Report

As of 2013-06-12 14:00:50 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/12/2013 02:00 PM (PDT)
Transfer Cookie starting with aspera.sync2:

Started At Stopped At Files Completed Awverage Rate

~ TOTAL: 13 7,697,113
o New folder 2013-06-12 13:47:15 2013-06-12 13:47:52 2 724

o Mew folder 2013-06-12 13:47:55 2013-06-12 13:47:57 10 43,844

o New folder 2013-06-12 13:58:09 2013-06-12 13:58:19 1 11,983,726

View SQL

Basic Report Example: Faspex Metadata

The following example demonstrates the process of creating a new, basic report (following the instructions described
in the topic Creating a Basic Report on page 83) for Faspex metadata. In our example, we will generate a report

that displays the metadata that is entered into a "Create New Package" form within Faspex, which is accomplished by
creating a new, custom field called "Event" within Console.
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Note: This example assumes that the "event" (metadata) field has already been set up on the Faspex node. When
creating a new Faspex package, Faspex users can select from a predefined (drop-down) list of events, which populates
the database for this custom field.

The

example report, once generated, will display the purpose (or "Event") of the Faspex package, as well as file-level

detail, transfer-level detail (where a transfer groups together transfer sessions into a single item), and which Faspex

user

sent the package.

1. Setup a Console database custom field for the metadata.

Within Console, select Configuration from the main menu, and then the Custom Fields tab. Create a new,
custom field with the following attributes:

Level: Select "transfer"
Name: Enter the name "event"
Start Date: Enter "2011-01-01"

Description: Since this custom field is for the metadata report, enter the description "Faspex Metadata report
demo"

For more information on custom fields, see Creating Custom Fields on page 88.

Next, click the Create button and enter the following information:

Field Value

Built-in field Faspex Metadata

Operator matching regular expression
Expression \{.*"Event":"(?<event>.+?)".*\)
Custom Field Value <event>

» New Rule for Custom Field: event

Rule name Rule 1

If the following conditions are met:

Built-in field NOT  Operator Expression
Faspex Metadata v matching regular expression v M. Event™:"(?<event=.+7)"."]} e maove
choose field. .. v

Then set the 'event’ custom field value to:

<event>

Create

In the rule example above, a rule is created that states if the conditions match the regular expression, then set the

event" custom field value to the Faspex metadata value.

The regular expression is interpreted as follows:
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\{.*"Event":" (?<event>.+?2)".*\}

\ { — Find a left curly bracket character

o — followed by 0 or more characters that don’t match "Event": " (this is text to
ignore, such as other metadata fields)

"Event":" — followed by the exact text "Event": "

(?<event>.+?) — followed by at least 1 character that is not a quotation mark [* (save these
characters and call them <event>),

" — followed by a quotation mark
o — followed by 0 or more characters that don’t match a right curly bracket: \ }

\ '} — followed by a right curly bracket character

The following example of decoded metadata for a Faspex cookie shows what the regular expression matches:
{"Event":"Summer"," pkg uuid":"abde20e28db24bfdb513c0a3de3bb8ff"
" pkg name":"test"," created utc":"2013/06/13 00:53:47 +0000",
" metadata profile name":"Event"," metadata profile uuid":
"2de58bd85e704107bd7233d98db2030b", " metadata profile version"}

When finished, click Create to create the new rule.

On the next page, click the Back to Custom Fields tab or the Custom Fields tab. Locate the entry for the field
you just created ("event" in this case), and click recalculate.

. Go to the Manage Report Types page

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

. Configure your basic report to display contact, file-level, and transfer-level details, organized by Faspex metadata
(the "event").

On the Create New Report Type page (for basic reports), enter the following information:



Dashboard
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Activity Nodes Accounts Transfer Reports Motifications

Reports

= Create New Basic Report Type

Mame

Description

limit 75 characters

» How would you like to organize this report?

select v
Field Description
Name Faspex meta data report
Description Based on the custom field "event." Includes metadata, contact, file-level, and

transfer-level details.

How would you like to
organize this report?

Select "Event" (which is a custom field), "Contact," "Transfer" and "File" as the
fields by which to organize this report. In doing so, the report will be grouped by
the following:

+ Event (Based on a transfer-level rule that states if the conditions match the
regular expression, then set the "event" custom field value to the Faspex
metadata value.)

* Contact (Contact assigned by Console. This can be a Console user name, a
Faspex Server user name, SSH account, or customized value obtained from
a transfer cookie. Examples: "admin (console)", "aspera (ssh)", "michael
(faspex)".)

* Transfer (Human-readable name assigned to a transfer. A transfer represents
one or multiple executions of ascp (i.e., one or multiple attempts to transfer).)

+ File (File's name)

Columns to include

Select the following basic fields to include as columns:

+ started at
* stopped at
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Field Description

* bytes transferred

+ status

* average rate

* cookie

Note: When you select a field, its definition will appear in the box below.
Sort Select the following fields to sort data inside your groups:

* Sort your metadata groups by event/metadata name

+ Sort your contact groups by contact name

» Sort your transfer groups by transfer name

» Sort your file groups by file name

Select ascending order for all fields.
Filters Filter the report so that only fields with metadata appear (that is, event is not

NULL) and only data from Faspex Users is displayed (that is, transfer contact
contains the value faspex).

4. Save, finalize run settings and run your report.

Next, click the Create and Run button. Confirm the following settings on next page:

Title is as described above.

Report is scheduled to Run Now.

Report period is Month to date and time zone is Pacific.
Sorting is as described above.

Filter is as described above.

Once confirmed, click the Run Report button.

5. View your Web report.

After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report will appear as shown below.



Report: Faspex meta data report

As of 2013-06-13 17:40:01 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/13/2013 05:39 PM (PDT)
Transfer Contact containing faspex, Event NOT NULL

= TOTAL:
- Autumn Trip
~ admin (faspex)
+ video (upload)
o Wildlife.wmv
+ Spring Trip
= admin (faspex)
+ photos {upload)
= test 2 {upload)
© Japan 1.PNG
o Japan 2.PNG
» test] (upload)

Started At

2013-06-13 17:33:07

2013-08-13 17:33:08

2013-06-13 17:34:31
2013-06-13 17:32:13
2013-06-13 17:32.18
2013-06-13 17:32:19

2013-08-13 17:31:43

Stopped At

2013-06-13 17:33:36

2013-08-13 17:33:36

2013-06-13 17:34:33
2013-06-13 17:32.19
2013-06-13 17:32.19
2013-06-13 17:32.19

2013-08-13 17:31:45

Bytes Transferred
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Status Average Rate Cookie
44,397,720' | 7,721,343'
26,246,026 7,498,865
26,240,020 7,408,865

26,246,026 completed
26,246,026 | com pleted
2,184,528
2,184,528
2,061,558 | completed
58,988 completed
20,029 completed
20,959 com pleted

63,982 completed

7,408,865 aspera.faspex20:u:f47697ae-c723-404¢c-bed’

7,408 865 aspera faspex20-u-f47607ae-c720-404c-bed

5,825,408

5,825,408

8,246,232 asperafaspex20:u:edc7b031-cc60-4010-b7fi
471,904 asperafaspex20:u:b5a46448-c103-4927-aeC
232,232 aspera.faspex20:u:b5a40448-c103-4027-ael
230,672 aspera.faspex20:u:b5a46448-c103-4227-aeC

511,856 aspera faspex20-u:8c4b05ba-cc7 3-404d-0c0

b Summer 163,248 1,305,084
» Winter 15,760,522 0,608,783
¢ Winter Trip 43,396 347,168
I 1 3

View SQL

As you can see, the report's data is grouped and sorted in the following manner:

* Metadata

» Faspex Users that selected the corresponding event/metadata

» Transfers (per Faspex User), which are sorted by the time they started
* File name (per Transfer)

In addition, all data columns appear as selected on the Create Basic Report Type page.

Advanced Report Example: Transfer Sessions with High Packet Loss

The following example demonstrates the process of creating a new, advanced report (following the instructions
described in the topic Creating an Advanced Report on page 84) for transfers with high packet loss. In our

example, we will generate a report that displays a list of all transfers that have high packet loss, where high loss is
user specified. The report includes transfers that started before the report period start, as well as ones that ended after
the report period end, as long as part of the transfer fell within the reporting period. Note that the data is not prorated,
meaning that the "bytes transferred," "files complete" and other values show totals for the entire transfer, even if part
of the transfer took place outside the reporting period.

1. Go to the Manage Report Types page.

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Advanced button.

2. Input your advanced report's name and description.

On the Create New Advanced Report Type page, enter the following information:

Field Description

Name Transfer Sessions with High Packet loss
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Field Description

Description Displays a list of all transfers that have high packet loss.

3. Create your SQL script.

Important: For assistance on SQL variables and a fields reference guide, please click the Help link.

CREATE TABLE SFINAL RESULT TABLE

SELECT DISTINCT -- prevents duplicate rows (that is, overlapping
permissions)
ts.name
ts.contact
ts.bytes transferred
ts.bytes lost
TRUNCATE ( (ts.bytes lost)*100/ (ts.bytes transferred + ts.bytes lost),
AS “packet loss %°
ts.source ip AS “from®
ts.dest ip AS “to°
ts.started at
ts.stopped at
ts.status
ts.files complete
ts.files failed
ts.files skipped

~ N N N N

N N N SN N N N N

FROM
$TBL_TRANSFER SESSIONS ts

WHERE
((ts.bytes lost * 100) /(ts.bytes lost + ts.bytes transferred)) >=
SPACKET LOSS /* Custom/configurable variable */
AND
ts.started at < 'SREPORT PERIOD END'
AND (
ts.stopped at >= 'SREPORT PERIOD START'
OR ts.stopped at IS NULL
)

ORDER BY
5 DESC
, 8

Important: For demonstration purposes, we have created a configurable/custom variable called

$PACKET LOSS in the SQL script text above. You may, alternatively, utilize the built-in SQL database field

avg loss_pct, to display the average packet loss over the network (as a percentage). Please see the Help link in the
application for details.

4. Save, finalize run settings and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

+ Title is as described above.

* Report is scheduled to Run Now.

* Report period is Last 24 hours and time zone is Pacific.
Once confirmed, click the Run Report button.

5. View your Web report.
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After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report will appear as shown below.

Report: Transfer Sessions with High Packet loss

As of 2013-06-12 15:10:12 (GMT-08:00) Pacific Time (US & Canada)

06/11/2013 03:10 PM - 06/12/2013 03:10 PM (PDT)
Packet Loss: 10

Name Contact Bytes Transferred Bytes Lost  Packet Loss % From To Started At Stopped At Status
Windows to Linux admin (console) 104,857,600 99,175,904 45.6 10.0.203.82 [10.0.203.250 |2013/06/12 14:59:11 2013/06/12 15:03:49 | completed
Windows to Linux admin (console) 17,790,056 15,963,040 47.2 10.0.203.82 |10.0.203.250 |2013/06/12 14:57:08 |2013/06/12 14:58:11 com pleted
Windows to Linux admin (console) 33,373,320 24,377,456 42.2 10.0.203.82 [10.0.203.250 |2013/06/12 15:04:11 2013/06/12 15:08:49 | completed
MNew folder root (ssh) 104,857,600 18,874,543 15.2 10.0.203.82 |10.0.203.220 |2013/06/12 13:58:00 2013/06/12 13:50:10 com pleted

Aspera Ecosystem Security Best Practices

Your Aspera applications can be configured to maximize system and content security. The following sections describe
the recommended settings and practices that best protect your content when using IBM Aspera High-Speed Transfer
Server and IBM Aspera High-Speed Transfer Endpoint, IBM Aspera Faspex,IBM Aspera Shares, and IBM Aspera
Console.

Contents
Securing the Systems that Run Aspera Software
Securing the Aspera Application

Securing Content in your Workflow

Securing the Systems that Run Aspera Software

The systems that run Aspera software can be secured by keeping them up to date, by applying security fixes, and by
configuring them using the recommended settings.

Updates

Aspera continually improves the built-in security of its products, as do the producers of third-party components used
by Aspera, such as Apache, Nginx, and OpenSSH. One of the first lines of defense is keeping your products up to
date to ensure that you are using versions with the latest security upgrades:

» Keep your operating system up to date.
» Keep your Aspera products up to date.

» Ifusing, keep OpenSSH up to date. The server security instructions require that OpenSSH 4.4 or newer (Aspera
recommends 5.2 or newer) is installed on your system in order to use the Match directive. Match allows you
to selectively override certain configuration options when specific criteria (based on user, group, hostname, or
address) are met.

» Ifyou are using the HST Server web UI, keep Apache serverlIS up to date.
Security Fixes

Rarely, security vulnerabilities are detected in the operating systems and third-party components that are used by
Aspera. Aspera publishes security bulletins immediately that describe the affected products and recommended
remediation steps.

Security Configuration
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Recommended security settings vary depending on the products you are using and how they interact. See the
following subsections for your Aspera products.

HST Server

1. Configure your SSH Server.

Aspera recommends that you:

Open TCP/33001 and keep TCP/22 open until users are notified that they should switch to TCP/33001.
Once users are notified, block TCP/22 and allow traffic only on TCP/33001.

The following steps open TCP/33001 and block TCP/22.

a)

b)

¢)

d)

Open the SSH configuration file.

C:\Program Files\Aspera\\etc\sshd config

/etc/ssh/sshd config

If you do not have an existing configuration for OpenSSH, or need to update an existing one, Aspera
recommends the following reference: https://wiki.mozilla.org/Security/Guidelines/OpenSSH.
Change the SSH port from TCP/22 to TCP/33001.

Add TCP/33001 and comment out TCP/22 to match the following example:

#Port 22
Port 33001

HST Server admins must also update the SshPort value in the <WEB. . . > section of aspera.conf.

Once this setting takes effect:

» Aspera clients must set the TCP port to 33001 when creating connections in the GUI or specify -P
33001 for command line transfers.

* Server administrators should use ssh -p 33001 to access the server through SSH.

Disable non-admin SSH tunneling.

SSH tunneling can be used to circumvent firewalls and access sensitive areas of your company's network.
Add the following lines to the end of sshd config (or modify them if they already exist) to disable SSH
tunneling:

AllowTcpForwarding no
Match Group Administrators
AllowTcpForwarding yes

AllowTcpForwarding no
Match Group root
AllowTcpForwarding yes

Depending on your sshd config file, you might have additional instances of Al1owTCPForwarding
that are set to the default Yes. Review your sshd_config file for other instances and disable if necessary.

Disabling TCP forwarding does not improve security unless users are also denied shell access, because
with shell access they can still install their own forwarders. Aspera recommends assigning users to aspshell,
described in the following section.

Disable password authentication and enable public key authentication.

Public key authentication provides a stronger authentication method than passwords, and can prevent brute-
force SSH attacks if all password-based authentication methods are disabled.

Important: Before proceeding:


https://wiki.mozilla.org/Security/Guidelines/OpenSSH

e)

g)
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» Create a public key and associate it with a transfer user, otherwise clients have no way of connecting to the
server.

» Configure at least one non-root, non-transfer user with a public key to use to manage the server. This is
because in the following steps, root login is disabled and transfer users are restricted to aspshell, which
does not allow interactive login. This user and public key is what you use to access and manage the server
as an administrator.

Add or uncomment PubkeyAuthentication yes and comment out PasswordAuthentication

yes:

PubkeyAuthentication yes
#PasswordAuthentication yes
PasswordAuthentication no

Note: If you choose to leave password authentication enabled, be sure to advise account creators to use strong
passwords and set PermitEmptyPasswords to "no".

PermitEmptyPasswords no
Disable root login.

=, CAUTION: This step disables root access. Make sure that you have at least one user account with

/= 4y sudo privileges before continuing, otherwise you may not have access to administer your server.

Comment out PermitRootLogin yes and add PermitRootLogin No:

#PermitRootLogin yes
PermitRootLogin no

Restart the SSH server to apply new settings. Restarting your SSH server does not affect currently connected
users.

Click Start > Control Panel > Administrative Tools > Services. Locate the OpenSSH Service and click
Restart.

# systemctl restart sshd.service
or for Linux systems that use init.d:

# service sshd restart

Review your logs periodically for attacks.

For information on identifying attacks, see IBM Aspera IBM Aspera High-Speed Transfer Server Admin
Guide: Securing Your SSH Server.

. For Aspera servers on Windows in an Active Directory Domain, create the Active Directory user account to use
as the Aspera service account before installing your Aspera server software. This ensures that the correct security
settings are applied to the user. If you create the Active Directory service account user after installation, see the
following knowledge base article for instructions on how to configure security policies for the acount.

https://support.asperasoft.com/hc/en-us/articles/216125388-OpenSSH-in-Active-Directory-Environments

. Configure your server's firewall to permit inbound access to only Aspera-required ports.

Aspera requires inbound access on the following ports:

For SSH connections that are used to set up connections, TCP/33001.
For FASP transfers, UDP/33001 (or a range, see below).

If you use HTTP and HTTPS fallback with HST Server, TCP/8080 and TCP/8443. If you only use HTTPS,
only open TCP/8443.

If your clients access the HST Server web UI, TCP/80 (for HTTP) or TCP/443 (for HTTPS).


https://downloads.asperasoft.com/en/documentation/4
https://downloads.asperasoft.com/en/documentation/4
https://support.asperasoft.com/hc/en-us/articles/216125388-OpenSSH-in-Active-Directory-Environments
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4. For HST Server, require strong TLS connections to the web server.

TLS 1.0 and TLS 1.1 are vulnerable to attack. Run the following command to require that the client's SSL security
protocol be TLS version 1.2 or higher:

> /opt/aspera/bin/asconfigurator -x "set server data;ssl protocol,tlsvl.2"

5. If the Aspera Node Service is exposed to internet traffic, run it behind a reverse proxy.

If your Aspera server must expose the Aspera Node Service to the internet, such as when setting it up as a IBM
Aspera on Cloud (AoC) node, Aspera strongly recommends protecting it with a reverse proxy. Normally, the
Aspera Node Service runs on port 9092, but nodes that are added to AoC must have the Aspera Node Service
run on port 443, the standard HTTPS port for secure browser access. Configuring a reverse proxy in front of the
Aspera Node Service provides additional protection (such as against DOS attacks) and resource handling for
requests to the node's 443 port.

The following instructions describe how to set up Nginx as a reverse proxy and require that you have valid, CA-
signed SSL certificates in . pem format for the server. Other reverse proxies might be supported on your server.

a) Setup a system user with Node API credentials on your server.
b) Download and install Nginx.
¢) Configure the HTTPS port for the Aspera Node Service.

# asconfigurator -x "set server data;https port, 9092"

d) Open the Nginx configuration file in a text editor.

Open C:\nginx\conf\nginx.conf and ensure the following include directive is present in the http
section. If it is not present, add it to the file:

http {

include /etc/nginx/conf.d/*.confC:\nginx\*.conf;

}

e) Create a file named aspera node proxy.conf and save it in the following location:

C:\nginx\confl\sites-enabled\aspera node proxy.conf

Create the sites-enabled folder if it does not exist.
f) Paste the following content into aspera node proxy.conf:

#
# Aspera configuration - reverse proxy for asperanoded
#
server {

listen 443;

Server name your.servername.com;

ssl certificate "C:/Program Files/Aspera/Enterprise Server/etc/
aspera_ server cert.pem";

ssl certificate key "C:/Program Files/Aspera/Enterprise Server/etc/
aspera_server key.pem";

ssl on;
ssl session cache builtin:1000 shared:SSL:10m;
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ssl protocols TLSvl.2;
ssl ciphers EECDH+AESGCM:EDH+AESGCM:AES256+EECDH:AES256+EDH;
ssl prefer server ciphers on;

access log C:\Logs\nginx\node-api.access.log;

location / {
proxy pass https://127.0.0.1:9092;
proxy read timeout 60;
proxy redirect https://127.0.0.1:9092 https://your.servername.com;

proxy set header Host Shost:$server port;
proxy set header X-Real-IP Sremote addr;
proxy set header X-Forwarded-For Sproxy add x forwarded for;

proxy set header X-Forwarded-Proto $scheme;

}

Note: Configure SSL ciphers as required. The preceding sample is not configured for backwards
compatibility, and the recommended list of secure ciphers might change. Aspera recommends reviewing and
staying current with the list provided in https://cipherli.st/.

In this configuration, Nginx listens externally on port 443, not 9092. Replace your.servername.com with your
server's domain name.

g) Restart the Aspera Node Service.
# systemctl restart asperanoded
or for Linux systems that use init.d:

# service asperanoded restart

> net stop asperanoded
> net start asperanoded

h) Restart Nginx.

> nginx -s reload

1) Run Nginx as a Windows service.

When you install Nginx on a Windows OS, it is installed as an application that runs only when the user
who installed the application is logged in. However, for HST Server nodes that are added to AoC, Aspera
recommends running Nginx as a service so that its function is not tied to a specific user.

For instructions, see https://ibm.ibmaspera.com/helpcenter/admin/nodes/configuring-an-aspera-transfer-server-
as-a-node-for-aspera-on-cloud.

6. Install Aspera FASP Proxy in a DMZ to isolate your HST Server from the Internet.
For more information, see IBM Aspera FASP Proxy Admin Guide
Faspex and Shares

1. Configure your Faspex or Shares server firewall to allow inbound access to TCP/443, the default HTTPS port.


https://cipherli.st/
https://ibm.ibmaspera.com/helpcenter/admin/nodes/configuring-an-aspera-transfer-server-as-a-node-for-aspera-on-cloud
https://ibm.ibmaspera.com/helpcenter/admin/nodes/configuring-an-aspera-transfer-server-as-a-node-for-aspera-on-cloud
http://downloads.asperasoft.com/en/documentation/42
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2. Faspex and Shares transfer nodes should be configured as described for HST Server.

The transfer user that is used by Faspex and Shares (usually xfer) must be configured on the node to only allow
transfers with a token:

> asconfigurator -x

"set user data;user name,xfer;authorization transfer in value, token"
> asconfigurator -x

"set user data;user name,xfer;authorization transfer out value, token"

Set the token encryption key to a string of at least 20 characters:

> asconfigurator -x
"set user data;user name, xfer;token encryption key, token string"

Do not use UUIDs for this key because they might not be generated using cryptographically secure methods.
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Console

Configure the firewall of the computer on which Console is installed to only allow Aspera-required connections to the
following ports:

e For HTTP or HTTPS access for the web UI, inbound TCP/80 or TCP/443.

* For SSH connections, outbound TCP/33001 to managed nodes.

* For Node API connections, outbound TCP/9092 to managed nodes.

» For connections to legacy nodes (those running HST Server older than 3.4.6), outbound TCP/40001 and inbound
TCP/4406. For security and reliability, Asepra strongly recommends upgrading all nodes to the latest version.

Securing the Aspera Applications

Your Aspera products can be configured to limit the extent to which users can connect and interact with the servers.
The instructions for Shares 1.9.x and Shares 2.x are slightly different; see the section for your version.

HST Server

1. Restrict user permissions with aspshell.
By default, all system users can establish a FASP connection and are only restricted by file permissions. Restrict
the user's file operations by assigning them to use aspshell, which permits only the following operations:

* Running Aspera uploads and downloads to or from this computer.
» Establishing connections between Aspera clients and servers.
* Browsing, listing, creating, renaming, or deleting contents.

These instructions explain one way to change a user account or active directory user account so that it uses the
aspshell; there may be other ways to do so on your system.

Windows users are assigned to aspshell automatically when you configure the user in the GUI and specify a
non-empty docroot. If you do not specify a docroot or configure users from the command line, you must manually
set the users' shell as aspshell.exeinC:\Program Files\Aspera\\etc\passwd.

Run the following command to change the user login shell to aspshell:
> sudo usermod -s /bin/aspshell username

Confirm that the user's shell updated by running the following command and looking for /bin/aspshell at
the end of the output:

> grep username /etc/passwd

Note: If you use OpenSSH, sssd, and Active Directory for authentication: To make aspshell the default
shell for all domain users, first set up a local account for server administration because this change affects all
domain users. Then open /etc/sssd/sssd.conf and change default shell from /bin/bashto /
bin/aspshell.

2. Restrict Aspera transfer users to a limited part of the server's file system or bucket in object storage.

a) For on-premises servers, set a default docroot to an empty folder, then set a docroot for each user:

> asconfigurator -x "set node data;absolute,docroot"
> asconfigurator -x "set user data;user name, username;absolute, docroot"

Replace username with the username and docroot with the directory path to which the user should have access.
b) For cloud-based servers, set a default restriction to an empty folder, then set a restriction for each user:

> asconfigurator -x "set node data;file restriction, |storage path"
> asconfigurator -x
"set user data;user name,username;file restriction, |storage path"
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Replace username with the username and storage path with the path to which the user has access. Restriction
syntax is specific to the storage:

Storage Type Format Example

local storage file:////*file:///c%3A/Documents/*
S3 and IBM Cloud Object Storage s3://*

Swift storage swift//>*

Azure storage azu://*

Azure Files azure-files://*

Google Cloud Storage gs://*

Hadoop (HDFS) hdfs://*

The "|" is a delimiter, and you can add additional restrictions. For example, to restrict the system user xfer
to s3://s3.amazonaws.com/bucket xyz/folder a/* andnot allow access to key files, run the
following command:

> asconfigurator -x "set user data;user name,xfer;file restriction, |
s3://s3.amazonaws.com/bucket xyz/folder a/*l'* key"

3. Restrict users' read, write, and browse permissions.

Users are given read, write, and browse permissions to their docroot by default. Change the global default to deny
these permissions:

> asconfigurator -x
"set node data;read allowed, false;write allowed, false;dir allowed, false"

Run the following commands to enable permissions per user, as required:

> asconfigurator -x "set user data;user name, username;read allowed, false"
> asconfigurator -x "set _user “data; user name, username; write allowed, false"
> asconfigurator -x "set _user “data; user name, username;dir allowed, false"

. Limit transfer permissions to certain users.

Set the default transfer permissions for all users to deny:

> asconfigurator -x "set node dataj;authorization transfer in value,deny"
> asconfigurator -x "set node data; authorlzatlon transfer out _value,deny"

Allow transfers for specific users by running the following commands for each user:

> asconfigurator -x

"set user data;user name, username;authorization transfer in value,allow"
> asconfigurator -x

"set user data;user name, username;authorization transfer out value,allow"

Note: For a user that is used by Shares or Faspex (usually xfer), allow transfers only with a token by setting
authorization transfer {in|out} valueto token.

. Encrypt transfer authorization tokens.

When a client requests a transfer from a server through an Aspera web application, an authorization token is
generated. Set the encryption key of the token for each user or group on the server:

> asconfigurator -x
"set user data;user name, username;token encryption key, token string"
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> asconfigurator -x
"set group data;group name, groupname;token encryption key, token string"

The token string should be at least 20 random characters.

Note: This is not used to encrypt transfer data, only the authorization token.
. Require encryption of content in transit.

Your server can be configured to reject transfers that are not encrypted, or that are not encrypted with a strong
enough cipher. Aspera recommends setting an encryption cipher of at least AES-128. AES-192 and AES-256 are
also supported but result in slower transfers. Run the following command to require encryption:

> asconfigurator -x
"set node data;transfer encryption allowed cipher,aes-128"

By default, your server is configured to transfer (as a client) using AES-128 encryption. If you require higher
encryption, change this value by running the following command:

> asconfigurator -x "set client data;transport cipher, value"

You can also specify the encryption level in the command line by using -c¢ cipher with ascp and async
transfers. ascp4 transfers use AES-128 encryption.

. Configure SSH fingerprinting for HST Server.

For transfers initiated by a web application (such as Faspex, Shares, or Console), the client browser sends the
transfer request to the web application server over an HTTPS connection. The web application requests a transfer
token from the target server. The transfer is executed over a UDP connection directly between the client and the
target server and is authorized by the transfer token. Prior to initiating the transfer, the client can verify the server's
authenticity to prevent server impersonation and man-in-the-middle (MITM) attacks.

To verify the authenticity of the transfer server, the web application passes the client a trusted SSH host key
fingerprint of the transfer server. The client confirms the server's authenticity by comparing the server's fingerprint
with the trusted fingerprint. In order to do this, the host key fingerprint must be set in the server's aspera.conf.

Note: Server SSL certificate validation (HTTPS) is enforced if a fingerprint is specified in aspera.conf
and HTTP fallback is enabled. If the transfer "falls back" to HTTP and the server has a self-signed certificate,
validation fails. The client requires a properly signed certificate.

If you set the host key path, the fingerprint is automatically extracted from the key file and you do not extract it
manually.

Retreiving and setting the host key fingerprint:

a) Retrieve the server's SHA-1 fingerprint.

> cat /etc/ssh/ssh host rsa key.pub | awk '{print $2}' | base64 -
shalsum

On the server, run a local ascp transfer. The transfer does not need to complete successfully in order for the
remote host-key fingerprint to appear in the log.

> ascp source file username@localhost:destination
Open C:\Program Files\Aspera\\var\log\aspera-scp-transfer.log.
Search for "remote host-key fingerprint". The line appears similar to the following, in which

19f7¢f4d495234ng4342ha062f5d98b5a9d665 is the SHA-1 fingerprint:

2017-12-08 12:04:53.024 [1888-0000264c] LOG [asssh] remote host-key
fingerprint 19f7c£f4d495234ng4342ha062£5d98b5a9d665
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b) Set the SSH host key fingerprint in aspera.conf.

> asconfigurator -x
"set server data;ssh host key fingerprint, fingerprint"

This command creates a line similar to the following example of the <server> section of aspera.conf:

<ssh host key fingerprint>7qdOwebGGeDeNT7Wv+2dP3HmWEP3
</ssh host key fingerprint>

¢) Restart the node service to activate your changes.
Go to Control Panel > Administrative Tools > Services, click Aspera NodeD, and click Restart.Run the
following commands to restart asperanoded:
> systemctl restart asperanoded
or for Linux systems that use init.d:

> service asperanoded restart

Setting the host key path: To set the SSH host key path instead of the fingerprint, from which the fingerprint will
be extracted automatically, run the following command:

# asconfigurator -x "set server data;ssh host key path,ssh key filepath"
This command creates a line similar to the following in the <server> section of aspera.conf:

<ssh host key path>/etc/ssh/ssh host rsa key.pub
</ssh _host key path>

Restart the node service to activate your changes, as described for "Retreiving and setting the host key
fingerprint".
8. Install properly signed SSL certificates.

Though your Aspera server automatically generates self-signed certificates, Aspera recommends installing valid,
signed certificates. These are required for some applications.

Faspex

Many of the settings for Faspex are the same as for HST Server, including SSH server configuration, firewall
settings, and signed SSL certificate installation. The following recommendations augment or are additional to the
recommendations described for HST Server.

1. Restrict transfers by all users except "faspex".

If your system is a dedicated Faspex server - the HST Server installed as part of your Faspex installation is used
only for Faspex transfers - prohibit transfers by all users except "faspex". If you have not already, deny transfers
globally by default:

> asconfigurator -x "set node data;authorization transfer in value,deny"
> asconfigurator -x "set node data;authorization transfer out value,deny"

Allow transfers for "faspex" by running the following commands:

> asconfigurator -x

"set user data;user name, faspex;authorization transfer in value, token"
> asconfigurator -x

"set user dataj;user name, faspex;authorization transfer out value, token"

2. Configure the Nginx server to allow only strong TLS.
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The default configuration of Faspex has TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). You can disable support for older browsers by removing TLS 1.0 and TLS 1.1
from the configuration.

a) Open the Nginx configuration file on the Shares server for editing:

C:\Program Files\Common Files\Aspera\Common\apache\confl\extra/httpd-
ssl.conf
b) Locate the following line:

SSLProtocol ALL -SSLv2 -SSLv3

¢) Replace the line with the following and save your change:

SSLProtocol TLSv1.2

d) Restart Apache to activate your change:

> asctl apache:restart

. Limit admin logins to those from known IP addresses.

Faspex admins have the ability to execute post-processing scripts on the server. If an admin account is
compromised, this capability can be a serious threat to your server's security. You can add additional protection by
allowing admin logins from only specific IP addresses.

a) In the Faspex UI, go to Accounts and select the admin account.

b) In the Permissions section, locate the Allowed IP addresses for login field and enter the IP addresses or IP
address range to allow.

¢) Click Save to activate your changes.
. Configure Faspex account security settings.
Go to Server > Configuration > Security and set the following global default configurations in the Faspex
accounts section, then edit configurations for individual users, as needed:
a) Set a non-zero session timeout.
b) Lock users out after five failed login attempts within five minutes.
c) Enable Prevent concurrent login.
d) Set a password expiration interval of 30 days.
e) Prevent reuse of the last three passwords and require strong passwords.
f) Set Keep user directory private to Yes.
g) Disable Allow all users to send to all other Faspex users.
h) Disable Users can see global distribution lists.
i) Disable Ignore invalid recipients.
j) Disable Allow users to change their email address.
Stay in Server > Configuration > Security for the next step.
. Configure Faspex account registration settings.
In Server > Configuration > Security, set the following configurations in the Registrations section:
a) Set Self-registration to None.
When self-registration is enabled, it can be used to find out whether a certain account exists on the server. That
is, if you attempt to self-register a duplicate account, you receive a prompt stating that the user already exists.
b) Select Require external users to register.
By requiring external users to register, you can better track their Faspex activity.
Stay in Server > Configuration > Security for the next step.
. Configure outside email address settings.

In Server > Configuration > Security, set the following global default configurations in the Outside email
addresses section, then edit configurations for individual users, as needed:
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a) Disable Allow inviting external senders.

b) Enable Invitation link expires and set an expiration policy.

c) Disable Allow public submission URLs.

d) Disable Allow sending to external email addresses.

e) Set a package link expiration.

f) Disable Allow external packages to Faspex users.

Stay in Server > Configuration > Security for the next step.
7. Configure Faspex encryption.

In Server > Configuration > Security, set the following configurations in the Encryption section:

a) Enable Encrypt transfers.

b) If possible in your work flow, set Use encryption-at-rest to Always.

See the next section, "Securing Content in your Workflow," for information about encryption at rest.

¢) Disable Allow dropboxes to have their own encryption settings.
8. Click Update when you have completed updating settings on the Security page to activate your changes.
9. Hide your server's IP address from email notifications.

If Faspex is configured to identify itself by IP address (rather than by domain name), then the URLSs in your
notification emails contain your IP address (for example, "https://10.0.0.1/aspera/faspex"). Configure an alternate
IP address or domain name for users who are external to your organization.

a) Go to Server > Configuration > Web Server.

b) Select Enable alternate address then click Add alternate address.

c) Enter the address name and description, and select Show in emails.

d) Click Update to activate your change.

e) Customize your email notification templates to use the alternate address.

Go to Server > Notifications.

Shares

The Shares server and its nodes should be secured as described for HST Server, including SSH server configuration,
firewall settings, and valid, signed SSL certificate installation. You can also secure the Shares application and its
network of nodes by restricting user permissions. Set the following settings globally, then edit the settings for specific
users and groups.

1. Configure Shares security settings.

On the Admin page, click User Security and set the following:

a) Set a non-zero session timeout.

b) Require strong passwords.

c) Set a password expiration interval of 30 days.

d) Lock users out after five failed login attempts within five minutes.

e) Do not allow self registration by setting Self Registration to None.
2. When setting up the email server (Admin > SMTP), select Use TLS if available.
3. Configure the Nginx server to allow only strong TLS.

The default configuration of Shares has TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). You can disable support for older browsers by removing TLS 1.0 and TLS 1.1
from the configuration.

a) Open the Nginx configuration file on the Shares server for editing:

C:\Shares\nginx\conf\nginx.conf
b) Delete TLSv1 and TLSvI1.1 from the following line:

ssl protocols TLSvl TLSvl.l TLSvl.2;

4. Configure secure transfer settings.
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Go to System Settings > Transfers and set the following:

a) Require a minimum Connect version of 3.6.1.
b) For Encryption, select AES-128.
c) If possible in your workflow, set Encryption at Rest to Required.

See the next section, "Securing Content in your Workflow," for information about encryption at rest.
Go to System Settings > Web Server and select Enable SSL/TLS.
This setting requires that the Shares server has a valid, signed SSL certificate.
When adding new users to Shares, disable API Login if users do not need to use the Shares API.

The Shares API is used by clients connecting through IBM Aspera Drive and IBM Aspera Command-Line
Interface

When adding nodes to Shares, select Use SSL (required by Shares) and Verify SSL (requires that the node has a
valid, signed SSL certificate).

When authorizing a user or group to a share (share_name > Authorizations), set the minimum permissions
required based on their Shares use.

Shares 2.x

The Shares 2.x server and its nodes should be secured as described for HST Server, including configuring the SSH
server, firewall settings, and installing valid, signed SSL certificates. You can also secure the Share application and
its network of nodes by restricting user permissions. Set the following settings globally and then edit the settings for
specific users, groups, and administrators.

1.

Configure Shares security settings.

Go to System Administration > Configuration > User Security and set the following:
a) Set a non-zero session timeout.

b) Set an access token lifetime of 8 hours.

c) Enable refreshing of expired access tokens, with a lifetime of 7 days.

Go to System Administration > Configuration > Local User Security and set the following:

a) Require strong passwords.

b) Set a password expiration interval of 30 days.

¢) Lock users out after five failed login attempts within five minutes.

d) Prevent reuse of the last three passwords and require strong passwords.

When setting up the email server (System Administration > Configuration > SMTP), select Use TLS if
available.

Configure secure transfer settings.
Go to System Administration > Configuration > Transfers and set the following:

a) Require a minimum Connect version of 3.6.1.
b) For Encryption, select AES-128 (or higher, if needed).
c) Ifpossible in your workflow, set Encryption at Rest to Yes.

See the next section, "Securing Content in your Workflow," for information about encryption at rest.
Go to System Administration > Configuration > Web Server and select Enable SSL/TLS.
This setting requires that the Shares server has a valid, signed SSL certificate.
Configure the Nginx server to allow only strong TLS.

The default configuration of Shares has TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). You can disable support for older browsers by removing TLS 1.0 and TLS 1.1
from the configuration.

a) Open the Nginx configuration file on the Shares server for editing:

C:\Shares\nginx\conf\nginx.conf
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b) Delete TLSv1 and TLSvI1.1 from the following line:

ssl protocols TLSvl TLSvl.l TLSvl.2;

6. When adding nodes to Shares, select Use SSL (required by Shares) and Verify SSL (requires that the node has a
valid, signed SSL certificate).

7. When authorizing a user or group to a share, set the minimum permissions required based on their Shares use.

Console

Console nodes should be secured as described for HST Server, including SSH server configuration, firewall settings,
and valid, signed SSL certificate installation. If possible for your workflow, limit Console and its nodes to your
internal network.

You can also secure the Console application and its network of nodes by restricting user permissions:

1. Configure secure Console defaults.
Go to Configuration > Defaults and set the following:
a) In the drop-down menu for Default SSH encryption, select a default SSH encryption algorithm of at least
AES-128 for non-Console nodes.
b) For Transport Encryption, select AES-128.
c) Disable Smart Transfer Sharing.
d) Set a non-zero session timeout.
e) Lock users out after five failed login attempts within five minutes.
f) Enable Prevent concurrent login.
g) Enable Suppress logging of transfer tokens to prevent tokens from being written to the Console database.
h) Set a password expiration interval of 30 days.
i) Prevent reuse of the last three passwords and require strong passwords.
2. When setting up the email server (Notifications > Email Server), select Use TLS if available.
3. Restrict Console users' permissions.
a) When creating a new user (Accounts > Users > New User), disable user login until their permissions are set
by clearing Active (allow user to log in). Click permissions and enable only the permissions that the user

requires. Once permissions are configured, allow the user to login by going to Accounts > Users, clicking the
user, and selecting Active (allow user to log in).

b) Assign users to Console Groups with only the required transfer paths and permissions allowed.

Create a group (Accounts > Groups > New Group) and restrict the group's transfers by clicking Add
Transfer Path. Assign specific endpoints to the group's transfer path, rather than Any, which grants
permission to transfer to all nodes. Limit the direction of the path, if the group's workflow allows.

4. When adding managed and unmanaged nodes, set the SSH port to 33001 and ensure SSH connections are
encrypted with AES-128 or higher.

5. When adding a managed cluster, select Use HTTPS to connect to node and Require signed SSL certificate.
6. When adding SSH endpoints, use SSH public key authentication rather than password authentication.

The key file on the node should not be a shared key; it should be a "private" key in the specified user account.

Securing Content in your Workflow

1. If your workflow allows, enable server-side encryption-at-rest (EAR).

When files are uploaded from an Aspera client to the Aspera server, server-side encryption-at-rest (EAR) saves
files on disk in an encrypted state. When downloaded from the server, server-side EAR first decrypts files
automatically, and then the transferred files are written to the client's disk in an unencrypted state. Server-side
EAR provides the following advantages:

+ It protects files against attackers who might gain access to server-side storage. This is important primarily
when using NAS storage or cloud storage, where the storage can be accessed directly (and not just through the
computer running HST Server).
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» It is especially suited for cases where the server is used as a temporary location, such as when one client
uploads a file and another client downloads it.

» Server-side EAR can be used together with client-side EAR. When used together, content is doubly encrypted.

» Server-side EAR doesn't create an "envelope" as client-side EAR does. The transferred file stays the same
size as the original file. The server stores the metadata necessary for server-side EAR separately in a file of
the same name with the file extension . aspera-meta. By contrast, client-side EAR creates a envelope file
containing both the encrypted contents of the file and the encryption metadata, and it also changes the name of
the file by adding the file extension . aspera-env.)

» It works with both regular transfers (FASP) and HTTP fallback transfers.

Limitations and Other Considerations

» Server-side EAR is not designed for cases where files need to move in an encrypted state between multiple
computers. For that purpose, client-side EAR is more suitable: files are encrypted when they first leave the
client, then stay encrypted as they move between other computers, and are decrypted when they reach the
final destination and the passphrase is available. See Step 4 of this section for more information on client-side
encryption.

* Do not mix server-side EAR and non-EAR files in transfers, which can happen if server-side EAR is enabled
after the server is in use or if multiple users have access to the same area of the file system but have different
EAR configurations. Doing so can cause problems for clients by overwriting files when downloading or
uploading and corrupting metadata.

» Server-side EAR does not work with multi-session transfers (using ascp -C ornode APImulti session
set to greater than 1) or Watch Folders (versions prior to 3.8.0 that do not support URI docroots).

To enable server-side EAR:

a) Set users' docroots in URI format (local docroots are prepended with file:///).

> asconfigurator -x "set user data;user_name,username;absolute,file:///path"

b) Set the server-side EAR password.
Set a different EAR password for each user:

> asconfigurator -x
"set_user_dataj;user_name,username;transfer_ encryption_content protection_secret, passphrase"

Important: If the EAR password is lost or aspera.conf is compromised, you cannot access the data on
the server.
¢) Require content protection and strong passwords.

These settings cause server-side EAR to fail if a password is not given or if a password is not strong enough.
For example, the following asconfigurator command adds both these options for all users (global):

> asconfigurator -x "set node data;transfer encryption content protection_ required, true"
> asconfigurator -x "set node data;transfer encryption content protection_ strong pass_required, true"

. Never use "shared" user accounts.

Configure each user as their own Aspera transfer user. Sharing Aspera transfer user account credentials with
multiple users limits user accountability (you cannot determine which of the users sharing the account performed
an action).

. Use passphrase-protected private keys.

The ssh-keygen tool can protect an existing key or create a new key that is passphrase protected.

If you cannot use private key authentication and use password authentication, use strong passwords and change
them periodically.

. If your workflow allows, require client-side encryption-at-rest (EAR).

Aspera clients can set their transfers to encrypt content in transit and on the server, and the server can be
configured to require client-side EAR. You can combine client-side and server-side EAR, in which case files are
doubly encrypted on the server. Client-side encryption-at-rest is not supported for ascp4 or async transfers.
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Client configuration

The client specifies a password and the files are uploaded to the server with a . aspera-env extension. Anyone
downloading these . aspera-env files must have the password to decrypt them. Users can enable client-side
EAR in the GUI or on the ascp command line.

GUI: Go to Connections > connection_name > Security. Select Encrypt uploaded files with a password and
set the password. Select Decrypt password-protected files downloaded and enter the password.

Ascp command line: Set the encryption and decryption password as the environment variable
ASPERA SCP_FILEPASS. For uploads (-—-mode=send), use -—file-crypt=encrypt. For downloads
(--mode=recv),use --file-crypt=decrypt.

Note: When a transfer to HST Server falls back to HTTP or HTTPS, client-side EAR is no longer supported.
If HTTP fallback occurs while uploading, then the files are NOT encrypted. If HTTP fallback occurs while
downloading, then the files remain encrypted.

Server configuration

To configure the server to require client-side EAR and to require strong content protection passwords, run the
following commands:

> asconfigurator -x "set node data;transfer encryption content protection_ required, true"
> asconfigurator -x "set node data;transfer encryption content protection_strong pass_required, true"

Note: These commands set the global configuration. Depending on your work flow, you might want to require
client-side EAR and strong passwords for only specific users.

5. For particularly sensitive content, do not store unecrypted content on any computer with network access.

HST Server, HST Endpoint, and Desktop Client include the asprotect and asunprotect command-line
tools that can be used to encrypt and decrypt files. Use an external drive to physically move encrypted files
between a network-connected computer and an unconnected computer on which the files can be unencrypted.

» To encrypt a file before moving it to a computer with network access, run the following commands to set the
encryption password and encrypt the file:

> setexport ASPERA SCP FILEPASS=password
> /opt/aspera/bin/asprotect -o filename.aspera-env filename

» To download client-side-encrypted files without decrypting them immediately, run the transfer without
decryption enabled (clear Decrypt password-protected files downloaded in the GUI or do not specify —-
file-crypt=decrypt on the ascp command line).

* To decrypt encrypted files, run the following commands to set the encryption password and decrypt the file:

> setexport ASPERA SCP FILEPASS=password
> /opt/aspera/bin/asprotect -o filename filename.aspera-env

Patch Versions

A patched Console installation displays the current patch version in the page footer, defined by a patch-version file
included in a patch. Upgrading Console removes the patch-version file.

Technical Support

Support Websites

For an overview of IBM Aspera Support services, go to https://asperasoft.com/company/support/.
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To view product announcements, webinars, and knowledgebase articles, as well as access the Aspera Support
Community Forum, sign into the IBM Aspera Support site at https://www.ibm.com/mysupport/ using your IBMid
(not your company Aspera credentials), or set up a new account. Search for Aspera and select the product. Click
Follow to receive notifications when new knowledgebase articles are available.

Personalized Support

You may contact an Aspera support technician 24 hours a day, 7 days a week, through the following methods, with a
guaranteed 4-hour response time.

Email aspera-support@ibm.com

Phone (North America) +1 (510) 849-2386, option 2

Phone (Europe) +44 (0) 207-993-6653 option 2

Phone (Singapore) +81 (0) 3-4578-9357 option 2
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